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Safety Instructions
Safety Instructions • English

WARNING: This symbol, , when used on the product, is intended to 
alert the user of the presence of uninsulated dangerous voltage within the 
product’s enclosure that may present a risk of electric shock.

ATTENTION: This symbol, , when used on the product, is intended 
to alert the user of important operating and maintenance (servicing) 
instructions in the literature provided with the equipment.

For information on safety guidelines, regulatory compliances, EMI/EMF 
compatibility, accessibility, and related topics, see the Extron Safety and 
Regulatory Compliance Guide, part number 68-290-01, on the Extron website, 
www.extron.com.

Instructions de sécurité • Français

AVERTISSEMENT: Ce pictogramme, , lorsqu’il est utilisé sur le 
produit, signale à l’utilisateur la présence à l’intérieur du boîtier du produit 
d’une tension électrique dangereuse susceptible de provoquer un choc 
électrique.

ATTENTION: Ce pictogramme, , lorsqu’il est utilisé sur le produit, 
signale à l’utilisateur des instructions d’utilisation ou de maintenance 
importantes qui se trouvent dans la documentation fournie avec le 
matériel.

Pour en savoir plus sur les règles de sécurité, la conformité à la réglementation, 
la compatibilité EMI/EMF, l’accessibilité, et autres sujets connexes, lisez les 
informations de sécurité et de conformité Extron, réf. 68-290-01, sur le site 
Extron, www.extron.com.

Sicherheitsanweisungen • Deutsch

WARNUNG: Dieses Symbol  auf dem Produkt soll den Benutzer 
darauf aufmerksam machen, dass im Inneren des Gehäuses dieses 
Produktes gefährliche Spannungen herrschen, die nicht isoliert sind 
und die einen elektrischen Schlag verursachen können.

VORSICHT:  Dieses Symbol  auf dem Produkt soll dem Benutzer in der 
im Lieferumfang enthaltenen Dokumentation besonders wichtige Hinweise 
zur Bedienung und Wartung (Instandhaltung) geben.

Weitere Informationen über die Sicherheitsrichtlinien, Produkthandhabung,  
EMI/EMF-Kompatibilität, Zugänglichkeit und verwandte Themen finden Sie in 
den Extron-Richtlinien für Sicherheit und Handhabung  (Artikelnummer  
68-290-01) auf der Extron-Website, www.extron.com.

Instrucciones de seguridad • Español

ADVERTENCIA: Este símbolo, , cuando se utiliza en el producto, 
avisa al usuario de la presencia de voltaje peligroso sin aislar dentro del 
producto, lo que puede representar un riesgo de descarga eléctrica.

ATENCIÓN: Este símbolo, , cuando se utiliza en el producto, avisa 
al usuario de la presencia de importantes instrucciones de uso y 
mantenimiento recogidas en la documentación proporcionada con el 
equipo.

Para obtener información sobre directrices de seguridad, cumplimiento 
de normativas,  compatibilidad electromagnética, accesibilidad y temas 
relacionados, consulte la  Guía de cumplimiento de normativas y seguridad de 
Extron, referencia 68-290-01, en el sitio Web de Extron, www.extron.com.

Инструкция по технике безопасности • Русский

ПРЕДУПРЕЖДЕНИЕ: Данный символ, , если указан 
на продукте, предупреждает пользователя о наличии 
неизолированного опасного напряжения внутри корпуса 
продукта, которое может привести к поражению электрическим 
током.

ВНИМАНИЕ:  Данный символ, , если указан на продукте, 
предупреждает пользователя о наличии важных инструкций 
по эксплуатации и обслуживанию в руководстве, 
прилагаемом к данному оборудованию.

Для получения информации о правилах техники безопасности, 
соблюдении нормативных требований, электромагнитной 
совместимости (ЭМП/ЭДС), возможности доступа и других 
вопросах см. руководство по безопасности и соблюдению 
нормативных требований Extron на сайте Extron: www.extron.com, 
номер по каталогу - 68-290-01.

Chinese Simplified（简体中文）

警告： 产品上的这个标志意在警告用户该产品机壳内有暴露的危险 电压，
有触电危险。

注意： 产品上的这个标志意在提示用户设备随附的用户手册中有 
重要的操作和维护(维修）说明。

关于我们产品的安全指南、遵循的规范、EMI/EMF 的兼容性、无障碍 
使用的特性等相关内容，敬请访问 Extron 网站 www.extron.com，参见 
Extron 安全规范指南，产品编号 68-290-01。

Chinese Traditional（  )

警告: 若產品上使用此符號，是為了提醒使用者，產品機殼內存在著 
可能會導致觸電之風險的未絕緣危險電壓。

注意	  若產品上使用此符號，是為了提醒使用者。

有關安全性指導方針、法規遵守、EMI/EMF 相容性、存取範圍和相關主題的詳
細資訊，請瀏覽 Extron 網站：www.extron.com，然後參閱《Extron 安全性與
法規遵守手冊》，準則編號 68-290-01。

Japanese

警告: この記号  が製品上に表示されている場合は、筐体内に絶縁されて 
いない高電圧が流れ、感電の危険があることを示しています。

注意:	 この記号  が製品上に表示されている場合は、本機の取扱説明書
に 記載されている重要な操作と保守(整備)の指示についてユーザーの 注
意を喚起するものです。

安全上のご注意、法規厳守、EMI/EMF適合性、その他の関連項目に  
ついては、エクストロンのウェブサイト www.extron.com より 『Extron Safety 
and Regulatory Compliance Guide』 (P/N 68-290-01) をご覧ください。

Korean

경고:  이 기호 , 가 제품에 사용될 경우, 제품의 인클로저 내에 있는 
접지되지 않은 위험한 전류로 인해 사용자가 감전될 위험이 있음을 
경고합니다.

주의: 이 기호 , 가 제품에 사용될 경우, 장비와 함께 제공된 책자에 나와 
있는 주요 운영 및 유지보수(정비) 지침을 경고합니다.

안전 가이드라인, 규제 준수, EMI/EMF 호환성, 접근성, 그리고 관련 항목에 
대한 자세한 내용은 Extron 웹 사이트(www.extron.com)의 Extron 안전 및 
규제 준수 안내서, 68-290-01 조항을 참조하십시오. 



FCC Class A Notice
This equipment has been tested and found to comply with the limits for a Class A digital device, 
pursuant to part 15 of the FCC rules. The Class A limits provide reasonable protection against harmful 
interference when the equipment is operated in a commercial environment. This equipment generates, 
uses, and can radiate radio frequency energy and, if not installed and used in accordance with the 
instruction manual, may cause harmful interference to radio communications. Operation of this 
equipment in a residential area is likely to cause interference. This interference must be corrected at 
the expense of the user.

ATTENTION: The Twisted Pair Extension technology works with shielded twisted pair 
(STP) cables only. To ensure FCC Class A and CE compliance, STP cables and STP 
connectors are also required.

For more information on safety guidelines, regulatory compliances, EMI/EMF 
compatibility, accessibility, and related topics, see the “Extron Safety and Regulatory 
Compliance Guide” on the Extron website.

Copyright
© 2014  Extron Electronics. All rights reserved.

Trademarks
All trademarks mentioned in this guide are the properties of their respective owners.

The following registered trademarks®, registered service marks(SM), and trademarks(TM) are the property of 
RGB Systems, Inc. or Extron Electronics:

Registered Trademarks (®)

AVTrac, Cable Cubby, CrossPoint, eBUS, EDID Manager, EDID Minder, Extron, Flat Field, GlobalViewer, Hideaway, Inline, IP Intercom, 
IP Link, Key Minder, LockIt, MediaLink, PlenumVault, PoleVault, PowerCage, PURE3, Quantum, SoundField, SpeedMount, SpeedSwitch, 
System INTEGRATOR, TeamWork, TouchLink, V-Lock, VersaTools, VN-Matrix, VoiceLift, WallVault, WindoWall, XTP, and XTP Systems

Registered Service Mark(SM) :  S3 Service Support Solutions

Trademarks (™)

AAP, AFL - Accu-RATE Frame Lock, ADSP - Advanced Digital Sync Processing, Auto-Image, CableCover, CDRS - Class D Ripple Suppression, 
DDSP - Digital Display Sync Processing, DMI - Dynamic Motion Interpolation, Driver Configurator, DSP Configurator, DSVP - Digital Sync 
Validation Processing, EQIP, FastBite, FlexOS, FOXBOX, Global Configurator, IP Intercom HelpDesk, LinkLicense, MAAP, MicroDigital, ProDSP, 
QS-FPC - QuickSwitch Front Panel Controller, Scope-Trigger, SIS - Simple Instruction Set, Skew-Free, SpeedNav, Triple-Action Switching, 
XTRA, ZipCaddy, and ZipClip

http://www.extron.com/download/files/userman/68-290-01_K.pdf
http://www.extron.com/download/files/userman/68-290-01_K.pdf


Conventions Used in this Guide

Notifications
The following notifications are used in this guide:

ATTENTION: 

• Risk of property damage. 
• Risque de dommages matériels.

NOTE: A note draws attention to important information.

TIP: A tip provides a suggestion to make working with the application easier.

Software Commands
Commands are written in the fonts shown here: 

^AR Merge Scene,,Op1 scene 1,1 ̂ B 51 ̂ W^C

[01] R 0004 00300 00400 00800 00600 [02] 35 [17] [03]

E X! *X1&* X2)* X2$* X2@ CE}

NOTE: For commands and examples of computer or device responses mentioned 
in this guide, the character “0” is used for the number zero and “O” is the capital 
letter “o.”

Computer responses and directory paths that do not have variables are written in the font 
shown here: 

Reply from 208.132.180.48: bytes=32 times=2ms TTL=32

C:\Program Files\Extron

Variables are written in slanted form as shown here:
ping xxx.xxx.xxx.xxx —t

SOH R Data STX Command ETB ETX

Selectable items, such as menu names, menu options, buttons, tabs, and field names are 
written in the font shown here:

From the File menu, select New.
Click the OK button.

Specifications Availability
Product specifications are available on the Extron website, www.extron.com.

http://www.extron.com
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Introduction

• About this Guide

• About the DTP CrossPoint 84 IPCP Matrix Switchers

• Definitions

• Features

About this Guide
This guide contains installation, configuration, and operating information for the Extron 
DTP CrossPoint Scaling Presentation Matrix Switchers with DTP Extension (see figure 1).

About the DTP CrossPoint 84 IPCP Matrix Switchers
The DTP CrossPoint matrix switchers distribute HDCP-compliant HDMI and Extron 
proprietary DTP video and audio signal types. A matrix switcher routes any input signal 
to any combination of outputs. It can route multiple input and output configurations 
simultaneously.

The DTP CrossPoint fixed matrix size switchers support a total of eight inputs: up to six 
HDMI and one or two inputs from Extron DTP transmitting devices. The matrix switchers 
provide up to four outputs: one or two HDMI and one or two scaled DTP outputs (see DTP 
Input and Output Signals on page 3).

The DTP CrossPoint Matrix Series consists of 8-input by 4-output models, differentiated by 
their audio capabilities:

• DTP CrossPoint 84 IPCP SA — Includes a stereo audio amplifier

• DTP CrossPoint 84 IPCP MA — Includes a mono audio amplifier

The switcher has RS-232 and infrared (IR) insertion ports on all DTP inputs and outputs that 
allow you to route bidirectional control signals to the connected devices.

The switchers provide four mono microphone (mic)/line level inputs that can be mixed with 
one or all audio outputs. Adjustable mic input audio gain and attenuation compensates for 
level differences among audio inputs. The DTP CrossPoint 84 also includes a built-in digital 
signal processor (DSP) that provides a wide variety of microphone pre-amplifier controls, 
mixers, filters, dynamics processors, and feedback supressors.

The mic/line inputs have a talkover feature that automatically reduces the program audio 
group when mic/line input is present. When the mic/line input is not present, the program 
audio group is restored to the set volume level. The mic talkover threshold is adjustable from 
0 dB to -60 dB.

Each input and output is individually isolated and buffered; switching is accomplished with 
virtually no crosstalk or signal noise between channels. Audio that is switched through the 
DSP can either be linked with the video (audio follow) or independent of the video (audio 
breakaway). Embedded digital audio always follow the video.
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Figure 1. Typical DTP CrossPoint 84 IPCP Application

The switcher has a rear panel serial port and a front panel USB port for remote control 
and reporting. The switcher also features the built-in Extron IPCP Pro 350 control 
processor, which has three rear panel local area network (LAN) Ethernet ports. The matrix 
switcher is programmed with the Extron Simple Instruction Set (SIS), a set of basic ASCII 
code commands that provide simple control through a control system or PC without 
programming long, obscure strings of code. SIS commands can be entered via the 
RS-232 port, USB port, or the LAN ports.

The LAN ports can be connected through a local area network (LAN) or wide area network 
(WAN).
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The DTP CrossPoint can be operated by any of the following connected to either serial port 
or a LAN port:

• A control system

• A PC and any of the following:

• The Extron SIS

• The Extron Windows®-based DSP Configurator program

• The Extron Windows-based Product Configuration Software (PCS)

• An Extron MKP 2000 remote control panel

• An Extron MKP 3000 remote control panel

• (RS-232 only) An Extron MCP 1000 remote control panel and/or MKP 1000 remote 
keypad

Setup of the IPCP control processor requires the Extron Global Configurator. The processor 
offers RS-232 and IR-based control, relays, and digital I/O controls that can control and 
monitor a variety of external devices, such as projectors and lights.

The switcher is housed in a rack-mountable, 2U high metal enclosure with mounting flanges 
for a standard 19-inch rack. The appropriate rack mounting kit is included with the switcher.

The switcher has an internal 100 VAC to 240 VAC, 50-60 Hz, 180 watts power supply that 
provides worldwide power compatibility.

DTP Input and Output Signals
The DTP inputs and outputs are proprietary signals that are created within any of the Extron 
DTP Extender systems and transmitted over a single shielded twisted pair (STP) cable.

The DTP CrossPoint accepts DTP inputs from transmitting devices such as the 
DTP T USW 333. Depending on the connected transmitting model, it generates the DTP 
signal from a variety of video and audio inputs, including HDMI, DVI, analog VGA, and 
embedded and analog audio. The DTP signal can also include bidirectional RS-232 and IR 
control signals from the connected transmitting and receiving devices or inserted locally, on 
the DTP CrossPoint switcher.

Depending on the transmitting or receiving device, the DTP inputs and outputs can travel up 
to 330 feet (100 meters) or 230 feet (70 meters) without a loss of signal integrity.
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Definitions
The following terms, which apply to all Extron matrix switchers, are used throughout this 
manual:

• Tie — An input-to-output video and/or line audio connection.

• Set of ties — An input tied to two or more outputs. (An output can never be tied to 
more than one input).

• Configuration — One or more ties, one or more sets of ties, and/or some or all of the 
signal processor settings made in the DSP Configurator program.

• Current configuration — The configuration that is currently active in the switcher (also 
called configuration 0).

• Preset — A full or partial configuration (a subset of ties, sets of ties, or signal processor 
settings) with accompanying audio settings that has been stored.

NOTES:

• Presets can be created only by using the DSP Configurator program.

• When a preset is retrieved from memory, it becomes the current configuration.

• Up to 32 partial or presets can be stored in memory. Preset locations are 
assigned to the input buttons and output buttons. Up to 12 preset locations 
can be recalled from the front panel. Preset numbers larger than 12 are 
accessible under remote control.

• Presets can also be recalled using SIS commands, using the Product 
Configuration Software, or using the DSP Configurator program.

• When a preset consisting of full configurations is recalled, it completely 
overwrites the current configuration.

• When a preset consisting of one or more partial configurations is recalled, it 
overwrite only a portion of the current configuration, leaving other ties and 
settings unchanged.
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Features
All-in-one 8x4 matrix switcher, scaler, audio DSP, and audio power amplifier — 
The DTP CrossPoint 84 delivers all of the core functionality of a conventional AV system in a 
single enclosure, making it ideal for presentation environments that require multiple displays 
and sound reinforcement.

Inputs —

• Six HDMI

• Two DTP twisted pair inputs on RJ-45

• Six stereo balanced or unbalanced audio inputs on captive screw

• Four mic/line audio inputs on captive screw

Outputs —

• Two HDMI

• Two independently scaled DTP twisted pair outputs on RJ-45

• One S/PDIF (Sony/Philips Digital Interface Format) digital audio output on an RCA 
connector

• Four variable audio outputs on captive screw connectors

• One variable amplified speaker output

• DTP CrossPoint 84 SA — 5 mm, 4-pole captive screw connector

• DTP CrossPoint 84 MA — 5 mm, 2-pole captive screw connector

Integrated DTP inputs and outputs — Support digital transmission of HDMI or DVI plus 
video, control, and audio up to 330 feet (100 meters) over a shielded twisted pair (STP) 
cable, providing high reliability and maximum performance on an easily installed cable 
infrastructure.

Supports 4K and UHD signals at all inputs and on both HDMI outputs — Incoming 
4K and UHD signals are supported at all HDMI and DTP inputs, and can be passed only to 
the HDMI outputs.

Selectable scaled DTP output rates — From 640x480 to 1920x1200, including HDTV 
1080p/60, and 2K (2048x1080). The output rate can be individually selected for each of the 
two scaled DTP outputs. Available output rates include computer-video up to 1920x1200, 
HDTV rates up to 1080p/60, and 2048x1080.

Compatible with DTP 230 Series and DTP 330 Series, plus XTP Matrix Switchers — 
Enables mixing and matching with desktop and wallplate transmitters and receivers, as well 
as other DTP-enabled products. The DTP CrossPoint 84 can also be integrated into an 
XTP System to provide connectivity between presentation spaces and a larger, facility-wide 
system.

DTP outputs are compatible with HDBaseT-enabled devices — The DTP outputs can 
be configured to send video and embedded audio signals to HDBaseT-enabled displays.

TP inputs and outputs are compatible with XTP matrix switcher I/O boards.

Compatible with shielded twisted pair cable — The DTP CrossPoint 84 fully supports a 
maximum transmission distance of 330 feet (100 meters) for all compatible resolutions when 
used with STP cable. Shielded twisted pair cabling with solid center conductor sizes of 24 
AWG or better is recommended for optimal performance.

Extron XTP DTP 24 shielded twisted pair cable is strongly recommended for optimal 
performance

Remote powering of DTP transmitters and receivers — The DTP CrossPoint 84 
can provide power to two DTP transmitters and two DTP receivers over the twisted pair 
connections, eliminating the need for separate power supplies at the remote units.



 

DTP CrossPoint 84 IPCP Series Matrix Switchers • Introduction 6

RS-232 insertion from the Ethernet control port — System level device control to all 
remote locations via one of the matrix switcher Ethernet ports, providing comprehensive 
control of endpoints and attached devices without needing additional equipment.

Bidirectional RS-232 and IR insertion for AV device control — Bidirectional RS-232 
control and IR signals can be transmitted alongside the video signal over DTP connections, 
allowing the remote device to be controlled without the need for additional cabling. 
Bidirectional control insertion eliminates the need for control system wiring to remote 
devices.

HDMI audio embedding — Two-channel audio signals can be embedded onto the HDMI 
and DTP outputs.

HDMI audio de-embedding — Embedded HDMI two-channel LPCM audio can be 
extracted for routing and further processing. Embedded multi-channel bitstream formats are 
routed with the video to the HDMI and DTP outputs.

Output volume control — The DTP CrossPoint 84 provides master volume control for the 
line level and amplified audio outputs, as well as a separate control for mic volume.

Audio input gain and attenuation — Gain or attenuation can be adjusted for each 
two-channel audio input to achieve optimal signal-to-noise ratio.

Audio breakaway — Provides the capability to break two-channel audio away from its 
corresponding video signal and route to the audio outputs, allowing the audio and video 
signals from one source to be switched to different destinations.

S/PDIF audio output — The DTP CrossPoint 84 includes an S/PDIF output for two-
channel LPCM audio or encoded standard definition bitstream audio for Dolby or DTS 
multi-channel surround sound.

Integrated digital audio matrix processor with ProDSP 32/64-bit signal processing — 
The DTP CrossPoint 84 features 32/64-bit floating point audio DSP processing, which 
maintains very wide dynamic range and audio signal transparency, to simplify management 
of gain staging while reducing the possibility of DSP signal clipping.

Digital audio expansion port — An expansion port provides interfacing to an Extron 
DMP 128 processor for AEC and audio system scalability. The expansion port allows the 
DTP CrossPoint 84 and any DMP 128 ProDSP Digital Matrix Processor model to be linked 
together via a single shielded Category (CAT) 6 cable for 16x8 channel transport between 
devices. Expansion supports audio system scalability with expanded audio processing 
and signal routing capabilities. A 1 foot (0.3 meter) shielded CAT 6 cable is included with 
DMP 128 models.

Four mic/line inputs with 48 volt phantom power — Four mic or line level audio sources 
can be independently mixed with program audio. Selectable 48 volt phantom power allows 
the use of condenser microphones.

Mic ducking — Automatically reduces program audio when a microphone or other 
incoming audio signal is detected, replacing the need for a separate audio ducking 
processor.

Studio grade 24-bit/48 kHz analog-to-digital and digital-to-analog converters — 
Professional converters fully preserve the integrity of the original audio signal.

Fixed, low latency DSP processing — Input to output latency is a constant 4.5 ms within 
the DTP CrossPoint 84, regardless of the number of active channels or processes. Fixed, 
low latency processing keeps audio in sync with video, and prevents distractions to the 
presenter resulting from delayed live audio.

DSP Configurator Software — A powerful yet user-friendly PC-based software tool for 
managing all audio operations of the DTP CrossPoint 84. It enables complete setup and 
configuration of digital audio processing tools on the DSP platform, as well as routing and 
mixing.
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Group masters — The DTP CrossPoint 84 provides the capability to consolidate gain or 
mute control throughout the system. Gain or mute controls can be selected and added to a 
group master, which can then be controlled by a single master fader or mute control. Up to 
32 group masters can be created.

Soft limits provide optimal group master adjustment range — The group master 
volume range can be limited using soft limits to maintain optimal minimum and maximum 
levels when using external volume control. This prevents operators from over or under-
adjusting levels when using Ethernet, USB, or RS-232 control. The DSP Configurator 
Software provides quick drag-and-drop adjustment of soft limits from the Group Controls 
screen.

32 DSP Configurator presets — Using the DSP Configurator Software, any or all 
parameters for DSP processing, levels, AV matrix switching ties, and audio matrix mixing 
can be saved as presets.

Flexible matrix design provides output, virtual, and expansion routing options — 
The DSP architecture of the DTP CrossPoint 84 employs an intuitive matrix design that 
offers substantial flexibility in routing, mixing, and processing audio input sources. An output 
matrix allows any of the four microphone inputs to be matrix mixed to any or all of the four 
stereo outputs of the AV switcher block. If desired, any of the microphone inputs or AV 
switcher outputs can first be directed into a virtual matrix, which routes the inputs to eight 
virtual buses, before being mixed back into the output matrix. Virtual buses allow inputs to 
be processed together as a group. The expansion matrix provides signal routing between 
the DTP CrossPoint 84 and a DMP 128 processor linked via the expansion port.

Building Blocks processor settings — A collection of pre-designed processor settings 
optimized for a specific type of input or output device, such as microphones and Extron 
speakers, with preset levels, filters, dynamics, and more. Flexible Building Blocks are 
available on each I/O strip and allow system designers to fully customize and save their own 
Building Blocks, further streamlining audio system design and integration.

Energy efficient Class D stereo or mono amplifier:

• 2 x 50 watts @ 4 ohms; 2 x 25 watts @ 8 ohms

• 1 x 100 watts @ 70 volts — The DTP CrossPoint 84 SA offers a stereo power amplifier 
with 50 watts per channel into 4 ohms and 25 watts per channel into 8 ohms, while the 
DTP CrossPoint 84 MA 70 offers a mono 70 volt power amplifier with 100 watts rms 
output. Both feature an Extron exclusive, highly efficient, advanced Class D amplifier 
design with CDRS - Class D Ripple Suppression, an Extron patented technology that 
provides a smooth, clean audio waveform and an improvement in signal fidelity over 
conventional Class D amplifier designs. CDRS eliminates the high frequency switching 
ripple characteristic of Class D amplifiers, a source of RF emissions which can interfere 
with sensitive AV equipment such as wireless microphones.

Supports HDMI specification — Includes data rates up to 10.2 Gbps, Deep Color up to 
12-bit, 3D, and HD lossless audio formats.

HDCP compliant — Fully supports HDCP-encrypted sources, with selectable authorization 
for unencrypted content.

Key Minder continuously verifies HDCP compliance for quick, reliable switching — 
Key Minder authenticates and maintains continuous HDCP encryption between input and 
output devices to ensure quick and reliable switching in professional AV environments, while 
enabling simultaneous distribution of a single source signal to one or more displays.

EDID Minder — Automatically manages EDID communication between connected devices. 
EDID Minder ensures that all sources power up properly and reliably output content for 
display.

SpeedSwitch Technology — Provides exceptional switching speed for HDCP-encrypted 
content
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HDCP authentication and signal presence confirmation — Provides real-time 
verification of HDCP status for each digital video input and output. This allows for simple, 
quick, and easy signal and HDCP verification through RS-232, USB, or Ethernet, providing 
valuable feedback to a system operator or helpdesk support staff.

HDCP Visual Confirmation — Provides a green signal when encrypted content is sent to 
a non-compliant display. A full-screen green signal is sent when HDCP-encrypted content is 
transmitted to a non-HDCP compliant display, providing immediate visual confirmation that 
protected content cannot be viewed on the display.

HDMI to DVI Interface Format Correction — Automatically enables or disables 
embedded audio and infoframes, and sets the correct color space for proper connection to 
HDMI and DVI displays.

QuickSwitch Front Panel Controller (QS-FPC) with tri-color backlit buttons — 
Provides a discrete button for each input and output, allowing for simple, intuitive operation. 
Buttons can be custom labeled for easy identification. The buttons illuminate red, green, or 
amber depending on function, for ease of use in low-light environments.

View I/O mode — Users can easily view which inputs and outputs are actively connected.

Presets — Frequently used I/O configurations may be recalled either from the QuickSwitch 
Front Panel Controller, Ethernet, USB, or RS-232 serial control.

Output muting control — Provides the capability to mute one or all outputs at any time. 
This allows, for example, content to be viewed on a local monitor prior to appearing on the 
main presentation display.

Aspect ratio control — For the scaled DTP outputs, the aspect ratio of the video can be 
controlled by selecting a FILL mode, which provides a full screen output, or a FOLLOW 
mode, which preserves the original aspect ratio of the input signal.

Auto Input Memory — When activated for the scaled DTP outputs, the unit automatically 
stores size, position, and picture settings based on the incoming signal. When the same 
signal is detected again, these image settings are automatically recalled from memory.

Output Standby Mode — The unit can be set to automatically mute video and sync output 
to the display device when no active input signal is detected. This allows the projector or 
flat-panel display to automatically enter into standby mode to save energy and enhance 
lamp or panel life.

User presets — Memory presets are available for each input to store and recall optimized 
image settings.

Internal video test patterns for calibration and setup — The unit offers several test 
patterns for the scaled DTP outputs, to facilitate proper system setup and calibration of 
display devices.

Automatic cable equalization — Cable input equalization for each HDMI input to 
100 feet (30 m) when used with Extron HDMI/DVI Pro cables optimizes signal performance 
for all HDMI signals, helping to ensure pristine image quality throughout DTP Systems.

Automatic HDMI output reclocking — Reshapes and restores timing of digital video 
signals at each HDMI output, eliminating high frequency jitter to ensure reliable transmission 
over long cables.

Remote power — Provides +5 VDC, 250 mA power on each HDMI output for powering 
external peripheral devices, such as the Extron DVI 104. Power provided via an HDMI 
output eliminates the need of a separate power supply for the connected peripheral device.

Front panel security lockout — Prevents unauthorized use in non-secure environments. 
In lockout mode, a special button combination is required to operate the matrix switcher 
from the front panel controller.
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Ethernet monitoring and control — Enables control and proactive monitoring over a 
LAN, WAN, or the Internet. An intuitive Web interface is included for configuration of the unit.

Built-in web page — Enables the use of a standard browser for device monitoring and 
configuration over an intuitive web interface.

RS-232 control port — Enables the use of serial commands for integration into a control 
system. Extron products use the SIS - Simple Instruction Set command protocol, a set of 
basic ASCII commands that allow for quick and easy programming.

Front panel USB configuration port — Enables easy configuration without having to 
access the rear panel.

RJ-45 signal and link LED indicators for DTP ports — Provides a means for validating 
signal flow and operation, allowing quick identification of connectivity issues.

Easy setup and commissioning with the Extron Product Configuration Software 
(PCS) — Conveniently configure multiple products using a single software application.

Rack-mountable 2U, full rack width metal enclosure

Includes LockIt HDMI cable lacing brackets

Internal universal power supply — The 100-240 VAC, 50/60 Hz, international power 
supply provides worldwide power compatibility.
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Installation

• Setup and Installation Checklist

• Rear Panel Cabling and Features

• Front Panel Configuration Port

Setup and Installation Checklist
Preparation

c Familiarize yourself with the DTP CrossPoint matrix switcher.
c Obtain IP setting information for the matrix switcher from the local network administrator 

(see the IPCP Pro 350 Series User Guide at www.extron.com).

Physical installation

c If desired, create and replace button labels (see Removing and Installing Button 
Labels on page 153).

c If desired, install the switcher in a rack (page 152).
c Cable input and output devices (page 12).
c If desired, connect computers or control systems to any of the remote control ports (a 

serial port [page 15], a USB port [page 21], and a LAN port [page 15]) on the switcher.
c Connect power (page 15).
c Test the switcher by creating a tie (page 31).

Ancillary operations

c Install the Product Configuration Software and DSP Configurator software (see 
page 72).
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Rear Panel Cabling and Features
The SA and MA models have similar features, with differences in the Amplified Output block only. 
Figure 2 shows the rear panel of a DTP CrossPoint 84 IPCP SA. Figure 3 shows 
only the Amplified Output block portion of the DTP CrossPoint 84 IPCP MA rear panel.
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Figure 2. DTP CrossPoint 84 IPCP SA (Stereo Audio) Matrix Switcher Rear Panel
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Figure 3. DTP CrossPoint 84 IPCP MA (Mono Audio) Amplified Output Block

ATTENTION:

• Use electrostatic discharge (ESD) precautions (be electrically grounded) when 
making connections. Electrostatic discharge can damage equipment, even if you 
cannot feel, see, or hear it.

• Prenez des précautions contre les décharges électrostatiques (soyez 
électriquement relié à la terre) lorsque vous effectuez des connexions.

• Remove system power before making all connections.

• Débranchez l’alimentation du système avant de faire n’importe quelle connexion.

A HDMI Inputs 1 through 6 (see page 12) K Amp Output 1 (stereo audio model) (see page 14)

B Input TP function switches (see page 12) L Amp Output 1 (see figure 3 and page 14)

C TP Inputs 7 and 8 (see page 12) M S/PDIF Output 4 (see page 14)

D HDMI Output 1 and 2 (see page 12) N DMP Expansion Port and LED (see page 14)

E Output TP function switches (see page 13) O Over TP (Inputs 7 and 8) ports (see page 14)

F TP Outputs 3 and 4 (see page 13) P Over TP (Outputs 3 and 4) ports (see page 14)

G Audio Inputs 1 through 6 (see page 13) Q IPCP Pro 350 control processor (see page 15)

H Mic/Line Inputs 1 through 4 (see page 13) R Remote port (see page 15)

I +48 V (phantom power) LEDs (see page 13) S Switcher Reset button and LED (see page 15)

J Audio Outputs 1 through 4 (see page 14) T Power connector (see page 15)
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Video and TP Input and Output Connections and Switches
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Figure 4. Video and TP Input and Output Connections and Switches

See figure 2 on the previous page for  numbers.

A HDMI Inputs 1 through 6 — Plug HDMI digital video sources into  
the matrix switcher via these HDMI connectors. These connectors can also 
accept DVI video with appropriate adapters. See HDMI connectors on 
page 16 for pin assignments and to use the LockIt HDMI Cable Lacing 
Bracket to secure the connector to the transmitter.

B Input TP function switches, inputs 7 and 8 — XTP

DTP
ATTENTION:

• Position this switch BEFORE connecting the appropriate device to the TP 
connector. Failure to comply can damage the endpoint.

• Positionnez le sélecteur AVANT de connecter l’appareil approprié au 
connecteur TP. Ne pas respecter cette procédure pourrait endommager le 
point de connexion.

If the connected transmitting device is in the Extron DTP series, set this switch to the 
DTP position. If the transmitting device is an XTP CrossPoint matrix switcher, set this 
switch to the XTP position. These switches tailor the switcher to accept input 7 and 8 
signals as follows:

XTP position — The TP input comes from an XTP CrossPoint matrix switcher and 
consists of HDMI with embedded audio plus RS-232 and IR.

DTP position — The TP input comes from a DTP transmitting device and consists of 
HDMI with embedded audio, analog audio, RS-232 and IR, and remote power.

C TP Inputs 7 and 8 — Connect STP cables between compatible Extron SIG          LINK

IN

 
DTP or XTP transmitting devices and these RJ-45 connectors (see TP 
connectors on page 17 to wire the connector).

ATTENTION:

• Do not connect this port to a computer data or telecommunications 
network.

• Ne connectez pas ces port à des données informatiques ou à un 
réseau de télécommunications.

D HDMI Output 1 and 2 — Connect HDMI cables between these ports and  
HDMI video displays. See HDMI connectors on page 16 for pin 
assignments and to use the LockIt HDMI Cable Lacing Bracket to secure the 
connector to the transmitter.
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E Output TP function switches, outputs 3 and 4 — XTP

DTP HDBT
ATTENTION:

• Position this switch BEFORE connecting the appropriate device to 
the TP connector. Failure to comply can damage the endpoint.

• Positionnez le sélecteur AVANT de connecter l’appareil approprié 
au connecteur TP. Ne pas respecter cette procédure pourrait 
endommager le point de connexion.

If the connected receiving device is in the Extron DTP series, set these switches to the 
DTP position. If the receiving device is an XTP CrossPoint matrix switcher, set these 
switches to the XTP position. For HDBaseT-enabled receivers, set these switches to the 
HDBT position. These switches tailor the output signals for output 3 and 4 as follows:

XTP position — The TP output is compatible with an XTP CrossPoint matrix switcher 
and consists of HDMI with embedded audio plus RS-232 and IR.

HDBT position — The TP output is compatible with HDBaseT-enabled devices and 
consist of HDMI with embedded audio plus RS-232 and IR.

DTP position — TP output is compatible with a DTP receiving device and consists of 
HDMI with embedded audio, analog audio, RS-232 and IR, and remote power.

F TP Outputs 3 and 4 — Connect STP cables between these RJ-45 SIG          LINK

OUT

 
connectors and compatible Extron DTP or XTP receivers or HDBaseT-
enabled devices (see TP connectors on page 17 to wire the connector).

ATTENTION:

• Do not connect this port to a computer data or telecommunications 
network.

• Ne connectez pas ces port à des données informatiques ou à un 
réseau de télécommunications.

Audio Input and Output Connections
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Figure 5. Audio Input and Output Connections and Indications

See figure 2 and figure 3 on page 11 for  numbers. For inputs and outputs on captive 
screw connectors (G, H, and J) the connectors are included with the switcher, but you 
must supply the audio cable.

G Audio Inputs 1 through 6 — Connect balanced or unbalanced stereo audio 

L R

 
inputs to these 3.5 mm, 5-pole captive screw connectors (see Analog audio 
input connectors on page 19 to wire the connectors).

H Mic/Line Inputs 1 through 4 — Connect microphones or other mono audio  
inputs to these 3-pole, 3.5 mm captive screw connectors (see Mic/Line input 
connectors on page 19 to wire the connectors).

I +48 V (phantom power) LEDs — These LEDs light to indicate that +48 V +48V

1
 

phantom power is applied to the associated mic/line inputs.
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J Audio Outputs 1 through 4 — Connect audio devices such as an audio 

L R

 
amplifier or powered speakers, to these 3.5 mm, 5-pole captive screw 
connectors. These connectors output unamplified, line level audio, whether it 
is tied from an analog input or de-embedded from an HDMI input (see 
Analog audio output connectors on page 20 to wire the connectors).

K Amp Output 1 (stereo audio model) — Connect unpowered, 4-ohm 
1

L R

4

CLASS 2 WIRING

8 /  
or 8-ohm speakers to this 5mm 4-pole captive screw connector to play 
the amplified stereo audio from output 1.

L Amp Output 1 (mono audio model) — Connect unpowered speakers to 1

CLASS 2 WIRING

 
this 2-pole captive screw connector to play the amplified mono audio from 
output 1.

ATTENTION:

• Ensure the rated input voltage of the speakers matches the rated 
output voltage of the switcher.

• Assurez-vous que la tension nominale d’entrée des enceintes soit 
compatible avec la tension nominale de sortie du sélecteur

M S/PDIF Output 4 — Connect a compatible device to this RCA connector to S/PDIF
OUT  

receive digital audio signal stripped from the output 4 digital stream (see S/PDIF 
output connector, on page 21, to wire this connector).

N DMP Expansion Port and LED — 

EXP

LI
N

K

Expansion port — Connect a CAT 6 cable between this port and the 
Expansion port on an optional Extron DMP 128 ProDSP Digital Matrix 
Processor. A shielded 1-foot cable is included with the DMP 128. Expansion 
supports audio system scalability with expanded audio processing and signal routing 
capabilities (see Expansion Port Operation Within the DSP, on page 128, for details 
on using this functionality). No setup is required; just connect the two devices.

Link LED — Lights to indicate that the port is connected to a compatible device.

Serial and IR Insertion Connections
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Figure 6. Serial and IR Insertion Connections

See figure 2 on page 11 for  numbers.

O Over TP (Inputs 7 and 8) ports — If desired, connect serial RS-232 signals, RS-232       IR

Tx Rx Tx RxG

 
modulated IR signals, or both to these 3.5 mm, 5-pole captive screw 
connectors to insert bidirectional RS-232 and IR communications onto the 
associated inputs (see Serial and IR port connectors on page 20 to wire the cables).

P Over TP (Outputs 3 and 4) ports — If desired, connect serial RS-232 RS-232       IR

Tx Rx Tx RxG

 
signals, modulated IR signals, or both to these 3.5 mm, 5-pole captive screw 
connectors to insert bidirectional RS-232 and IR communications onto the 
associated outputs (see Serial and IR port connectors on page 20 to wire 
the cables).
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Control Connections
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Figure 7. Control Connections

See figure 2 on page 11 for  numbers.

Q IPCP Pro 350 control processor —The DTP CrossPoint 84 includes a built-in IPCP 
control processor that can control and monitor a variety of external devices. The IPCP 
offers RS-232 and IR-based control, relays, and digital I/O controls. Controllable device 
can include:

• Projectors or other displays • Switchers • Projector lifts

• Source devices • Lights • Screen motors

See the IPCP Pro 350 Series User Guide at www.extron.com to make all connections 
and to configure and operate the IPCP control processor.

R Remote Port — Plug a serial RS-232 device into the matrix switcher via this 
Tx Rx G

REMOTE  
3.5 mm, 3-pole captive screw connector for remote control of the switcher 
(see Serial and IR port connectors on page 20 to wire the connector).

Switcher Reset

S Switcher Reset button and LED (see figure 2 on page 11 for  number) — RESET  
The Reset button initiates four levels of reset of the matrix switcher. For the 
different reset levels, press and hold the button while the switcher is running or 
while you power up the switcher (see Rear Panel Operations on page 46 for details).

Power

T Power connector (see figure 2 on page 11 for  number) — Plug a 

50-60 Hz

   100-240V ~ 
2.0 A MAX

 
standard IEC power cord into this connector to connect the switcher to a 
100 VAC to 240 VAC, 50-60 Hz power source.

http://www.extron.com
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Detailed Pin Assignments, Wiring, and Sample Applications

HDMI connectors
Figure 8 defines the pinout for the HDMI protocol.

Pin Signal 

1 TMDS data 2+

TMDS data 2-

TMDS data 0+

TMDS clock- +5 V power

Hot plug detect

CEC control

Reserved
(NC)

TMDS data 1+ TMDS clock+

TMDS clock
shield

SDA

DDC / CEC
Ground

TMDS data 2
shield

Pin Pin Signal Signal 

2

7 13

4 10 16

11 17

12 18

19

14

3 TMDS data 0-

TMDS data 0
shield

8

9 SCL15

TMDS data 1-

TMDS data 1
shield

5

6

HDMI
HDMIType A Receptacle

Type A Plug

1

18 2

19 1

182

19

Figure 8. HDMI Connector

Use the LockIt Lacing Brackets, supplied with the switcher, to securely fasten HDMI cables 
to devices as follows (see figure 9):

1. Plug the HDMI cable into the panel connection.

3

33

11

44

55
22

Figure 9. Installing the LockIt Lacing Bracket

2. Loosen the HDMI connection mounting screw from the panel enough to allow the 
LockIt lacing bracket to be placed over it. The screw does not have to be removed.

3. Place the LockIt lacing bracket on the screw and against the HDMI connector, then 
tighten the screw to secure the bracket.

ATTENTION:

• Do not overtighten the HDMI connector mounting screw. The shield to which it 
fastens is very thin and can easily be stripped.

• Ne serrez pas trop la vis de montage du connecteur HDMI. Le blindage auquel 
elle est attachée est très fin et peut facilement être dénudé.

4. Loosely place the included tie wrap around the HDMI connector and the LockIt lacing 
bracket as shown.

5. While holding the connector securely against the lacing bracket, use pliers or similar 
tools to tighten the tie wrap, then remove any excess length.
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TP connectors
All RJ-45 ports, whether TP input and output ports, the Expansion port, and the LAN 
(Ethernet) ports on the IPCP control processor use twisted pair cables. It is essential that 
the TP cables for the DTP ports, Expansion port, and LAN (Ethernet) ports be the correct 
type and that they be properly terminated with the correct pinout. The TP cable can be 
terminated as a patch (straight-through) cable or a crossover cable and must be properly 
terminated for your application (see figure 10). All these cables are terminated with RJ-45 
connectors. All TP cables are limited to a length of 330 feet (100 m).

NOTES:

• Do not use standard telephone cables. Telephone cables do not support Ethernet 
or Fast Ethernet.

• Do not stretch or bend cables. Transmission errors can occur.
 

A cable that is wired as T568A at one end
and T568B at the other (Tx and Rx pairs
reversed) is a "crossover" cable.

A cable that is wired the same at both ends is
called a "straight-through" cable, because
no pin/pair assignments are swapped.

12345678

RJ-45
Connector

Insert Twisted
Pair Wires

Pins: LAN PortsDTP I/O Ports, Expansion Port, and LAN Ports
Crossover CableStraight-through Cable

Pin

1

2

3

4

5

6

7

8

Wire color

White-green

Green

White-orange

Blue

White-blue

Orange

White-brown

Brown

Wire color

T568A T568B

End 1 End 2End 1 End 2

White-orange

Orange

White-green

Blue

White-blue

Green

White-brown

Brown

Pin

1

2

3

4

5

6

7

8

Wire color

White-orange

White-green

Blue

White-blue

White-brown

Brown

Wire color

T568BT568B

White-orange

OrangeOrange

White-green

Blue

White-blue

GreenGreen

White-brown

Brown

Figure 10. RJ-45 Connector and Pinout Tables

• Patch (straight) cable —

• DTP input and output ports — Shielded twisted pair (STP) for connection to 
Extron DTP or XTP transmitters and receivers or HDBaseT-enabled devices.

 

• Expansion port — STP for connection between the matrix switcher and a 
DMP 128. A shielded 1-foot cable is included with the DMP 128.

• LAN ports — Unshielded twisted pair (UTP) or STP for connection of the LAN port 
to an Ethernet LAN or direct connection between the switcher and a computer.

• Crossover cable —

• LAN ports — UTP or STP for direct connection between the DTP CrossPoint 84 
matrix switcher and a connected computer.

LAN ports

The LAN ports require CAT 3, CAT 5e, or CAT 6a, crossover or patch cables.

The cable used depends on your network speed. The switcher LAN port supports both 
10 Mbps (10Base-T — Ethernet) and 100 Mbps (100Base-T — Fast Ethernet), half-duplex 
and full-duplex Ethernet connections. TP inputs and outputs support 100Base-T only.

• 10Base-T Ethernet requires CAT 3 UTP or STP cable at minimum.

• 100Base-T (max. 155 Mbps) or 1000Base-T Fast Ethernet require CAT 5e UTP or STP 
cable at minimum.

See the IPCP Pro 350 Series User Guide at www.extron.com to make all network 
connections and to configure and operate the IPCP control processor.
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TP and Expansion ports

The TP input and output ports are compatible with Extron XTP DTP 24 SF/UTP cables, as 
well as CAT 5e, 6, 6a, and 7 shielded twisted pair (F/UTP, SF/UTP, and S/FTP) cable. The 
Expansion port requires CAT 5e, 6, 6a, or 7 shielded twisted pair cable.

For the TP ports only —

ATTENTION:

• Do not connect these ports to a computer data or telecommunications network.

• Ne connectez pas ces port à des données informatiques ou à un réseau de 
télécommunications.

• Do not use Extron UTP23SF-4 Enhanced Skew-Free AV UTP cable or 
STP201 cable to link the matrix switcher to Extron DTP or XTP products or 
HDBaseT-enabled devices.

• N’utilisez pas le câble AV Skew-Free UTP version améliorée UTP23SF d’Extron ou 
le câble STP201 pour relier la grille de commutation avec des produits XTP ou DTP 
d’Extron, ou des appareils équipés HDBaseT.

• To ensure FCC Class A and CE compliance, STP cables and STP connectors are 
required.

• Afin de s’assurer de la compatibilité entre FCC Classe A et CE, les câbles STP et 
les connecteurs STP sont nécessaires.

Extron recommends using the following practices to achieve full transmission distances up 
to 330 feet (100 m) and reduce transmission errors.

• Use the following Extron XTP DTP 24 cables and connectors for the best performance:

• XTP DTP 24/1000 Non-Plenum 1000' (305 m) spool 22-236-03

• XTP DTP 24P/1000 Plenum 1000' (305 m) spool 22-235-03

• XTP DTP 24 Plug Package of 10 101-005-02

• If you not using XTP DTP 24 cable, Extron recommends, at a minimum, using 24 AWG, 
solid conductor, STP cable with a minimum bandwidth of 400 MHz.

• Terminate cables with shielded connectors to the TIA/EIA T 568 B standard only (patch 
cables, see figure 10 on the previous page).

• Limit the use of more than two pass-through points, which may include patch points, 
punch down connectors, couplers, and power injectors. If these pass-through points 
are required, use CAT 6 or 6a shielded couplers and punch down connectors.

NOTE: When using cable in bundles or conduits, consider the following: 

• Do not exceed 40% fill capacity in conduits.

• Do not comb the cable for the first 65 feet (20 meters), where cables are 
straightened, aligned, and secured in tight bundles.

• Loosely place cables and limit the use of tie wraps or hook and loop fasteners.

• Separate twisted pair cables from AC power cables.
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Analog audio input connectors
See figure 11 to wire a connector for the appropriate input type. Connectors are included 
with the switcher, but you must supply the audio cable. Use the supplied tie-wrap to strap 
the cable to the extended tail of the connector.

Unbalanced Stereo Input Balanced Stereo InputDo not tin the wires!

Tip
Ring

Tip
Ring

L
R

Sleeves
Tip

Sleeve

Sleeve
Tip

L
R

Figure 11. Captive Screw Connector Wiring for Audio Inputs

NOTES:

• The length of exposed wires is important. The ideal length is 3/16 inch 
(5 millimeters).

• If the stripped section of wire is longer than 3/16 inch, the exposed wires may 
touch, causing a short circuit.

• If the stripped section of wire is shorter than 3/16 inch, wires can be easily 
pulled out even if tightly fastened by the captive screws.

• Do not tin the power supply leads before installing them in the connector. Tinned 
wires are not as secure in the connector and could be pulled out.

An unbalanced stereo audio connector consists of a tip, ring, 

Sleeve (   )

Ring (-)

Tip (+)

3.5 mm Stereo Plug Connector
(balanced)

 
and sleeve. An unbalanced mono audio connector consists of 
a tip and sleeve. When you are making connections for the 
switcher from existing audio cables, see at right to identify the 
tip, ring, and sleeve parts of the connector. The ring, tip, and 
sleeve wires are also shown on the captive screw audio 
connector diagrams, figure 11, above, figure 12, below, and 
figure 13, on the next page.

Mic/Line input connectors
See figure 12 to wire a connector for mono audio input. Use the supplied tie-wrap to strap 
the audio cable to the extended tail of the connector.

Tip (+)

Jumper
Gnd (Sleeve,   )

Tip (+)
Ring (–)

Gnd (Sleeve,   )

Do not tin the wires! Unbalanced Mono Input Balanced Mono Input

Figure 12. Captive Screw Connector Wiring for Mono Audio Inputs

NOTE: The length of exposed wires is important. The ideal length is 3/16 inch (5 mm) 
(see the NOTES above for details).
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Analog audio output connectors
Connect audio devices, such as an audio amplifier or powered speakers, to these 
3.5 millimeter, 5-pole captive screw connectors. These connectors output the tied 
unamplified, line level audio (see figure 13 to wire an output connector). Use the supplied tie-
wrap to strap the audio cable to the extended tail of the connector.
  

Unbalanced Stereo Output Balanced Stereo Output

Do not tin the wires!

Tip

NO GROUND HERE

NO GROUND HERE

Tip

L
R

Sleeves

Tip
Ring

Tip
Ring

L
R

Figure 13. Captive Screw Connector Wiring for Audio Outputs

ATTENTION:

• For unbalanced audio, connect the sleeves to the ground contact. DO NOT 
connect the sleeves to the negative (-) contacts.

• Pour l’audio asymétrique, connectez les manchons au contact au sol. Ne PAS 
connecter les manchons aux contacts négatifs (–).

NOTES:

• The length of exposed wires is important. The ideal length is 3/16 inch (5 millimeter) 
(see the NOTES on the previous page for details).

• The audio that is output on these connectors is converted from the tied embedded 
input signal or the analog audio input. This feature allows you to duplicate the 
outputs while eliminating the need for extra receivers.

By default, the audio ties follow the video ties. Audio breakaway, which can be activated 
via the front panel or under remote control if, in the DSP Configurator, the Output Signal 
Source is set to From DSP (see Output signal processor chain Volume controls 
on page 100), allows you to select from any one of the audio input sources and route it 
separately from its corresponding video source (see Example 3: Remove a tie from a 
set of ties on page 33). You can also use an SIS command (see page 60) or the Product 
Configuration Software (see Matrix Software on page 72).

Serial and IR port connectors
Figure 14 shows how to wire the Over TP RS-232 and IR and Remote connectors.

Tx/Rx
Pins

Rx Tx

Tx Rx

Gnd

Gnd

RS-232 Device

IR Device

R
S-232       IR

Tx
R

x
Tx

R
x

G

O
V

E
R

 T
P

TxGnd

RS-232 Device
Rx

Tx
R

x
G

R
E

M
O

T
E

Figure 14. RS-232 and IR Connectors Wiring

NOTE: The length of exposed wires is important. The ideal length is 3/16 inch 
(5 millimeter) (see the NOTES on the previous page for details).
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S/PDIF output connector
Figure 15 shows the S/PDIF connector, a 75-ohm cable with a standard RCA connector.

Tip (+)

Sleeve (   )

RCA Connector

Figure 15. S/PDIF Connector

Front Panel Configuration Port

Extron

1 2 3 4

1 2 3 4

5 6 7 8

CONFIG

INPUTS

OUTPUTS

AA
Figure 16. Front Panel Configuration Port

A Configuration port — This USB mini-B port serves a similar communications function 
as the rear panel Remote port, but it is easier to access than the rear port after the 
matrix switcher has been installed and cabled.

NOTE: A front panel Configuration port connection and a rear panel Remote 
port connection can both be active at the same time. If commands are sent 
simultaneously to both, the command that reaches the processor first is handled 
first.
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Operation

This section describes the front panel operation of the DTP CrossPoint Matrix Switcher, 
including:

• Front Panel Controls and Indicators

• Front Panel Operations

• Rear Panel Operations

• Troubleshooting

• Configuration Worksheets

Front Panel Controls and Indicators
The front panel controls (see figure 17) are grouped into four sets. The input and output 
buttons, A and B, are grouped on the left side of the control panel. The control buttons 
and video and audio (I/O) selection buttons, C through H, are grouped in the center of the 
panel. The Volume controls (I and J) and the IPCP indications (K) are on the right side 
of the panel.

DTP CROSSPOINT 84 SERIES
DIGITAL PRESENTATION MATRIX

Extron

1 2 3 4

1 2 3 4

5 6 7 8

CONFIG

VOLUME

INPUTS

CONTROL MIC VOLUMEI/O

OUTPUTS

AUDIOVIDEOENTER PRESET VIEW ESC

RTS

CTS

Tx

Rx
OVER

LIMITS

1 2 3 2

1

3 4

1 2

3

1

4

2

eBUS

COM

IR/S I/O RELAYS

CC GGHHDDEEFF II JJ

AA

BB

KK

Figure 17. Front Panel, DTP CrossPoint 84 Switcher

A Input buttons (see page 24)

B Output buttons (see page 24)

C Enter button (see page 25)

D Preset button (see page 25)

E View button (see page 25)

F Esc button (see page 25)

G Video button (see page 26)

H Audio button (see page 26)

I Mic Volume (gain) knob and LEDs (see page 27)

J Volume (gain) knob and LEDs (see page 27)

K IPCP control processor LEDs (see page 27)
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The illuminated buttons can be labeled with text, graphics, or both. The buttons 
can be set to provide amber background illumination all the time, or the background 
illumination can be turned off (see Background Illumination on page 43). The buttons blink 
or are lit at full intensity (depending on the operation) when selected.
 

Input and Output Buttons

NOTE: See Front Panel Operations, beginning on page 28 for detailed descriptions of 
the following operations.

Primary functions
Action Select input or output for tie being created.

Indication Blink: potential tie/untie. 
Lit: current tie 

Amber: video and audio tie 
Green: video only tie 
Red: audio only tie

1 2 3
 

4
 through

7
 

8
Secondary functions

Presets Action Select a preset in Preset mode.

Indication Lit: A preset has been saved to this location.

Output 
mutes

Action Output buttons: Press and hold to mute or unmute the output.

Indication Output buttons blink: Output is muted.

Input audio 
configuration

Action 1 Input 2 and 
Output 2 blink: 

Select config mode.

Action 2 Input buttons: Select the input to configure.

Indication Input buttons: Indicate setting.

Control 
insert 
configuration

Action 1 Input 4 and 
Output 4 blink: 

Select config mode.

Action 2 Output 3 and 4 buttons: 
Select the output to configure.

Input 7 and 8 
buttons: 

Select the input to 
configure.

Indication Input and output buttons: 
Indicate setting.

Background 
illumination

Action Input 1 and Input 2:  
Toggle between background 
illumination or buttons unlit.
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A Input buttons — The input buttons have one primary function (❏) and six secondary 
functions (•):

❏ Select and identify an input for creating ties or for audio level adjustment.

• Select a preset.

• (Input 2) With the Output 2 button, select input audio configuration mode.

• Display input audio configuration.

• (Input 4) With the Output 4 button, select control insert configuration mode.

• (Input 7 and Input 8 only) Display control insert configuration for input.

• (Input 1 and Input 2 only) Toggle background illumination of the buttons on and 
off.

B Output buttons — The output buttons have one primary function (❏) and five 
secondary functions (•):

❏ Select and identify an output for ties.

• Select a preset.

• Mute the output.

• (Output 2) With the Input 2 button, select input audio configuration mode.

• (Output 4) With the Input 4 button, select control insert configuration mode.

• (Output 3 and Output 4 only) Display control insert configuration for output.

Control Buttons

NOTE: See Front Panel Operations, beginning on page 28 for detailed descriptions of 
the following operations.

Primary functions

Action Save changes Select Preset mode Select View mode Cancel or Escape

Indication Blink: Save needed Lit: Recall preset View mode selected Blinks once

ENTER PRESET VIEW ESC

Secondary functions

Input audio 
configuration

Indication Blink: Input Audio Configuration Mode.

Port 
configuration

Action 1: Select Configuration mode.

Action 2: Select 9600 baud Select 19200 baud Select 38400 baud Select 115200 baud

Indication Blink: 9600 baud Blink: 19200 baud Blink: 38400 baud Blink: 115200 baud

Front panel 
locks

Action 1: Select Lock mode 1 or toggle between 
mode 2 and mode 1.

Action 2: Select Lock mode 2 or toggle between mode 0 and mode 2.
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C Enter button — The Enter button has two primary functions (❏) and two secondary 
functions (•):

❏ Saves configuration or other changes that you make on the front panel. To create a 
simple configuration:

 Specify video, audio, or both (see I/O buttons [item G] and [item H]).

 Press the desired input button (item A).

 Press the desired output button or buttons (item B).

 Press the Enter button.

❏ Indicates that a potential tie or other change has been created but not saved.

• With the Preset, View, and Esc buttons, selects Serial Port Configuration mode.

• Selects 9600 baud for the rear panel Remote port in Serial Port Configuration mode 
and indicates the selection.

D Preset button — The Preset button has one primary function (❏) and three secondary 
functions (•):

❏ Activates Recall Preset mode to activate a previously-defined preset and indicates 
the selection.

• With the Enter, View, and Esc buttons, selects Serial Port Configuration mode.

• Selects 19200 baud for the rear panel Remote port in Serial Port Configuration 
mode and indicates the selection.

• With the Vew and Esc buttons, selects front panel security Lock mode 2 or toggles 
between mode 0 (unlocked) and mode 2.

E View (<) button — The View (<) button has one primary function (❏) and five 
secondary functions (•):

❏ Select and indicate View-only mode, which displays the current configuration.

NOTE: View-only mode also provides a way to mute and unmute the outputs.

• With the Esc button, indicates Input Audio Configuration mode.

• With the Enter, Preset, and Esc buttons, selects Serial Port Configuration mode.

• Selects 38400 baud for the rear panel Remote port in Serial Port Configuration 
mode, and indicates the selection.

• With the Preset button and Esc button, selects between front panel locks 
(Lock mode 2 and Lock mode 0).

• With the Esc button, selects between front panel locks (Lock mode 2 and 
Lock mode 1).

F Esc (>) button — The Esc (>) button has one primary function (❏) and five secondary 
functions (•):

❏ Cancels operations or selections in progress and resets the front panel button 
indicators and blinks once to indicate that the escape function has been activated.

• With the View button, indicates Input Audio Configuration mode.

• With the Enter, Preset, and View buttons, selects Serial Port Configuration mode.

• Selects 115200 baud for the rear panel Remote port in Serial Port Configuration 
mode and indicates the selection.

• With the Preset button and View button, selects between front panel locks 
(Lock mode 2 and Lock mode 0).

• With the View button, selects between front panel locks (Lock mode 2 and 
Lock mode 1).
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I/O Buttons

NOTE: See Front Panel Operations, beginning on page 28 for detailed descriptions of 
the following operations.

Primary functions

Action Select video Select audio

Indication Green: selected Red: selected

VIDEO AUDIO

Secondary functions

Control insert 
configuration

Indication Blink: Control Insert Configuration Mode.

Resets Action: Perform a system reset.

G Video button — The Video button has one primary function (❏) and two secondary 
functions (•):

❏ Selects and deselects video for a configuration that is being created or viewed and 
lights green to indicate that video is available for configuring or for viewing.

• With the Audio button, indicates Control Insert Configuration mode.

• With the Audio button, commands the front panel system reset.

H Audio button — The Audio button has one primary function (❏) and two secondary 
functions (•):

❏ Selects and deselects audio for a configuration that is being created or viewed and 
lights to indicate that audio is available for configuration or viewing.

• With the Video button, indicates Control Insert Configuration mode.

• With the Video button, commands the front panel system reset.
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Volume Controls

NOTE: The following volume functions are in the default group masters configuration. 
Operation of these controls can be changed using the DSP Configurator software (see 
Group masters, on page 103).

If you change the group master configuration, the front panel controls adjust the new 
group masters that you create.

I Mic Volume (gain) knob and LEDs — Rotate the knob clockwise to increase the 
pre-mixer gain for all four microphone inputs. By default, this knob controls DSP group 
master 2.

J Volume knob and LEDs — Rotate the knob clockwise to increase the output 1 
amplified volume. By default, this knob controls DSP group master 1.

For both Volume controls, the range is from 0 (-100 dB) to 100 (+12 dB). The default 
setting is 50 (-50 dB). As the volume increases or decreases, the LED bar ramps up and 
down to indicate the current volume range, as shown in table 1. As you increase and 
decrease the volume, the top LED that is lit blinks.

The sensitivity of the encoder (the amount [dB] of volume adjustment per step of 
rotation) varies depending on the current volume setting (see the last column in table 1). 

Table 1. Volume Indication

Volume ranges 
for each LED 

(dB)

LEDs lit Increment 
(dB per step of 
knob rotation)

-4 to 0 All 8 LEDs lit.

1
-9 to -5 Bottom 7 LEDs lit.

-14 to -10 Bottom 6 LEDs lit.

-19 to -15 Bottom 5 LEDs lit.

-29 to -20 Bottom 4 LEDs lit. 2

-49 to -30 Bottom 3 LEDs lit.
4

-69 to -50 Bottom 2 LEDs lit.

-99 to -70 Bottom LED lit.
5

-100 All LEDs off.

Control Processor Indications
K IPCP LEDs —The DTP CrossPoint 84 includes a built-in IPCP control processor that 

can control and monitor a variety of external devices. The IPCP control processor 
display its operational status on the front panel. See the IPCP Pro 350 Series User 
Guide at www.extron.com to interpret the indications of the IPCP control processor.

http://www.extron.com
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Button Icons
The numbered translucent covers on the input and output buttons can be removed and 
replaced to insert labels behind the covers.

Input and output labels can be created easily with the Extron Button-Label Generator 
software, which is shipped with every Extron matrix switcher. Each input and output can be 
labeled with names, alphanumeric characters, or color bitmaps for easy and intuitive input 
and output selection (see figure 18). See the Removing and Installing Button Labels, on 
page 153, for details on using the labeling software, blank labels you can fill in yourself, and 
a procedure for removing and replacing the translucent covers.

1 2 4

1 4

5 7

INPUTS

OUTPUTS

DVD

VCR Computer

Document
Camera

VTG

Figure 18. Sample Button Icons

Front Panel Operations
The following sections detail the power-up process and then provide sample procedures for 
the following actions:

• Creating ties, sets of ties, and configurations

• Changing a configuration

• Viewing ties, sets of ties, and configurations

• Recalling a preset

• Muting and unmuting outputs

• Configuring the audio inputs

• Configuring the TP insertion ports

• Reading and setting the Remote port baud rate

• Toggling background illumination on and off

• Locking and unlocking the front panel

• Performing a front panel reset
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Definitions
The following Extron matrix switcher terms are used throughout this guide:

Tie — An input-to-output connection

Set of ties — An input tied to two or more outputs.

NOTE: An output can never be tied to more than one input.

Configuration — One or more ties or one or more sets of ties

Full configuration — A configuration that includes the ties associated with all inputs and 
outputs and all associated DSP processors.

Partial configuration — A subset of ties, sets of ties, and DSP processors.

Current 
configuration — The configuration that is currently active (also called configuration 0)

Preset — One or more ties or sets of ties and signal processor settings that has been 
created and stored under RS-232 or Ethernet control. Up to 32 presets can be stored in 
memory. The first 12 preset locations are assigned to the input buttons and output buttons 
and can be recalled from the front panel. Preset numbers 12 through 32 can be recalled 
under RS-232 or Ethernet control only.

Preset locations are assigned to the input and output buttons. When a preset is retrieved 
from memory, it becomes either:

• The current configuration (if the preset includes a full configuration), overwriting all of the 
current configuration.

• Part of the current configuration (if the preset includes a partial configuration), overwriting 
a portion of the current configuration, leaving other ties and settings unchanged.

Power
Apply power by connecting the power cord between the switcher and an AC source. The 
switcher performs a self-test that blinks the front panel button indicators red, green, and 
amber and then turns them off. An error-free power-up self-test sequence leaves all input, 
output, and control buttons either unlit or showing background illumination and the Video 
button and the Audio button lit.

The current configuration and all presets are saved in non-volatile memory. When power is 
applied, the most recent configuration is retrieved. The previous presets remain intact.

If an error occurs during the self-test, the switcher locks up and does not operate. If your 
switcher locks up on power-up, call the Extron S3 Sales and Technical Support Hotline. See 
the end of this guide for the phone number in your region of the world.

Front Panel Security Lockouts
In the procedural descriptions that follow, it is assumed that the switcher is in Lock mode 0 
(fully unlocked). The following two Lock modes are also available:

• Lock mode 1 — All changes are locked from the front panel (except for setting Lock 
mode 2). Some functions can be viewed.

• Lock mode 2 — Advanced features are locked and can be viewed only. Basic functions 
are unlocked.

NOTE: The switcher is shipped from the factory in Lock mode 2. See Setting the 
Front Panel Locks (Executive Modes) on page 44 for a detailed list of basic and 
advanced functions and the procedure to set the various front panel locks.
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Creating a Configuration
The current configuration can be changed using the front panel buttons. Change the current 
configuration as follows:

1. Press the Esc button to clear any input button indicators, output button indicators, or 
control button indicators that may be lit.

2. Press the Video button and Audio button as necessary to select video, audio, or both 
for configuration.

3. Select the desired input and one or more outputs by pressing the input and output 
buttons.

• Input buttons and output buttons light or blink:

• Amber to indicate video and audio ties

• Green to indicate video only ties

• Red to indicate audio only ties

• To indicate potential ties, output buttons blink the appropriate color when an input 
is selected.

• To indicate current ties, output buttons light steadily the appropriate color when an 
input is selected.

• To clear unwanted outputs, press and release the associated lit output buttons. To 
indicate potential unties, output buttons blink the appropriate color when an output 
is deselected but not untied from the input.

4. Press and release the Enter button to accept the tie or to break an existing tie.

5. Repeat steps 1 through 4 to create or clear additional ties until the desired configuration 
is complete.

NOTES:

• Only one video input and one audio input can be tied to an output.

• If a tie is made between an input and an output, and the selected output was 
previously tied to another input, the older tie is broken in favor of the newer tie.

• If an input with no tie is selected, only the button for the selected input lights.

• When the Video button and the Audio button are lit, if an input with an audio 
tie but no video tie is selected, the button for the input and the button for the 
output light the appropriate color (amber, green, or red).

• As each input and output is selected, the associated output button blinks 
the appropriate color to indicate a tentative tie. Buttons for outputs that were 
already tied to the input light the appropriate color steadily. Outputs that are 
already tied can be left on, along with new blinking selections, or toggled off by 
pressing the associated output button.
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Example 1: Create a set of video and audio ties
1. Clear all selections: Press and release the Esc button.

C O N T R O L

PRESETENTER ESCVIEW

Press the Esc button to clear all selections.

The button flashes once.

2. Select video and audio for the tie: If necessary, press and release the Video button 
and the Audio button to light both.

I / O

VIDEO AUDIO

Press the Video button to toggle on and off.
The button lights green when selected.

Press the Audio button to toggle on and off.
The button lights red when selected.

3. Select an input: Press and release the input 5 button.

1 2 3 4 5 6 7 8

INPUTS

Press the button.
The button lights amber.

4. Select the outputs: Press and release the output 1, output 3, and output 4 buttons.

 

C O N T R O L

PRESETENTER ESCVIEW1 2 3 41 2 3 4
OUTPUTS

Press the buttons.
The buttons blink amber to indicate that the selected 
video and audio inputs will be tied to these outputs.

The Enter button blinks 
green to indicate the need to 
confirm the change.

NOTE: You can cancel the entire set of ties at this point by pressing and releasing 
the Esc button. The Esc button blinks once.

5. Confirm the change: Press and release the Enter button.

ENTER All input buttons and output buttons
return to unlit or background illumination.

Press the Enter button 
to confirm the change.

The Enter button returns to 
unlit or background illumination.

The current configuration (see figure 19) is now input 5 video and audio are tied to output 1, 
output 3, and output 4.

Output
3
4

1
5

Video
Audio

Input

Figure 19. Final Configuration, Example 1
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Example 2: Add a video tie to a set of video and audio ties
In the following example, a new video tie is added to the current configuration. The example 
shows the front panel indications that result from your actions.

NOTE: This example assumes that you have performed example 1 on the previous 
page.

1. Clear all selections: Press and release the Esc button.

2. Select video only for the tie: Press and release the Video button and the Audio 
button as necessary to light Video only.

I / O

VIDEO AUDIO

Press the Video button to toggle on and off.
The button lights green when selected.

Press the Audio button to toggle on and off.
The button is unlit or background illuminated when deselected.

3. Select an input: Press and release the Input 5 button.

1 2 3 4 1 2 3 45 6 7 8

INPUTS

OUTPUTS

Press the button.
The button lights green to indicate that video 
outputs can be tied to or untied from this input.

The Output 1, Output 3, and Output 4 
buttons light green to indicate the 
video ties created in example 1.

4. Select the output: Press and release the Output 2 button.

C O N T R O L

PRESETENTER ESCVIEW1 2 3 4
OUTPUTS

Press the button.
The button blinks green to indicate that only the 
selected video input will be tied to this output.

The Enter button blinks 
green to indicate the need to 
confirm the change.

5. Confirm the change: Press and release the Enter button.

ENTER All input buttons and output buttons
return to unlit or background illumination.

Press the Enter button 
to confirm the change.

The Enter button returns to 
unlit or background illumination.

The current configuration (see figure 20) is now:

• Video — Input 5 video is tied to output 1, output 2, output 3, and output 4.

• Audio — Input 5 audio is tied to output 1, output 3, and output 4.

Input

Output

1

3
4

2

5

Video
Audio

Figure 20. Final Configuration, Example 2



 

DTP CrossPoint 84 IPCP Series Matrix Switchers • Operation 33

Example 3: Remove a tie from a set of ties
In the following example, an existing tie is removed from the current configuration. The 
example shows the front panel indications that result from your actions.

NOTE: This example assumes that you have performed example 1 on page 31 and 
example 2 on the previous page.

1. Clear all selections: Press and release the Esc button.

2. Select audio only for the tie: Press and release the Video button and the Audio 
button as necessary to light Audio only.

I / O

VIDEO AUDIOPress the Video button to toggle on and off.
The button is unlit or background illuminated when deselected.

Press the Audio button to toggle on and off.
The button lights red when selected.

3. Select an input: Press and release the input 5 button.

1 2 3 4

1 2 3 4

5 6 7 8

INPUTS

OUTPUTS

The Output 2 button does not light to indicate the tie 
created in example 2 because that tie is video only.

The Output 1, Output 3, and Output 4 buttons light 
red to indicate the audio ties created in example 1.

Press the button.
The button lights red.

4. Select the output: Press and release the output 4 button.

C O N T R O L

PRESETENTER ESCVIEW

1 2 3 4
OUTPUTS

Press the button.
The button blinks red to indicate the pending change:  
the audio input will be untied.

The Enter button blinks 
green to indicate the need 
to confirm the change.

5. Confirm the change: Press and release the Enter button.

ENTER All input buttons and output buttons
return to unlit or background illumination.

Press the Enter button 
to confirm the change.

The Enter button returns to 
unlit or background illumination.

The current configuration (see figure 21) is now:

• Video — Input 5 video is tied to output 1, output 3, output 4, and output 8.
• Audio — Input 5 audio is tied to output 2 and output 3.

Input

Output

1

3
4

2

5

Video
Audio

Figure 21. Final Configuration, Example 3
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Viewing the Configuration
The current configuration can be viewed using the front panel buttons. The View-only mode 
prevents inadvertent changes to the current configuration. View-only mode also provides a 
way to mute audio outputs (see Muting and Unmuting Video and HDMI Audio Outputs 
on page 38).

View the current configuration as follows:

1. Press the Esc button to clear any input button indications, output button indications, or 
control button indications that may be on.

2. Press and release the View button. All of the buttons light for outputs that are not tied 
as follows:

• Amber to indicate video and audio ties

• Green to indicate video only ties

• Red to indicate audio only ties

If you press an output button for which there are no ties, the output buttons light for all 
outputs without ties.

3. Press the Video button, Audio button, or both to select video, audio, or both to view by.

4. Select the desired input or outputs whose ties you wish to view by pressing the input 
and output buttons.

NOTES:

• To see all ties of the current configuration, press and release each input and 
output button, one at a time, with the Video button and the Audio button lit.

• When you view video and audio ties, the Video button is lit green and the Audio 
button is lit red. After you select an input or output, the output buttons light 
different colors to show where video and audio ties are not the same (audio is 
broken away). Amber indicates video and audio, green indicates video only, and 
red indicates audio only.

• After 30 seconds of front panel inactivity, View-only mode automatically 
deselects.
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Example 4: Viewing video and audio, audio only, and video only ties
The following example shows viewing the video and audio, audio only, and video-only ties 
in the current configuration. The steps show the front panel indications that result from your 
action.

NOTE: This example assumes that you have performed example 1 on page 31, 
example 2 on page 32, and example 3 on page 33.

1. Clear all selections: Press and release the Esc button.

2. Select View-only mode: Press and release the View button. The View button lights red.

3. Select video and audio for viewing: Press and release the Video button and the 
Audio button as necessary to light both.

I / O

VIDEO AUDIO

1 2 3 4
OUTPUTS

Until you select an input, the buttons for all untied outputs 
light the appropriate color:

Amber if no inputs are tied (not shown in this example)
Green if no video inputs are tied (only audio is tied)
Red if no audio inputs are tied (only video is tied).

Press the Audio button 
to toggle on and off.

The button lights red 
when selected.

Press the Video button 
to toggle on and off.

The button lights 
green when selected.

4. Select an input: Press and release the input 5 button.

1 2 3 4 5 6 7 8

INPUTS

1 2 3 4
OUTPUTS

The output buttons for outputs that are not tied to Input 5 are 
either unlit or background illuminated.

The output buttons for outputs that are tied to Input 5
light or blink the appropriate color:

Amber for audio and video ties (audio follow)
Green for video ties (audio breakaway)
Red for audio ties (audio breakaway, not shown in this example)

Press the button.  It lights amber.

NOTE: You can also view a set of ties by selecting a tied output. Demonstrate this 
as follows:

• Note the number of a lit output button, and then press and release the 
output button for an untied (unlit or background illumination) output.

• Observe that all of the untied outputs light.

• Then press the output button that you noted previously.

• Observe that the selected output button, the tied input button (input 5), and 
the output buttons light for all of the outputs that are tied to the input.
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5. Deselect video: Press and release the Video button.
I / O

VIDEO AUDIO

1 2 3 4
OUTPUTS

Press the button.

The button is unlit or 
background illuminated 
when deselected.

The Audio button 
remains lit red to 
indicate that only 
audio is selected.

The output buttons for outputs that are not tied to 
Input 5 are either unlit or background illuminated.

The output buttons for outputs that are tied to Input 5 
light red to indicate audio ties (audio breakaway).

6. Toggle audio off and video on: Press and release the Video button and the Audio 
button.

I / O

VIDEO AUDIO

1 2 3 4
OUTPUTS

Press button.

The button lights 
green when selected.

Press the button.

The button is unlit 
or background 
illuminated when 
deselected.

The output buttons for outputs that are not tied to 
Input 5 are either unlit or background illuminated.

The output buttons for outputs that are tied to Input 5 
light red to indicate audio ties (audio breakaway).

If video ties are established for input 5, the output buttons light green for all video 
outputs tied to input 5. If no ties are established for input 5, all output buttons return to 
either unlit or to background illumination.

7. Exit View-only mode: Press and release the View button.

All input buttons and output buttons
return to unlit or background illumination.

VIEW

Press the button.

The View button returns to unlit or background illumination.
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Recalling Presets
A full or partial configuration, plus all signal processor settings can be saved as one of 32 
presets. Presets are created via the DSP Configurator software only (see Save a preset 
on page 108). When a preset is retrieved from memory, it becomes either the current 
configuration or part of the current configuration, with all of the associated saved audio 
settings.

Presets 1 through 12 are assigned to the input buttons and output buttons and can be 
recalled from the front panel (see figure 22). Preset numbers 12 through 32 can be recalled 
via RS-232, USB, or Ethernet control only.

NOTES:
• Presets cannot be viewed from the front panel unless they are recalled as the 

current configuration.

• The current configuration and all presets are stored in non-volatile memory. When 
power is removed and restored, the current configuration is still active and all 
presets are retained.

• When a preset is recalled, it replaces all or part of the current configuration, which 
is lost unless it is also stored as a preset. The recalled preset overwrites current 
configuration ties in favor of the preset configuration ties.

Input
buttons

Output
buttons

Preset
1

Preset
6

Preset
7

Preset
3

Preset
8

Preset
4

Preset
5

Preset
2

Preset
9

Preset
11

Preset
12

Preset
10

1 2 3 4

1 2 3 4

5 6 7 8

INPUTS

OUTPUTS

Figure 22. DTP CrossPoint 84 Preset Locations

Example 5: Recalling a preset
In the following example, a preset is recalled to become the current configuration. The steps 
show the front panel indications that result from your action.

1. Clear all selections: Press and release the Esc button.

2. Select Recall Preset mode: Press and release the Preset button.

PRESET 1 2 3 4 8

INPU

Press and release the Preset button.
The Preset button lights.

All input buttons with assigned 
presets light red.

Preset Assigned

No Preset Assigned

3. Select the preset: Press and release the input button or output button for the desired 
preset.

C O N T R O L

PRESETENTER ESCVIEW

1 2 3 4 8

INPU
   The Enter button blinks to 

indicate the need to recall 
the preset.

Press the button.

The button blinks to indicate that this 
preset number is selected but not recalled.
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4. Recall the preset: Press and release the Enter button. The configuration stored in the 
selected memory location is now the current configuration and can be viewed in the 
View-only mode (see example 4 on page 35).

C O N T R O L

PRESETENTER ESCVIEW

1 2 3 4
OUTPUTS

The Enter and Preset 
buttons return to unlit or 
background illumination.

Press the button.

All input and output buttons return 
to unlit or background illumination.

Muting and Unmuting Video and HDMI Audio Outputs
Individual outputs can be muted or unmuted as follows:

NOTES:

• Output mutes are protected when front panel Lock mode 2 is selected. You can 
view the status of the output (muted or unmuted) in Lock mode 2 but you cannot 
change it from the front panel (see Setting the Front Panel Locks (Executive 
Modes) on page 44).

• Audio mute silences the HDMI audio and S/PDIF audio only, not the analog or 
amplified audio.

1. Press the Esc button to clear any input button indications, output button indications, or 
control button indications that may be on.

2. Press and release the View button.

3. Press the Video button and the Audio button to select video, HDMI audio, or both to 
mute or unmute.

4. One at a time, press and hold the buttons for the desired outputs for approximately 
2 seconds. The output buttons for the selected outputs blink to indicate the mute or 
return to their previous state to indicate the unmute.

5. Press and release the View button to return to normal switcher operation.

NOTES:

• You can mute video and HDMI audio, video-only, or HDMI audio-only outputs. 
Pressing and releasing the Video button and the Audio button toggles each 
selection on and off.

• When you enter View-only mode, the output LEDs turn on for all outputs 
without ties.

• Mutes are saved to volatile memory. When power is removed and restored, all 
outputs are unmuted.
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Example 6: Muting and unmuting an HDMI audio output
In the following example, a switcher output is muted and unmuted. The steps show the front 
panel indications that result from your action.

1. Clear all selections: Press and release the Esc button.

2. Select View-only mode: Press and release the View button. The View button lights red.

3. Select both video and audio for viewing and muting: If necessary, press and 
release the Video button and the Audio button.

NOTE: This example assumes that you have performed example 1 on page 31, 
example 2 on page 32, and example 3 on page 33.

I / O

VIDEO AUDIO

1 2 3 4
OUTPUTS

Until you select an input, the buttons for all untied outputs 
light the appropriate color:

Amber if no inputs are tied (not shown in this example)
Green if no video inputs are tied (only audio is tied)
Red if no audio inputs are tied (only video is tied).

Press the Audio button 
to toggle on and off.

The button lights red 
when selected.

Press the Video button 
to toggle on and off.

The button lights 
green when selected.

NOTE: Output mutes are protected when front panel Lock mode 2 is selected. You 
can view the mutes in Lock mode 2 but you cannot change them from the front 
panel (see Setting the Front Panel Locks (Executive Modes) on page 44).

 If front panel Lock mode 2 is selected and you try to perform steps 4 and 5, the 
actions are ignored.
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4. Mute outputs: One at a time:

a. Press and hold the Output 3 button until the button begins to blink (approximately 
2 seconds).

b. Press and hold the Output 4 button until the button begins to blink (approximately 
2 seconds).

3

4

3

4

The button blinks indicate 
that the output is muted.

The button blinks indicate 
that the output is muted.

Mute outputs one at a time.

2 seconds

2 seconds

Press and hold the Output 3 button.

Press and hold the Output 4 button.

Green = Video is muted.
Red = HDMI audio is muted.
Amber = Video and HDMI audio are muted.  (Amber is visible only 

after you have selected the Video and Audio buttons).

NOTE: Video is muted in this example.

NOTES:

• If both video and audio are selected, the mute action toggles both the 
video and HDMI audio outputs. If either the video output or the HDMI audio 
output is already muted, the unmuted output is muted and the muted 
output is unmuted.

• If both video and audio are selected and only video is muted, the output 
button blinks between green and amber. If only audio is selected, the 
output button blinks between red and amber.

5. Unmute outputs: One at a time:

a. Press and hold the Output 3 button until the button returns to its previous state 
(approximately 2 seconds). The output 3 video and audio signals are unmuted.

b. Press and hold the Output 4 button until the button returns to its previous state 
(approximately 2 seconds). The output 4 video and audio signals are unmuted.

3

4

3

4

Unmute outputs one at a time.

2 seconds

2 seconds

Press and hold the Output 3 button.

Press and hold the Output 4 button. The button returns to its previous indication 
(either lit, background illuminated, or unlit) 
to indicate that the output is unmuted.

The button returns to its previous indication 
(either lit, background illuminated, or unlit) 
to indicate that the output is unmuted.

NOTE: If both video and audio are selected, the unmute action toggles both the 
video and HDMI audio outputs. If either the video output or the audio output 
is already unmuted, the muted output is unmuted and the unmuted output is 
muted.

6. Exit View-only mode: Press and release the View button.

All input buttons and output buttons
return to unlit or background illumination.

VIEW

Press the button.

The View button returns to unlit or background illumination.
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Configuring the Input Audio
The input audio can be configured to tie the digital audio input (on the HDMI or TP 
connector), the analog audio input (on the local connector), or to automatically select the 
input, with digital having priority. Configure the input audio as follows:

1. Press the Esc button to clear any input button indications, output button indications, or 
control button indications that may be on.

2. Select Input Audio Configuration mode: Press and hold the Input 2 and Output 2 
buttons simultaneously until the View and Esc button begin to blink (approximately 2 
seconds).

1 2 3

1 2 3
OUTPUTS

CONTROL

ENTER PRESET VIEW ESC

Press and hold the buttons.

2 seconds

3. Release the input and output buttons.

NOTE: The audio configuration is protected when front panel Lock mode 2 is 
selected. You can view the configuration in Lock mode 2 but you cannot change it 
from the front panel (see Setting the Front Panel Locks (Executive Modes) on 
page 44).

 If front panel Lock mode 2 is selected and you try to perform steps 4 and 5, the 
actions are ignored.

4. Select the input and configure it: Press and release an input button to select that 
input to configure. Repeatedly press the input, cycling through unlit, green, and amber 
indications, to select the configuration.

4 5

INPUTS

4 5

INPUTS

4 5

INPUTS

CONTROL

ENTER PRESET VIEW ESC

Press the button repeatedly.

Press

Press

Press

The selected input button indicates the audio input configuration as follows:
Unlit — auto mode Green — digital audio Amber — analog audio

The Enter button blinks to indicate 
the need to save the change.

The View and Esc buttons 
continue to blink.

5. Confirm the change: Press and release the Enter button.

ENTER All input buttons and output buttons
return to unlit or background illumination.

Press the Enter button 
to confirm the change.

The Enter button returns to 
unlit or background illumination.
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Configuring the TP Insertion Ports
The control insertion ports on TP inputs and outputs can be configured for Ethernet 
insertion or RS-232 pass-through. Configure the control insertion as follows:

1. Press the Esc button to clear any input button indications, output button indications, or 
control button indications that may be on.

2. Select Control Insert Configuration mode: Press and hold the Input 4 and Output 4 
buttons simultaneously until the Video and Audio button begin to blink (approximately 2 
seconds).

I/O

AUDIOVIDEO1 2 3 4

1 2 3 4

INPUTS

OUTPUTS

Press and hold the buttons.

2 seconds

3. Release the input and output buttons.

NOTE: The TP insertion ports are protected when front panel Lock mode 2 is 
selected. You can view the port configurations in Lock mode 2 but you cannot 
change them from the front panel (see Setting the Front Panel Locks 
(Executive Modes) on page 44).

 If front panel Lock mode 2 is selected and you try to perform steps 4 and 5, the 
actions are ignored.

4. Select the input or output and configure it: Press and release either an input button 
or output button to select that input or output to configure. Repeatedly press the input 
or output, toggling between unlit and amber indications, to select the configuration.

NOTE: Only TP inputs and outputs (inputs 7 and 8 and output 3 and 4) are valid 
selections. Other input buttons do not respond.

6 7

INPUTS

6 7

INPUTS

CONTROL

ENTER PRESET VIEW ESC

Press the button repeatedly.

Press

Press

The selected input button indicates the control 
insertion configuration as follows:
Unlit — RS-232 pass-through  Amber — Ethernet

The Enter button blinks to indicate 
the need to save the change.

5. Confirm the change: Press and release the Enter button.

ENTER All input buttons and output buttons
return to unlit or background illumination.

Press the Enter button 
to confirm the change.

The Enter button returns to 
unlit or background illumination.
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Selecting the Remote Port Baud Rate
The switcher can operate at the 9600, 19200, 38400, and 115200 baud rate. This variable 
can be viewed and changed from the front panel, as follows:

1. Select Serial Port Configuration mode: Simultaneously press and hold all Control 
buttons (Enter, Preset, View, and Esc).

2 seconds

•

CONTROL

ENTER PRESET VIEW ESC

CONTROL

ENTER PRESET VIEW ESC

The blinking Control button indicates the baud rate as follows:
Enter — 9600  Preset — 19200
View — 38400  Esc — 115200

All Control buttons light with 
one blinking.

Press and hold the buttons.

2. Release the Control buttons.

NOTE: If front panel Lock mode 2 is selected and you try to perform step 3, the 
actions are ignored and the Enter, Video, and Audio buttons flash (see Setting the 
Front Panel Locks (Executive Modes) on page 44).

3. Change the baud rate: Press and release the button that relates to the desired value.

CONTROL

ENTER PRESET VIEW ESC

Press and release the button(s) to configure the 
port as follows:

Enter — 9600  Preset — 19200
View — 38400  Esc — 115200

The selected button blinks and the others remain lit.

In this example, the port is set to 38400 baud.

4. Exit the Serial Port Configuration mode: Press and release an output button.

C O N T R O L

PRESETENTER

I / O

VIDEO AUDIOESCVIEW5

All Control and I/O buttons return 
to unlit or background illumination.Press and release 

an output button.

Background Illumination
The buttons on the front panel can be set to provide amber background illumination at 
all times or the background illumination can be turned off. To toggle the background 
illumination on or off, press and hold the Input 1 and Input 2 buttons simultaneously for 
approximately 2 seconds (see figure 23).

1 2 7 8

Press and hold the buttons.

After the illumination status of the 
buttons change (after approximately 
2 seconds), release the buttons.

Figure 23. Toggle Background Illumination on or off
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Setting the Front Panel Locks (Executive Modes)
The matrix switcher has three levels of front panel security lock that limit the operation of the 
switcher from the front panel. The three levels are:

• Lock mode 0 — The front panel is completely unlocked. All front panel functions are 
available.

• Lock mode 1 — All changes are locked from the front panel (except for setting Lock 
mode 2). Some functions can be viewed.

• Lock mode 2 — Basic functions are unlocked. Advanced features are locked and can 
be viewed only.

Basic functions consist of:

• Making ties

• Saving and recalling presets

• Changing Lock modes

Advanced functions consist of:

• Setting audio output mutes

• Setting the rear panel remote port protocol and baud rate

NOTE: The switcher is shipped from the factory in Lock mode 2.

Selecting Lock mode 2 or toggling between mode 2 and mode 0

NOTE: If the switcher is in Lock mode 0 or mode 1, this procedure selects mode 2. The 
Esc, Video, and Audio buttons blink twice.

If the switcher is in Lock mode 2, this procedure selects mode 0 (unlocks the switcher). 
The Video and Audio buttons blink twice.

Toggle the lock on and off by pressing and holding the Enter button, the Video button, and 
the Audio button simultaneously for approximately 2 seconds (see figure 24).

Lock mode 2

Lock mode 0

CONTROL I/O

AUDIOVIDEO

I/O

AUDIOVIDEOENTER PRESET VIEW ESC

CONTROL I/O

AUDIOVIDEOENTER PRESET VIEW ESC

CONTROL I/O

AUDIOVIDEOENTER PRESET VIEW ESC

Press and hold for 2 seconds.

Press and hold for 2 seconds.

Figure 24. Toggle Front Panel Lock Between Mode 2 and Mode 0
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Selecting Lock mode 2 or toggling between mode 2 and mode 1

NOTE: If the switcher is in Lock mode 0 or mode 1, this procedure selects mode 2.

 If the switcher is in Lock mode 2, this procedure selects mode 1.

Toggle the lock on and off by pressing and holding the Video button and the Audio button 
simultaneously for approximately 2 seconds (see figure 25).

Lock mode 1 Lock mode 0
I/O

AUDIOVIDEO

I/O

AUDIOVIDEO

CONTROL I/O

AUDIOVIDEOENTER PRESET VIEW ESC

I/O

AUDIOVIDEO

Press and hold for 
2 seconds.

Press and hold for 
2 seconds.

Figure 25. Toggle Front Panel Lock Between Mode 2 and Mode 1

Performing a System Reset from the Front Panel
The front panel reset is identical to issuing the EZXXX} SIS command defined on 
page 64. A system reset performs the following functions:

NOTES:

• System reset does not reset the Internet protocol (IP) settings or replace 
user-installed firmware.

• This function resets not only the switcher, but any connected endpoints.

• Clears all ties and presets

• Clears all mutes

• Disables all RS-232 output inserts

• Restores group masters 1 and 2 to their factory defaults (Mic volume and Volume)

Reset the switcher to the factory default settings by pressing and holding the Video button 
and Audio button simultaneously while you apply AC power to the switcher (see figure 26).

I / O

VIDEO AUDIO

Press and hold the Video and Audio 
buttons simultaneously while you 
apply power to the switcher.

Release the Video and Audio buttons.

Power

The switcher flashes 
the button indicators 
and then turns them off.

Continue to hold the Video and Audio 
buttons until all input and output buttons 
return to unlit and the Video and Audio 
buttons turn on.

Figure 26. System Reset

NOTE: If background illumination was turned on before the reset, the I/O and control 
buttons are unlit after the reset. But, when you cycle power, background illumination 
returns to the condition that you previously selected.
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Rear Panel Operations
The rear panel has a Reset button that initiates four levels of resets (numbered 1, 3, 4, and 5 
for the sake of comparison with other Extron IPL products). The Reset button is recessed, 
so use a small screwdriver, a pointed stylus, or a ballpoint pen.

See table 2, for a summary of the modes.

ATTENTION:

• Review the reset modes carefully. Using the wrong reset may result in unintended 
loss of flash memory programming, port reassignment, or a controller reboot.

• Étudier de près les différents modes de réinitialisation. Appliquer le mauvais mode 
de réinitialisation peut causer une perte inattendue de la programmation de la 
mémoire flash, une reconfiguration des ports ou une réinitialisation du contrôleur. 
(du processeur.)

NOTE: The reset modes listed below close all open IP and Telnet connections and close 
all sockets. Also, the following modes are separate functions, not a continuation from 
Mode 1 to Mode 5.

Table 2. Reset Mode Comparison and Summary
Mode Activation Result Purpose and Notes

1 Hold down the recessed Reset button while 
applying power to the switcher.

NOTE: After a mode 1 reset is 
performed, update the 
switcher firmware to the latest 
version. Do not operate the 
switcher firmware version that 
results from the mode 1 reset. 
If you want to use the factory 
default firmware, you must 
upload that version again 
(see Updating the Firmware on 
page 78 for details on uploading 
firmware).

The switcher reverts to the factory default firmware. 
Event scripting will not start if the switcher is powered on 
in this mode. All user files and settings (such as drivers, 
adjustments, and IP settings) are maintained.

NOTE: If you do not want to update firmware, 
or you performed a mode 1 reset by mistake, 
cycle power to the switcher to return to the 
firmware version that was running before the 
mode 1 reset. Use the 0Q SIS command (see 
page 65) to confirm that the factory default 
firmware is no longer running (look for the 
asterisk [*] following the version number.

Use mode 1 to revert 
to the factory default 
firmware version if 
incompatibility issues 
arise with user-loaded 
firmware. 

3 Hold down the Reset button for about 3 
seconds, until the Reset LED blinks once, 
then press and release Reset (<1 second) 
within 1 second.

Mode 3 turns events on or off. During resetting, the 
Reset LED blinks 2 times if events are starting, 3 times if 
events are stopping.

Mode 3 is useful for 
troubleshooting.

4 Hold down the Reset button for about 
6 seconds, until the Reset LED blinks 
twice (once at 3 seconds and again at 
6 seconds). Then press and release Reset 
(<1 second) within 1 second.

Mode 4:
• Enables ARP capability.
• Sets the IP address to the factory default.
• Sets the subnet address to the factory default.
• Sets the gateway address to the factory default.
• Sets port mapping to the factory default.
• Turns DHCP off.
• Turn events off.

The Reset LED blinks four times in quick succession 
during the reset.

Mode 4 enables you 
to set IP address 
information using ARP 
and the MAC address.
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Table 2. Reset Mode Comparison and Summary (continued)
Mode Activation Result Purpose and Notes

5 Hold down the Reset button for about 
9 seconds, until the Reset LED blinks 
three times (once at 3 seconds, again at 
6 seconds, and then again at 9 seconds). 
Then press and release Reset (<1 second) 
within 1 second.

Mode 5 performs a complete reset to factory 
defaults (with the exception of the firmware):

• Does everything mode 4 does.
• Resets most real time adjustments, including: 

clears all ties and presets, 
clears all HDMI mutes, 
disables all RS-232 output inserts, 
clears all audio settings.

• Resets all IP options.
• Removes/clears all files for the switcher.

The reset LED blinks four times in quick succession during 
the reset. 

Mode 5 is useful if 
you want to start over 
with configuration and 
uploading or to replace 
events.

Performing a Hard Reset (Reset 1)
The hard reset function restores the switcher to the base firmware that it was shipped with. 
After a hard reset, events do not automatically start, but user settings and files are restored.

Perform a hard reset as follows:

NOTE: The hard reset restores the factory-installed firmware. The switcher reverts 
to that factory firmware the next time power is cycled off and on unless a firmware 
update is performed before the power cycle.

1. If necessary, turn off power to the switcher.

2. Press and hold the Reset button on the rear panel while you apply AC power to the 
switcher (see figure 27).

Power

RESET

RESET

Press and hold the button 
while you apply power.

Release the Reset button.

The switcher blinks the front panel 
button indicators green, red, and 
amber and then turns them off.

Continue to hold the Reset button until 
all input and output buttons return to 
either unlit or to background illumination 
and the Video and Audio buttons turn on.

Figure 27. Hard Reset
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Performing Soft System Resets (Resets 3, 4, and 5)
Perform a soft reset of the switcher as follows:

1. Use a small screwdriver to press and hold the rear panel Reset button until the Reset 
LED and the front panel Video and Audio buttons blink the number of times for the 
desired reset: once (events reset), twice (system reset), or three times (absolute reset) 
(see figure 28).

I/O

AUDIOVIDEO

I/O

AUDIOVIDEO

I/O

AUDIOVIDEO

RESET RESET RESET

RESET RESET RESET

RESET RESET RESET

Release, then immediately
press and release again.

IP Settings 
Reset

6 seconds

Absolute Reset
9 seconds

Press and hold 
the Reset button.

3 seconds
Events Reset

(Mode 4)

(Mode 5)

(Mode 3)

Front panel I/O buttons blink once.

Reset LED blinks once.
Release, then immediately
press and release again.

Reset LED blinks twice.
Press and hold 
the Reset button.

Press and hold 
the Reset button.

Reset LED blinks 
three times.

Front panel I/O buttons blink twice.

Front panel I/O buttons blink three times.

Release, then immediately
press and release again.

Figure 28. Soft System Resets

2. Release the Reset button and then immediately press and release the Reset button 
again. Nothing happens if the second momentary press does not occur within 1 second.

Troubleshooting
This section recommends what to do if you have problems operating the switcher.

1. Ensure that all devices are plugged in and powered on.

2. Check to see if one or more outputs are muted.

3. Ensure an active input is selected for output on the switcher.

4. Ensure that the proper signal format is supplied.

5. Check the cabling and make corrections as necessary.

6. Call the Extron S3 Sales and Technical Support Hotline if necessary. See the end of this 
guide for the phone number in your region of the world.
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Configuration Worksheets
Rather than trying to remember the configuration for each preset, use worksheets to record 
this information. Make copies of the blank worksheet on page 51 and use one for each 
preset configuration. Cross out all unused or inactive inputs and outputs. Use different 
colors for video and audio.

NOTE: All of the equipment in the following examples is connected through the 
appropriate transmitter or receiver.

Worksheet Example 1: System Equipment
Figure 29 shows a portion of a worksheet for a DTP CrossPoint 84 in a fictional organization 
with the system hardware annotated. Inputs 6 and 8 have no connection in this 
organization, so they are crossed out on the worksheet. Similarly, output 2 is crossed out.

1 2 3 4 5 6 7 8

1 2 3 4

Input  sources

Output destinations 

Preset #  Title:  Video:  Audio:
Fill in the preset number and use colors, dashes, etc., to make connecting lines.
Indicate if the configuration is for video, audio, or both.

VTG 400/
Audio

System

PC 2PC 1

Weekly status mtg 3

Camera 
#2

Camera/ 
mic - Main

podium

Classroom
FP #1

Podium
monitor

DTP R
HDMI
330/
Audio

System

DTP T
USW 333

Figure 29. Worksheet Example 1: System Equipment

Inputs include cameras, PCs, an Extron VTG 400DVI, an audio system, and digital and 
analog inputs to an Extron DTP T USW 333 switcher. Output devices include monitors, 
projectors, a stereo, a VCR for recording presentations, and a DA.

The VTG 400DVI video test generator connected to input 5 enables a video test pattern 
to be sent to one, several, or all output devices for problem isolation or adjustment 
purposes. An audio test tape or CD can be used in a similar manner to check out the audio 
components.
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Worksheet Example 2: Daily Configuration
Figure 30 continues from worksheet example 1 by showing the video and audio ties in the 
preset 1 configuration. Black lines shows video ties, red lines show the audio ties.

1 2 3 4 5 6 7 8

1 2 3 4

Input  sources

Output destinations 

Preset #  Title:  Video:  Audio:
Fill in the preset number and use colors, dashes, etc., to make connecting lines.
Indicate if the configuration is for video, audio, or both.

VTG 400/
Audio

System

PC 2PC 1

Weekly status mtg 3

Camera 
#2

Camera/ 
mic - Main

podium

Classroom
FP #1

Podium
monitor

DTP R
HDMI
330/
Audio

System

DTP T
USW 333

Figure 30. Worksheet Example 2: Daily Configuration

In this example:

• The presenter, from the podium camera (input 1), is displayed in the classroom (output 1).

• Her laptop computer presentation on (input 4) is displayed on the podium (output 3).

• Her microphone audio (input 1) is played in the classroom (output 1).

• Audio from another PC (input 5) is output to a local device via a DTP receiver (output 4).

Worksheet Example 3: Test Configuration
The AV system in our fictional organization needs to be fine tuned on a regular basis. 
Figure 31 shows a typical test configuration, with an Extron video test generator (input 5) 
generating a test pattern to all monitors (outputs 1, 3, and 4). Sound checks are run from a 
CD player (input 5) to all audio systems (outputs 1, 3, and 4).

1 2 3 4 5 6 7 8

1 2 3 4

Input  sources

Output destinations 

Preset #  Title:  Video:  Audio:
Fill in the preset number and use colors, dashes, etc., to make connecting lines.
Indicate if the configuration is for video, audio, or both.

VTG 400/
Audio

System

PC 2PC 1

Test config 4

Camera 
#2

Camera/ 
mic - Main

podium

Classroom
FP #1

Podium
monitor

DTP R
HDMI
330/
Audio

System

DTP T
USW 333

Figure 31. Worksheet Example 3: Test Configuration
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Configuration Worksheets

1 2 3 4 5 6 7 8

1 2 3 4

Input  sources

Output destinations 

Preset #  Title:  Video:  Audio:
Fill in the preset number and use colors, or dashes, etc. to make connecting lines.
Indicate if the configuration is for video, audio, or both.

1 2 3 4 5 6 7 8

1 2 3 4

Input  sources

Output destinations 

Preset #  Title:  Video:  Audio:
Fill in the preset number and use colors, or dashes, etc. to make connecting lines.
Indicate if the configuration is for video, audio, or both.
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Programming Guide

The DTP CrossPoint Matrix Switcher can be remotely controlled, monitored, or configured via:

• The Extron Product Configuration Software and DSP Configurator software (see Matrix 
Software, on page 72).

• Built-in HTML pages (see HTML Operation, on page 136)

• SIS commands (see below)

This section describes the operation of the DTP CrossPoint Matrix Switchers via SIS 
commands, including:

• Host Control Ports

• Host-to-Switcher Instructions

• Switcher-Initiated Messages

• Switcher Error Responses

• Using the Command and Response Tables

• Special Characters

NOTE: This section details the matrix-switcher-centric SIS commands. Additional 
commands are available for the DSP, see the DSP SIS Commands section, 
beginning on page 144.

Host Control Ports
The switcher has one serial port, a USB port, and three Ethernet LAN ports. Any of these 
ports can be connected to a host device such as a computer running the Extron DataViewer 
utility or the HyperTerminal utility or a control system. These ports make control of the 
switcher possible.

The rear panel Remote port and front panel Configuration port are independent of one 
another. A front panel Configuration port connection and a rear panel Remote port 
connection can be active at the same time.

Serial Port
The rear panel Remote port is an RS-232 serial port on a 3-pin captive screw connector 
(see item R on page 15).

The default serial port protocol of the rear panel Remote port is:

• 9600 baud • No parity • 8 data bits

• No flow control • 1 stop bit

See Selecting the Remote Port Baud Rate on page 43 to configure the rear panel 
Remote port from the front panel.

Extron recommends leaving the Remote port at 9600 baud.
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USB Port
The front panel Configuration port (see item A on page 21) is a standard USB port. A USB 
cable, terminated on one end with a USB mini-B male connector, is available at any local 
electronics store.

Ethernet (LAN) Port
The Ethernet cable can be terminated as a straight-through cable or a crossover cable and 
must be properly terminated for your application (see item Q on page 15).

• Crossover cable — Direct connection between the computer and the DTP CrossPoint 
switcher.

• Patch (straight-through) cable — Connection of the DTP CrossPoint switcher to an 
Ethernet LAN or direct connection between the computer and switcher.

Default IP addresses
To access the DTP CrossPoint switcher via the LAN port, you need the IP address for 
the unit, and may need the subnet mask and the gateway address. If the IP address has 
been changed to an address comprised of words and characters, you can determine 
the actual numeric IP address for the DTP CrossPoint using the ping (ICMP) utility (for all 
control access information for the IPCP Pro 350, see the IPCP Pro 350 Series User Guide 
at www.extron.com for more details). If the addresses have not been changed, the 
factory-specified defaults are:

DTP CrossPoint 84 IPCP Pro 350

• IP address 192.168.254.254 192.168.254.250

• Subnet mask 255.255.0.0 255.255.255.0

• Gateway address 0.0.0.0 0.0.0.0

NOTES:

• The values listed above are the same for all three LAN ports.

• The LAN ports give access to either the DTP CrossPoint or the built-in 
IPCP Pro 350 control processor.

• The unused ports function as a simple, multiport, unmanaged network switch so 
that you can connect additional devices to the same network.

http://www.extron.com
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Establishing a connection
Establish a network connection to a DTP CrossPoint switcher as follows:

1. Open a TCP socket to port 23 using the IP address of the switcher.

NOTE: If the local system administrators have not changed the value, the 
factory-specified default, 192.168.254.254, is the correct value for this field.

The switcher responds with a copyright message including the date, the name of the 
product, firmware version, part number, and the current date and time.

NOTES:

• If the switcher is not password-protected, the device is ready to accept SIS 
commands immediately after it sends the copyright message.

• If the switcher is password-protected, a Password: prompt appears below the 
copyright message.

2. If the switcher is password protected, enter the appropriate administrator or user 
password.

If the password is accepted, the switcher responds with Login User or Login 
Administrator.

If the password is not accepted, the Password: prompt reappears.

Connection timeouts
The Ethernet link times out after a designated period of time of no communications. By 
default, this timeout value is set to five minutes but the value can be changed (see the 
Configure port timeout SIS command on page 70).

NOTE: Extron recommends leaving the default timeout at 5 minutes and periodically 
issuing the Query (Q) command to keep the connection active. If there are long idle 
periods, Extron recommends disconnecting the socket and reopening the connection 
when another command must be sent.

Number of connections
A DTP CrossPoint switcher can have up to 200 simultaneous TCP connections, including 
all http sockets and telnet connections. When the connection limit is reached, the switcher 
accepts no new connections until some have been closed. No error message or indication 
is given that the connection limit has been reached. To maximize performance of an IP 
device, the number of connections should stay low and unnecessary open sockets should 
be closed.

Using Verbose Mode
Telnet connections to a DTP CrossPoint switcher can be used to monitor for changes that 
occur on the switcher, such as front panel operations and SIS commands from other telnet 
sockets or a serial port. For a telnet session to receive change notices from the switcher, 
the telnet session must be in verbose mode 1 or 3 (see the Verbose Mode SIS command 
on page 70).
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Host-to-Switcher Instructions
The switcher accepts SIS (Simple Instruction Set) commands through the rear panel 
Remote RS-232 port, the front panel Configuration port, and the rear panel Ethernet 
(LAN) Port. SIS commands consist of one or more characters per command field. They 
do not require any special characters to begin or end the command character sequence. 
Each switcher response to an SIS command ends with a carriage return and a line feed 
(CR/LF = ]), which signals the end of the response character string. A string is one or 
more characters.

Switcher-initiated Messages
When a local event such as a front panel operation occurs, the switcher responds 
by sending a message to the host. The switcher-initiated messages are listed below 
(underlined).

The switcher does not expect a response from the host, but, for example, the host program 
might request a new status.

(c) Copyright 20yy, Extron Electronics DTPCP84, Vx.xx, 60-nnnn-nn]
{day, date, time}]
The switcher initiates the Copyright message on the Remote RS-232 port when it is first 
powered up and on a newly connected Internet protocol (IP) port. Vx.xx is the firmware 
version number and 60-nnnn-nn is the switcher part number.

Password:]
The switcher initiates the Password message immediately after the copyright message 
when the controlling system is connected using TCP/IP or Telnet and the switcher is 
password protected. This message means that the switcher requires an administrator or 
user level password before it will perform the commands entered via this link. The switcher 
repeats the password message response for every entry other than a valid password until a 
valid password is entered.

]Login Administrator]
]Login User]
The switcher initiates the Login message when a correct administrator or user password 
has been entered. If the user and administrator passwords are the same, the switcher 
defaults to administrator privileges.

Qik]
The switcher initiates the Qik message when a front panel tie creation has occurred.

Rprnn]
The switcher initiates the Rpr message when a memory preset has been recalled from the 
front panel. “nn” is the preset number.

Amtnn*x]
The switcher initiates the Amt message when an output audio mute is toggled on or off from 
the front panel. nn is the output number and x is the mute status: 1 = on, 0 = off.

GrpmDn*y]
The switcher initiates the Grpm message when a front panel Volume knob is adjusted. “n” is 
the control: 1 (Mic Volume) or 2 (Volume).”y” is the variable.

Exen]
The switcher initiates the Exe message when the front panel security lockout (executive 
mode) is toggled on or off from the front panel. “n” is the executive mode: 0, 1, or 2.
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Switcher Error Responses
When the switcher receives an SIS command and determines that it is valid, it performs the 
command and sends a response to the host device. If the switcher is unable to perform 
the command because the command is invalid or contains invalid parameters, the switcher 
returns an error response to the host. The error response codes are:

E01 — Invalid input channel number (out of range) 
E10 — Invalid command 
E11 — Invalid preset number (out of range) 
E12 — Invalid output number (out of range) 
E13 — Invalid value (out of range) 
E14 — Invalid command for this configuration 
E22 — Busy 
E24 — Privileges violation (Users have access to all view and read commands [other than  
  the administrator password], and can create ties, presets, and audio mutes 
E25 — Device not present 
E26 — Maximum number of connections exceeded 
E27 — Invalid event number 
E28 — Bad filename or file not found

Using the Command and Response Tables
The command and response tables begin on page 60. Symbols used in the table represent 
variables in the command and response fields. Command and response examples are 
shown throughout the table. The SIS commands are not case sensitive. The ASCII to HEX 
conversion table below is for use with the command and response table.

ASCII to Hex  Conversion Table

•

Space



DTP CrossPoint 84 IPCP Series Matrix Switchers • Programming Guide 57

General Matrix Switcher Commands

Symbol definitions
] = Carriage return and line feed

} = Carriage return (no line feed)

| = Pipe (can be used interchangeably with the } character)

• = space

E = Escape key

W = Can be used interchangeably with the E character

X! = Input number 00 – 08  (00 = untied input, valid for tie commands only)

X@ = Output number 00 – 04  (00 = untied output, valid for tie commands only)

X# = EDID value (resolution and rate) See table 3 on page 61.

X$ = EDID filename nnnnn.bin. Can include a full path name. File carries 128 or 256 bytes of data.

X% = Mute status enable or available 0 = Disable (unmute) 1 = Enable (mute) 2 = Mute video and sync

X^ =  Input audio source 0 = Auto (see Example 2 on page 62) 
1 = HDMI (de-embedded digital audio) (default) 
2 = Analog 2-channel audio

X& = Output audio source 0 = Original HDMI audio 1 = Embed audio 2 = None

X* = Detected input audio format 0 = None 2 = 3-channel or bitstream 
1 = 2-channel

X( = HDCP authorized device 0 = Off 
1 = On (default)

X1) = HDCP output 0 = Auto (follow the input) (default) 
1 = On (always encrypt HDMI outputs) 
2 = Follow input with contiuous DVI trials 
3 = Always encrypt HDMI outputs with continuous DVI trials

X1! = HDCP status (for inputs) 0 = No source device connected 2 = Source connected is not HDCP-compliant 
1 = Source connected is HDCP-compliant

X1@ = HDCP status (for outputs) 0 = No monitor connected 
1 = Monitor connected but does not support HDCP 
2 = Monitor connected, supports HDCP, but the video signal is not encrypted 
3 = Monitor connected, supports HDCP, and the video signal is encrypted

X1# = Video format 0 = Auto (HDMI RGB Full to CEA sink or DVI to non-CEA sink) 
1 = DVI (RGB 444, no audio, no InfoFrames) 
2 = HDMI RGB Full (RGB 444, 000 - 255 audio, InfoFrames) 
3 = HDMI RGB Limited (RGB 444, 016 - 255 audio, InfoFrames) 
4 = HDMI YUV Full (RGB 444, 000 - 255 audio, InfoFrames) 
5 = HDMI YUV Limited (RGB 444, 016 - 255 audio, InfoFrames) 
6 = HDMI YUV Full (RGB 422, 000 - 255 audio, InfoFrames) 
7 = HDMI YUV Limited (RGB 422, 016 - 255 audio, InfoFrames)

X1$ = Output video bit depth 0 = Auto (default) 1 = 8-bit

X1% = Video mute status 0 = No mutes 2 = Video and sync 
1 = Video mute

X1^ = Input signal status 0 = No signal detected 1 = Sync detected

X1& = TP and insertion input number 07 or 08

X1* = Switch position 0 = DTP 1 = HDBT (output only) 2 = XTP

X1( = TP (scaled) and insertion output number 03 or 04

X2) = Name 12 characters maximum 
upper- and lower-case alphanumeric characters and _  /  and spaces are valid.

NOTE: The HTML language reserves certain characters for specific functions (see Special Characters on page 71).

X2! = Preset number 01 – 32

X2@ = Lock mode 0 = Mode 0 1 = Mode 1 2 = Mode 2 (default)

X2# = Scaler preset 001 – 128

X2$ = Firmware version number to second decimal place (x.xx)

X2% = Verbose firmware version-description-upload date/time (see the Query firmware version (verbose) command on page 65).
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X2^ = Voltage Positive or negative voltage and magnitude

X2& = Internal temperature Degrees Celsius

X2* = Fan speed RPM

X2( = Picture adjustments 000 through 127 (064 = default)

X3) = Position and size ±10240 Horizontal position specified from left, 
 Vertical position specified from top

X3! = Active pixels and active lines Dependent on the input signal and selected scaling.

X3@ = Aspect ratio fill or follow  1= fill (default) 2 = follow

X3# = Overscan percentage 0 = 0% (default) 1 = 2.5% 2 = 5.0%

X3$ = Test pattern 00 = Disable (default)  
01 = Crop 04 = Color bars 
02 = Alternating pixels 05 = Grayscale 
03 = Crosshatch 06 = Blue mode

X3% = Duration 0 = Output sync instantly disabled when no active video input is selected 
001 through 500 (seconds) 
501 = Output sync never times out (default)

X3^ = Screen saver status 0 = Active input detected, timer is not running 
1 = No active input, timer is running, output sync is still active 
2 = No active input, timer is expired, output sync is disabled.

X3& = Scaler output resolution and rate
 

Refresh rate (Hz)

23.98 24 25 29.97 30 50 59.94 60

640x480 11

800x600 14

1024x768 20

1280x768 29

1280x800 32

1280x1024 35

1360x768 41

1366x768 47

1440x900 53

1400x1050 56

1600x900 58

1680x1050 60

1600x1200 62

1920x1200 64

480p 65 66

576p 67

720p 68 69 70 71 72 73*

1080i 74 75 76

1080p 77 78 79 80 81 82 83 84

2048x1080 (2k) 85 86 87 88 89 90 91 92

* Default
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X3* = Captive screw or UART 0 = Captive screw RS-232 insert (default) 1 = Ethernet RS-232 insert (UART)

X3( = Port number 02 — 05 = UARTs 2 — 5 (DTP input and output ports) 
02 = Input 7 03 = Input 8 
04 = Output 3 05 = Output 4

X4) = Baud rate 9600, 19200, 38400, 115200

X4! = Parity odd, even, none, mark, space (only the first letter required) (n = default)

X4@ = Data bits 7, 8

X4# = Stop bits 1, 2

X4$ = Port timeout interval (in 10-second increments) 1 (= 10 seconds) - 65000 (default is 30 = 300 seconds = 5 minutes)

NOTE: X3( through X4$ are variables for the RS-232 inserts. These variables are repeated on page 70 as X5! through X5% and X5* for 
the rear panel Remote RS-232 port.

X4% = UART starting point The starting point (X4%) is the rear panel Remote RS-232 port. 
The next two positions (X4%+1 and X4%+2) are DTP inputs. 
The next two positions (X4%+3 and X4%+4) are DTP outputs. 
Default values: 2000 = Rear panel Remote (RS-232) port 
 2001 and 2002 = Input 7 and input 8 
 2003 and 2004 = Output 3 and output 4
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Command and Response Table for Matrix Switcher Commands

Command Function SIS Command 
(Host to Unit)

Response 
(Unit to Host)

Additional description

Create Ties

NOTES:

• Commands can be entered back-to-back in a string, with no spaces. For example: 1*1!02*03%02*03$4*4!.
• The quick multiple tie and tie input to all output commands activate all I/O switches simultaneously.
• The matrix switchers support 1- and 2-digit numeric entries (1*1 or 02*02).

Tie input video and audio to output X!*X@! OutX@•InX!•All] Tie the input X! video and audio to 
output X@.

Example: 1*3! Out03•In01•All] Tie input 1 video and audio to output 3. 

Tie input video only to output X!*X@% OutX@•InX!•Vid] Audio breakaway.

Example: 7*5% Out05•In07•Vid] Tie input 7 video to output 5.

Tie input audio only to output X!*X@$ OutX@•InX!•Aud] Audio breakaway. 

Example: 8*4$ Out04•In08•Aud] Tie input 8 audio to output 4.

Untie input video and audio 0*X@! OutX@•In00•All] Untie the video and audio input from 
output X@.

Quick multiple tie E+QX!*X@!...X!*X@$} Qik]

Example: E+Q3*4!3*3%3*2$} Qik] Tie input 3 video and audio to 
output 4, tie input 3 video to output 3, 
and tie input 3 audio to output 2.

Tie input to all outputs, video and 
audio

X!*! InX!•All]

Example: 5*! In05•All] Tie input 5 video and audio to all outputs.

NOTE: 0*! clears all ties.

Tie input to all outputs, video only X!*% InX!•Vid] Audio breakaway.

Example: 10*% In10•Vid] Tie input 10 video to all outputs.

Tie input to all outputs, audio only X!*$ InX!•Aud] Audio breakaway.

Read ties
Read video output tie X@% X!] Video input X! is tied to output X@.
Read audio output tie X@$ X!] Audio input X! is tied to output X@.

EDID commands

NOTES:

• See table 3, on the next page for X# values.
• Leading zeroes are optional for the entry of the inputs (X!s) and EDID values (X#s). Leading zeroes are reported in the response.
• For the Save (ESX#EDID}) and Import (EIX#,X$EDID}) commands, X# is valid only in the range of 75 through 82.

Assign EDID data to an input EAX!*X#EDID} EdidAX!*X#] Assign an EDID value of X# to input X!.
Example: EA7*36EDID} EdidA07*036] Assign an EDID value of 1024x768 at 

60 Hz to input 7.
Assign EDID data to all inputs EAX#*EDID} EdidAX#] Assign an EDID value of X# to all inputs.
View EDID input assignment EAX!EDID} X#]

NOTE: The “EdidA” portion of the View command response appears only when the switcher is in Verbose mode 2 or 3 (see the 
Verbose Mode SIS command on page 70).

Save output EDID to user assigned 
slot

ESX#EDID} EdidSX#] Save the output 1 EDID to location X#.

Example: ES75EDID} EdidS75] Save the output 1 EDID to user location 1.

Import EDID to user slot EIX#,X$EDID} EdidIX#]

Export EDID EEX#,X$EDID} EdidEX#]

NOTE: X! = Input number 00 – 08 (00 = untied input) 
X@ = Output number 00 – 04 (00 = untied output) 
X# = EDID value (resolution and rate) See table 3 on the next page. 
X$ = EDID filename nnnnn.bin. Can include a full path name. File carries 128 or 256 bytes of data.
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Table 3. EDID Values

X# Source or value X# Source or value X# Source or value X# Source or value

Assigned output values

01 Output 1 02 Output 2 03 Output 3 04 Output 4

DVI – PC values

05 1024x768 @ 50 Hz 13 1280x1024 @ 50 Hz 21 1440x900 @ 50 Hz 29 1920x1080 @ 50 Hz

06 1024x768 @ 60 Hz 14 1280x1024 @ 60 Hz 22 1440x900 @ 60 Hz 30 1920x1080 @ 60 Hz

07 1280x720 @ 50 Hz 15 1360x768 @ 50 Hz 23 1600x900 @ 50 Hz 31 1920x1200 @ 50 Hz

08 1280x720 @ 60 Hz 16 1360x768 @ 60 Hz 24 1600x900 @ 60 Hz 32 1920x1200 @ 60 Hz

09 1280x768 @ 50 Hz 17 1366x768 @ 50 Hz 25 1600x1200 @ 50 Hz 33 2048x1080 @ 50 Hz

10 1280x768 @ 60 Hz 18 1366x768 @ 60 Hz 26 1600x1200 @ 60 Hz 34 2048x1080 @ 60 Hz

11 1280x800 @ 50 Hz 19 1400x1050 @ 50 Hz 27 1680x1050 @ 50 Hz

12 1280x800 @ 60 Hz 20 1400x1050 @ 60 Hz 28 1680x1050 @ 60 Hz

HDMI – PC values, 2-channel Audio

35 1024x768 @ 50 Hz 42 1280x1024 @ 60 Hz 49 1440x900 @ 50 Hz 56 1680x1050 @ 60 Hz

36 1024x768 @ 60 Hz 43 1360x768 @ 50 Hz 50 1440x900 @ 60 Hz 57 1920x1200 @ 50 Hz

37 1280x768 @ 50 Hz 44 1360x768 @ 60 Hz 51 1600x900 @ 50 Hz 58 1920x1200 @ 60 Hz

38 1280x768 @ 60 Hz 45 1366x768 @ 50 Hz 52 1600x900 @ 60 Hz 59 2048x1080 @ 50 Hz

39 1280x800 @ 50 Hz 46 1366x768 @ 60 Hz 53 1600x1200 @ 50 Hz 60 2048x1080 @ 60 Hz

40 1280x800 @ 60 Hz 47 1400x1050 @ 50 Hz 54 1600x1200 @ 60 Hz

41 1280x1024 @ 50 Hz 48 1400x1050 @ 60 Hz 55 1680x1050 @ 50 Hz

HDMI HDTV

61 480p @ 60 Hz 
2-channel audio

65 720p @ 50 Hz 
multi-channel audio

69 1080i @ 50 Hz 
multi-channel audio

73 1080p @ 50 Hz 
multi-channel audio

62 576p @ 50 Hz 
2-channel audio

66 720p @ 60 Hz 
multi-channel audio

70 1080i @ 60 Hz 
multi-channel audio

74 1080p @ 60 Hz 
multi-channel audio

63 720p @ 50 Hz 
2-channel audio

67 1080i @ 50 Hz 
2-channel audio

71 1080p @ 50 Hz 
2-channel audio

64* 720p @ 60 Hz 
2-channel audio

68 1080i @ 60 Hz 
2-channel audio

82 1080p @ 60 Hz 
2-channel audio

User – Assigned EDIDs

75 User assigned 1 77 User assigned 3 79 User assigned 5 81 User assigned 7

76 User assigned 2 78 User assigned 4 80 User assigned 6 82 User assigned 8

* Default value
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Command Function SIS Command 
(Host to Unit)

Response 
(Unit to Host)

Additional description

Video mutes
Mute video only X@*1B VmtX@*1] Mute output X@ video (video off, sync on).
Mute video and sync X@*2B VmtX@*2] Mute output X@ video and sync.
Unmute video X@*0B VmtX@*0] Unmute output X@ video (video on).
Read video mute X@B X%]

Global video mute 1*B Vmt1] Mute all video outputs.

Global video and sync mute 2*B Vmt2] Mute all video and sync outputs.

Global video unmute 0*B Vmt0] Unmute all video outputs.

Audio routing selections

NOTE: These commands select between the audio embedded in the digital video stream and the 2-channel analog audio.

Input audio selection EIX!*X^AFMT} AfmtIX!*X^] Use audio from the X^ source.

Example 1: EI1*1AFMT} AfmtI01*1] Use analog audio from the analog audio 
port of input 1.

Example 2: EI1*0AFMT} AfmtI01*0] Auto (0): Digital audio takes priority over 
analog audio.

View input audio selection EIX!AFMT} X^]

View all input audio selections EIAFMT} X^1
 X^2

 X^3 ... X^8] 8 sequential audio input selections, 
starting from input 1.

Output audio HDMI select EOX@*X&AFMT} AfmtOX@*X&] When audio is broken away from video, 
embed audio from the X& source in the 
video output.

Example: EO3*0AFMT} AfmtO03*0] When audio is broken away from video, 
use the embedded audio from the input 
port when creating an audio breakaway 
tie to output 3.

View output audio breakaway 
selection

EOX@AFMT} X&]

View output audio breakaway 
selection, all outputs

EOAFMT} X&1 X&2 X&3 X&4] 4 sequential audio output selections, 
starting from output 1.

Audio input format
View detected digital input audio 
format

E40*X!STAT} X*] 
40StatX!*X*]

Format detected on input X! is X*. 
Verbose mode 2 or 3 response.

Input reports as an HDCP-authorized device
HDCP authorized device on EEX!*1HDCP} HdcpEX!*1] Set the input as an HDCP authorized 

device.
HDCP authorized device off EEX!*0HDCP} HdcpEX!*0] Set the input as not an HDCP 

authorized device.
View HDCP authorized status EEX!HDCP} X(] Show HDCP authorized device status.

HDMI output settings
Set output HDCP mode to auto ESX@*0HDCP} HdcpSX@*0] Set output X@ HDCP to auto.

Set output HDCP mode to auto (DVI) ESX@*2HDCP} HdcpSX@*2] Set output X@ HDCP to auto.

Set output HDCP mode to on ESX@*1HDCP} HdcpSX@*1] Set output X@ HDCP to always encrypted.

Set output HDCP mode to on (DVI) ESX@*3HDCP} HdcpSX@*3] Set output X@ HDCP to on (always 
encrypted).

View output HDCP mode ESX@HDCP} X1)]

NOTE: X! = Input number 01 – 08 
X@ = Output number 01 – 04 
X% = Mute enable 0 = Disable (unmute) 1 = Mute video 2 = Mute video and sync 
X^ = Input audio source 0 = Auto (see the Example 2, above) 
 1 = HDMI (de-embedded digital audio) (default) 2 = Analog 2-channel audio 
X& = Output audio source 0 = Original HDMI audio 1 = Embed audio 2 = None 
X* = Detected input audio format 0 = None 1 = 2-channel 2 = 3-channel or bitstream 
X( = HDCP authorized device 0 = Off 1 = On (default) 
X1) = HDCP output 0 = Auto (follow the input) (default)  2 = Follow input with contiuous DVI trials 
 1 = On (always encrypt HDMI outputs) 3 = Always encrypt HDMI outputs, continuous DVI trials
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Command Function SIS Command 
(Host to Unit)

Response 
(Unit to Host)

Additional description

HDCP status
View input HDCP status EIX!HDCP} X1!]

View HDCP status of all inputs EIHDCP} X1!1 X1!2 X1!3... X1!8]

View output HDCP status EOX@HDCP} X1@]

View HDCP status of all outputs EOHDCP} X1@1 X1@2 X1@3 X1@4]

Output format
Set output format EX@*X1#VTPO} VtpoX@*X1#]

View output format EX@VTPO} X1#]

Output video bit depth
Set bit depth EX@*X1$BITD} BitdX@*X1$]

View bit depth EX@BITD} X1$]

View ties and mutes
Read video output tie X@% X!] Video input X! is tied to output X@.

Example: 7% 02] Input 2 video is tied to output 7.

Read audio output tie X@$ X!] Audio input X! is tied to output X@.
Example: 3$ 06] Input 6 audio is tied to output 3.

View output mutes EVM} MutX1%1 X1%2 X1%3 X1%4] Each X1% is the mute status of an output: 
left = output 1, right = output 4).

NOTE: The “Mut” portion of the response appears only when the switcher is in Verbose mode 2 or 3.

Input sync detection
View all input connections 0LS Frq00•X1^1 X1^2 ... X1^8] Each X1^ is the connection status of an 

input, starting from input 1.

NOTE: The “Frq00•” portion of the response appears only when the switcher is in Verbose mode 2 or 3.

Example: 0LS

Input:
Response Status:

 No input detected Sync detected

1 2 3 4 5 6 7 8
0 0 0 1 1 1 0 1

DTP/HDBaseT/XTP switch positions
Check input switch position EIX1&HDBT} X1*] 

HdbtIX1&*X1*]
Verbose mode 0 and 1. 
Verbose mode 2 and 3.

Check output switch position EOX1(HDBT} X1*] 
HdbtOX1(*X1*]

Verbose mode 0 and 1. 
Verbose mode 2 and 3.

NOTE: X! = Input number 01 – 08 
X@ = Output number 01 – 04 
X1! = HDCP status (for inputs) 0 = No source device connected 2 = Source connected is not HDCP-compliant 
 1 = Source connected is HDCP-compliant 
X1@ = HDCP status (for outputs) 0 = No monitor connected 
 1 = Monitor connected, does not support HDCP 
 2 = Monitor connected, supports HDCP, ,the video signal is not encrypted 
 3 = Monitor connected, supports HDCP, the video signal is encrypted 
X1# = Video format 0 = Auto (HDMI RGB Full to CEA sink or DVI to non-CEA sink) 
 1 = DVI (RGB 444, no audio, no InfoFrames) 
 2 = HDMI RGB Full (RGB 444, 000 - 255 audio, InfoFrames) 
 3 = HDMI RGB Limited (RGB 444, 016 - 255 audio, InfoFrames) 
 4 = HDMI YUV Full (RGB 444, 000 - 255 audio, InfoFrames) 
 5 = HDMI YUV Limited (RGB 444, 016 - 255 audio, InfoFrames) 
 6 = HDMI YUV Full (RGB 422, 000 - 255 audio, InfoFrames) 
 7 = HDMI YUV Limited (RGB 422, 016 - 255 audio, InfoFrames) 
X1$ = Output video bit depth 0 = Auto (default) 1 = 8-bit 
X1% = Video mute status 0 = No mutes 1 = Video mute 2 = Video and sync 
X1^ = Input signal status 0 = No signal detected 1 = Sync detected 
X1& = TP and insertion input number 07 or 08 
X1* = Switch position 0 = DTP 1 = HDBT (output only) 2 = XTP 
X1( = TP (scaled) and insertion output number 03 or 04
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Command Function SIS Command 
(Host to Unit)

Response 
(Unit to Host)

Additional description

Names

NOTE: The HTML language reserves certain characters for specific functions (see Special Characters on page 71).

Write input name EX!,X2)NI} NmiX!,X2)]
Example: E1,Podium camNI} Nmi01,Podium cam] Name input 1 “Podium cam”.

Read input name EX!NI} X2)]

Write output name EX@,X2)NO} NmoX@,X2)]
Example: E1,Main PJ1NO} Nmo01,Main PJ1] Name output 1 “Main PJ1”.

Read output name EX@NO} X2)]

Write EDID name EEX#*X2)UNAM} UnamEX#*X2)]

NOTE: For the Write, Clear, and Read EDID Name commands, X# is valid only in the range of 75 through 82 (User EDID slots 1 through 8).

Example: EE75*Slot 1UNAM} UnamE75*Slot 1] Name EDID location 75 “Slot 1“.

Clear EDID name EEX#*•UNAM} UnamE75*USER n] n = 1 through 8.

Read EDID name EEX#UNAM} X2)]

Write scaler preset name E2*X2#,X2)PNAM} Pnam2*X2#,X2)]

Example: E2*5,preset 1PNAM} Pnam2*005,preset 1] Name scaler preset 5 “preset 1”.

Read scaler preset name E2*X2#PNAM] X2)]

Recall presets

NOTES:

• Create presets using the DSP Configurator program (see Save a preset on page 108).
• If you try to recall a preset that is not saved, the matrix switcher responds with the error code E11.

Recall a global preset X2!. RprX2!] Command character is a period.

Example: 5. Rpr05] Recall preset 5, (ties and audio settings).

Resets
System reset (factory default) EZXXX} Zpx] Clear all ties and presets, restore group 

masters 1 and 2.
Absolute reset, including IP settings EZQQQ} Zpq] Similar to EZXXX}, plus clear the 

IP address to 192.168.254.254 and 
subnet mask to 255.255.000.000.

NOTE: The absolute reset (EZQQQ}) command resets not only the switcher, but any connected endpoints.

Absolute reset, excluding IP settings EZY} Zpy] Similar to EZQQQ}, but preserves IP 
address, subnet mask, gateway address, 
unit name, DHCP setting, and port 
mapping. 
Recommended after a firmware update.

Executive modes

NOTE: See Setting the Front Panel Locks (Executive Modes) on page 44 for more information on the Lock modes.

Lock all front panel functions 1X Exe1] Enable Lock mode 1.

Lock advanced front panel functions 2X Exe2] Enable Lock mode 2.

Unlock all front panel functions 0X Exe0] Enable Lock mode 0.

View lock status X X2@]

NOTE: X! = Input number 01 – 08 
X@ = Output number 01 – 04 
X# = EDID value (resolution and rate) See table 3 on page 61. 
X2) = Name Up to 12 upper- and lower-case alphanumeric characters and _  /  and spaces 
X2! = Preset number 01 – 32 
X2@ = Lock mode 0 = Mode 0 1 = Mode 1 2 = Mode 2 (default) 
X2# = Scaler preset 001 – 128
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Command Function SIS Command 
(Host to Unit)

Response 
(Unit to Host)

Additional description

Information requests
Information request I DTPCP84]

Request part number N 60-nnnn-nn] See the Extron website for the part 
number.

NOTE: There are up to three separate sets of Extron firmware on which the switcher can report: the controller firmware, which is the 
overall control firmware; the Ethernet protocol firmware, which handles the Ethernet interface; and the latest optional Extron firmware 
update, which is available at www.extron.com.

Query controller firmware version Q X2$]

Example: Q 1.23] The factory-installed controller firmware 
version is 1.23 (sample value only).

Query controller firmware version 
(verbose)

0Q X2$-X2%-X2%] Detailed status of the controller firmware 
and any firmware upgrade. The active 
firmware is marked by an asterisk (*). 
A caret (^) indicates a bad checksum 
or an invalid load. ?.?? indicates that 
firmware is not loaded.

Response description: Ethernet protocol firmware version-controller firmware version-updated firmware version

Example: 0q See below

Ethernet protocol
firmware

Description

DTP CrossPoint firmware version Updated firmware version

* indicates the version running Upload date and time

1.23-1.00(1.06LX-DTPCP84  -Tue, 08 Apr 2014 00:00:00 UTC)-1.00*(1.06LX-DTPCP84  -Mon, 21 Apr 2014 16:39:21 UTC)

Request system status S Sts00*X2^•X2&•X2*•X2*]

NOTE: The “Sts00*” portion of the response appears only when the switcher is in Verbose mode 2 or 3.

Response description: Power supply•Temperature Celsius•Fan 1 RPM•Fan 2 RPM]

Example: S

Power supply at 12.25V

Temperature is 35.0 °C Fan 2 rotating at 2004 RPM

12.25•35.00•1976•2004

View and erase file directory

NOTE: The response to the View File Directory command differs, depending on whether the command is sent via an RS-232 or Telnet 
connection or sent via a Web browser connection.

View file directory 
RS-232 port and Telnet

EDF} See below: List user-supplied files.

filename1•date/time•length] 
filename2•date/time•length]

 • • 
 • •
filenamen•date/time•length] 
# of•Bytes•Left]]

View file directory 
Web browser

EDF} See below: List user-supplied files.

Var•file•=•new•array•();
File•[1]•=•‘filename1,date1,filesize1‘; 
File•[2]•=•‘filename3,date3,filesize3‘;

 • • 
 • •
File•[n]•=•‘filenamen,daten,filesizen‘; 
File•[n+1]•=•# of•Bytes•Left

Erase user-supplied web page/files EfilenameEF} Del•filename]

NOTE: X2$ = Firmware version number to second decimal place (x.xx) 
X2% = Verbose firmware version-description-upload date and time. 
X2^ = Voltage Positive or negative voltage and magnitude 
X2& = Internal temperature Degrees Celsius 
X2* = Fan speed RPM
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Command Function SIS Command 
(Host to Unit)

Response 
(Unit to Host)

Additional description

Scaler Output Commands
Brightness
Set a specific brightness value EX1(*X2(BRIT} BritX1(*X2(] Specify the brightness adjustment.

Increment brightness value EX1(+BRIT} BritX1(*X2(] Increase the brightness setting by one.

Decrement brightness value EX1(–BRIT} BritX1(*X2(] Decrease the brightness setting by one.

View the brightness value EX1(BRIT} X2(] Show the brightness setting.

Contrast
Set a specific contrast value EX1(*X2(CONT} ContX1(*X2(] Specify the contrast adjustment.

Increment contrast value EX1(+CONT} ContX1(*X2(] Increase the contrast setting by one.

Decrement contrast value EX1(–CONT} ContX1(*X2(] Decrease the contrast setting by one.

View the contrast value EX1(CONT} X2(] Show the contrast setting.

Detail
Set a specific detail value EX1(*X2(HDET} HdetX1(*X2(] Specify the detail adjustment.

Increment detail value EX1(+HDET} HdetX1(*X2(] Increase the detail setting by one.

Decrement detail value EX1(–HDET} HdetX1(*X2(] Decrease the detail setting by one.

View the detail value EX1(HDET} X2(] Show the detail setting.

Horizontal shift
Specify a value EX1(*X3)HCTR} HctrX1(*X3)] Set the horizontal location of first active 

pixel in output X1(.
Increment value EX1(+HCTR} HctrX1(*X3)] Increment the value by one pixel (shift 

the image to the right).
Decrement value EX1(–HCTR} HctrX1(*X3)] Decrement the value by one pixel (shift 

the image to the left).
View EX1(HCTR} X3)] Show the horizontal location of first 

active pixel in output X1(.

Vertical shift
Specify a value EX1(*X3)VCTR} VctrX1(*X3)] Set the vertical location of first active line 

in output X1(.
Increment value EX1(+VCTR} VctrX1(*X3)] Increment the value by one line (shift up).

Decrement value EX1(–VCTR} VctrX1(*X3)] Decrease the value by one line (shift down).

View EX1(VCTR} X3)] Show the vertical location of first active 
line in output X1(.

Horizontal size (image)
Specify a value EX1(*X3)HSIZ} HsizX1(*X3)] Set the horizontal of output X1(.
Increment value EX1(+HSIZ} HsizX1(*X3)] Increment the value by one pixel (make 

one pixel wider).
Decrement value EX1(–HSIZ} HsizX1(*X3)] Decrement the value by one pixel (make 

one pixel narrower).
View EX1(HSIZ} X3)] Show the horizontal size of output X1(.

Vertical size (image)
Specify a value EX1(*X3)VSIZ} VsizX1(*X3)] Set the vertical of output X1(.
Increment value EX1(+VSIZ} VsizX1(*X3)] Increment the value by one pixel (make 

one pixel taller).
Decrement value EX1(–VSIZ} VsizX1(*X3)] Decrement the value by one pixel (make 

one pixel shorter).
View EX1(VSIZ} X3)] Show the vertical size of output X1(.

NOTE: X1( = TP (scaled) and insertion output number 03 or 04 
X2( = Picture adjustments 000 through 127 (064 = default) 
X3) = Position and size ±10240 (Horizontal is specified from left, vertical from top)
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Command Function SIS Command 
(Host to Unit)

Response 
(Unit to Host)

Additional description

Compound image position and size
Specify all size and position values EX1(,X3)*X3)*X3)*X3)XIMG}

XimgX1(,X3)*X3)*X3)*X3)]

Example: E3,+0*+0*2000*1000XIMG}

Ximg3,+00000*+00000*02000*01000]

View all size and position values EX1(XIMG} X3)*X3)*X3)*X3)]

View active pixels and lines
View active pixels EX1(APIX} ApixX1(*X3!]

NOTE: The “ApixX1(*” portion of the response appears only when the switcher is in Verbose mode 2 or 3.

View active lines EX1(ALIN} AlinX1(*X3!]

NOTE: The “AlinX1(*” portion of the response appears only when the switcher is in Verbose mode 2 or 3.

View defaults EVX1(SPEC} Show active pixels, active lines, total 
pixels, and total lines.SpecVX1(*X3!*X3!*X3)*X3)]

NOTE: The “SpecVX1(*” portion of the response appears only when the switcher is in Verbose mode 2 or 3.

Aspect ratio
Set to fill EX1(*1ASPR} AsprX1(*1] Always fill the output.

Set to follow EX1(*2ASPR} AsprX1(*2] Follow the input aspect ratio.

View aspect ratio EX1(ASPR} X3@]

Execute Auto-Image
Execute Auto-Image X1(*A ImgX1(]

Overscan

NOTE: The Overscan command applies to SMPTE input rates only (NTSC or PAL, 480p to 1080p, 50 Hz or 60 Hz).

Set overscan value E6*X3#OSCN} Oscn6*X3#]

Read overscan value E6OSCN} X3#]

Save and recall scaler presets

NOTE: If you try to recall a scaler preset that is not saved, the matrix switcher responds with the error code E13.

Save a scaler preset 2*X1(*X2#, 2SprX1(*X2#] Command character is a comma.

Recall a scaler preset 2*X1(*X2#. 2RprX1(*X2#] Command character is a period.

Example: 2*3*5. 2Rpr3*005] Recall preset 5, which becomes the 
current configuration.

Erase a scaler preset EX2*X2#PRST} PrstX2*X2#]

Show scaler preset availabilities 51# PreIX%1X%2X%3 ... X%128] Each X% is the availability status of a 
scaler preset, starting from preset 1.

NOTE: The “PreI” portion of the response appears only when the switcher is in Verbose mode 2 or 3.

Auto memories
Enable auto memories EX1(*1AMEM} AmemX1(*1] Set auto memories on. Previous settings 

for the incoming signal are recalled.
Disable auto memories EX1(*0AMEM} AmemX1(*0] Set auto memories off.

Show auto memory status EX1(AMEM} X%] Default = 0.

NOTE: X% = Available or enable 0 = Not available or disable 1 = Available or enable 
X1( = TP (scaled) and insertion output number 03 or 04 
X2# = Scaler preset 001 – 128 
X2( = Picture adjustments 000 through 127 (064 = default) 
X3) = Position and size ±10240 Horizontal is specified from left, vertical from top 
X3! = Active pixels and active lines Dependent on the input signal and selected scaling. 
X3@ = Aspect ratio fill or follow  1= fill (default) 2 = follow 
X3# = Overscan percentage 0 = 0% (default) 1 = 2.5% 2 = 5.0%
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Command Function SIS Command 
(Host to Unit)

Response 
(Unit to Host)

Additional description

Test pattern
Enable a test pattern EX1(*X3$TEST} TestX1(*X3$]

Disable test patterns EX1(*0TEST} TestX1(*0]

View test pattern selection EX1(TEST} X3$]

Screen saver timeout and status
Set screen saver to go black 
immediately

ETX1(*0SSAV} SsavTX1(*000] Disable sync whenever no input video is 
selected.

Set screen saver timeout duration ETX1(*X3%SSAV} SsavTX1(*X3%] Blank output X1( after X3% seconds.
Example: ET3*300SSAV} SsavT3*300] Blank output 3 after 300 seconds 

(5 minutes).
Set screen saver to never go black ETX1(*501SSAV} SsavTX1(*501] Do not blank output X1(.
View screen saver timeout duration ETX1(SSAV} X3%]

View screen saver status ESX1(SSAV} X3^]

Scaler output rate
Set scaler output rate EX1(*X3&RATE} RateX1(*X3&] Set the scaler to output X3& on output X1(.

Example: E3*73RATE} Rate3*73] Set the scaler to output 720p video at 
60 Hz on output 3.

View scaler output rate EX1(RATE} X3&]

RS-232 Insertion Commands
Captive screw and Ethernet serial port insertion enables
Enable an input captive screw serial 
port insertion

EIX1&*0LRPT} LrptIX1&*0] Enable the captive screw serial port 
insert on input X1&. This disables the 
Ethernet RS-232 insert.

Enable an input Ethernet serial port 
insertion

EIX1&*1LRPT} LrptIX1&*1] Enable the Ethernet serial port insert 
on input X1&. This disables the captive 
screw serial port insert.

Set all RS-232 input insertions EIX3**LRPT} LrptIX3*]

View input insertion EIX1&LRPT} X3*]

View all input insertions EILRPT} X3*7X3*8] One X3* for both available inputs, 
starting at input 7.

Enable an output captive screw 
serial port insertion

EOX1(*0LRPT} LrptOX1(*0] Enable the captive screw serial port 
insert on output X1(. This disables the 
Ethernet serial port insert.

Enable an output Ethernet serial 
port insertion

EOX1(*1LRPT} LrptOX1(*1] Enable the Ethernet serial port insert 
on output X1(. This disables the 
captive screw serial port insert.

Set all RS-232 output insertions EOX3**LRPT} LrptOX3*]

View RS-232 output insertion EOX1(LRPT} X3*]

View all output insertions EOLRPT} X3*3X3*4] One X3* for both available outputs, 
starting at output 3.

NOTE: X1& = TP and insertion input number 07 or 08 
X1( = TP (scaled) and insertion output number 03 or 04 
X3$ = Test pattern 00 = Disable (default)  
 01 = Crop 04 = Color bars 
 02 = Alternating pixels 05 = Grayscale 
 03 = Crosshatch 06 = Blue mode 
X3% = Duration 0 = Output sync instantly disabled when no active video input is selected 
 001 through 500 (seconds) 
 501 = Output sync never times out (default) 
X3^ = Screen saver status 0 = Active input detected, timer is not running 
 1 = No active input, timer is running, output sync is still active 
 2 = No active input, timer is expired, output sync is disabled. 
X3& = Scaler output resolution and rate See the table on page 58. 
X3* = Captive screw or UART 0 = Captive screw RS-232 insert 1 = Ethernet RS-232 insert (UART) (default)
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Command Function SIS Command 
(Host to Unit)

Response 
(Unit to Host)

Additional description

Ethernet and serial port insert parameters
Set serial port parameters EX3(*X4),X4!,X4@,X4#CP}

CpnX3(•CcpX4),X4!,X4@,X4#]

Read serial port parameters EX3(CP} X4),X4!,X4@,X4#]
Configure current port timeout E0*X4$TC} Pti0*X4$]

Read current port timeout E0TC} X4$]

Configure global IP port timeout E1*X4$TC} Pti1*X4$]

Read global IP port timeout E1TC} X4$]

Set UART start point EX4%MD} PmdX4%] Sets the initial (lowest) port number for 
the range of numbers assigned to the 
serial port and UARTs.

Read UART start point EMD} X4%]

NOTE: X3( = Port number 01 = Remote (RS-232) port 
02 — 05 = UARTs 1 — 5 (DTP input and output ports) 

X4) = Baud rate 300, 600, 1200, 1800, 2400, 3600, 4800, 7200, 9600, 14400, 19200, 
28800, 38400, 57600, 115200 (default=9600) 

X4! = Parity odd, even, none, mark, space (only the first letter required) (n = default) 
X4@ = Data bits 7, 8 
X4# = Stop bits 1, 2 
X4$ = Port timeout interval (in 10-second increments) 1 (= 10 seconds) - 65000 (default is 30 = 300 seconds = 5 minutes) 
X4% = UART starting point The starting point (X4%) is the rear panel Remote RS-232 port. 

The next two positions (X4%+1 and X4%+2) are DTP inputs. 
The next two positions (X4%+3 and X4%+4) are DTP outputs. 
Default values: 2000 = Rear panel Remote (RS-232) port 
 2001 and 2002 = Input 7 and input 8 

2003 and 2004 = Output 3 and output 4
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Port Specific and Communications Protocol SIS Commands

Symbol definitions for Remote port specific SIS commands
X5) = Password Up to 12 alphanumeric characters

NOTE: The HTML language reserves certain characters for specific functions (see Special Characters on the next page).

X5! = Port number 01 = Remote (RS-232) port

X5@ = Baud rate 9600 (default), 19200, 38400, 115200

X5# = Parity odd, even, none, mark, space (only the first letter required) (n = default)

X5$ = Data bits 7, 8 (default)

X5% = Stop bits 1 (default), 2

NOTE: X5! through X5% and X5* are variables for the rear panel Remote RS-232 port. These variables are repeated on page 59 as X3( 
through X4$ for the RS-232 inserts.

X5^ = Port type 0 = RS-232 (default)  1 = RS-422 (not available on DTP CrossPoint)

X5& = Verbose mode 0 = Clear or none (default for Telnet connection) 
1 = Verbose mode (default for RS-232 or USB connection) 
2 = Tagged responses for queries 
3 = Verbose mode and tagged for queries

NOTE: If tagged responses is enabled (modes 2 and 3), all read commands return the constant string and the value as the set command 
does (for example, the read matrix name command ECN}, returns Ipn•X2)]).

X5* = Port timeout interval (in 10-second increments) 1 (= 10 seconds) - 65000 (default is 30 = 300 seconds = 5 minutes)

SIS Command and Response Table for Remote and Communications Protocol Commands

Command Function SIS Command 
(Host to Unit)

Response 
(Unit to Host)

Set administrator password EX5)CA} Ipa•X5)]

Read administrator password ECA} X5)]

Reset (clear) administrator password E•CA} Ipa•]

Set user password EX5)CU} Ipu•X5)]

Read user password ECU} X5)]

Reset (clear) user password E•CU} Ipu•]

Set serial port parameters EX5!*X5@,X5#,X5$,X5%CP} CpnX5!•CcpX5@,X5#,X5$,X5%]

Read serial port parameters EX5!CP} X5@,X5#,X5$,X5%]
Configure flow control EX5!*Y8^,Y8&CF} CpnX5!•CflY8^,Y8&]

Read flow control EX5!CF} Y8^,Y8&]

Configure receive timeout EX5!*Y8*,Y8(CE} CpnX5!•CceY8*,Y8(,Y9),Y9!]

NOTE: The configure command is sufficient as shown for most users, with the priority (Y9)) and length or delimiter (Y9!) omitted). 
 The response in this case is “CpnX5!•CceY8*,Y8(,0,00000L],” with the default Y9) and Y9! values returned.

Read receive timeout EX5!CE} Y8*,Y8(,Y9),Y9!]

Set mode EX5!*X5^CY} CpnX5!•CtyX5^]

Read mode EX5!CY} X5^]

Set verbose mode EX5&CV} VrbX5&]

Read verbose mode ECV} X5&]

Configure current port timeout E0*X5*TC} Pti0*X5*]

Read current port timeout E0TC} X5*]

Configure global IP port timeout E1*X5*TC} Pti1*X5*]

Read global IP port timeout E1TC} X5*]

NOTE: This section details the matrix-switcher-centric SIS commands. Additional 
commands are available for the DSP, see the DSP SIS Commands section, 
beginning on page 144.



 

DTP CrossPoint 84 IPCP Series Matrix Switchers • Programming Guide 71

IPCP Pro 350 Information
The DTP CrossPoint 84 includes a built-in IPCP Pro 350 control processor that supports 
the LAN ports and other functionality. See the IPCP Pro 350 Series User Guide at 
www.extron.com.

Special Characters
The HTML language reserves certain characters for specific functions. The switcher does 
not accept these characters as part of names, passwords, or locally created file names.

The switcher rejects the following characters: 
{space (spaces are Ok for names)}  +  ~  ,  @  =  ‘  [  ]  {  }  <  >  ’  “  semicolon (;)  colon (:)  
|  \  and ?.
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Matrix Software

The DTP CrossPoint Matrix Switcher can be remotely controlled, monitored, or configured via:

• SIS commands (see Programming Guide, on page 52)

• Built-in HTML pages (see HTML Operation, on page 136)

• The following two Extron computer programs:

• Product Configuration Software

• DSP Configurator.

This section details the two programs, both available on the Extron website. The section 
covers:

• Software Operational Considerations and Installation

• Product Configuration Software

• DSP Configurator Program

• Optimizing the Audio

The Windows-based DSP Configurator program and Extron Product Configuration Software 
(PCS) communicate with the switcher via the following ports:

• Rear panel LAN ports — Password-protected RJ-45 connections (see Software 
Operation via Ethernet, on the next page).

• Front Panel Configuration port — A non-password-protected USB mini-B port (see 
Software Operation via USB Port, on the next page).

Both programs are compatible with Windows 2000, Windows XP, and later.

The Product Configuration Software manages basic functions such as:

• Video and audio matrix (making ties) • Test patterns

• Video input and output configuration • RS-232 insertion

• Scaler setup and picture controls • Line audio input level and output volume

• EDID management

The DSP Configurator software provides all of the tools and controls necessary for 
configuring and controlling the advanced audio mixing and processing functions available in 
the digital signal processor built into the switcher.

NOTE: The DSP Configurator has a software lock that protects the complex DSP audio 
adjustments, making them unavailable for selection in PCS. This protects the DSP 
settings against inadvertent changes made by the more basic PCS audio adjustment 
capabilities.

This software lock can be overridden, but Extron STRONGLY advises against doing 
so.
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Software Operational Considerations and Installation

Software Operation via Ethernet
When the switcher is connected to an Ethernet WAN or LAN, up to 200 users can be 
connected to locally or remotely operate it, using the DSP Configurator or Product 
Configuration Software (see item Q on page 15).

Connection to the switcher via the Ethernet can be password protected. There are two 
levels of password protection:

• Administrators have full access to all matrix switching capabilities and editing functions.

• Users can select inputs and outputs, recall presets, and view all settings with the 
exception of passwords.

If the same password or no password is required for logging on, all personnel log on with 
administrator privileges. Fields and functions that exceed user privileges are not available in 
the Product Configuration Software when the operator is logged on as a user.

Software Operation via a USB Port
The front panel Configuration port (see item A on page 21) and a standard USB cable, 
can be used for remote control of the switcher using the DSP Configurator or Product 
Configuration Software. The standard USB cable must be terminated on one end with a 
USB mini-B male connector.

Installing the Software
The PCS, version 2.0 or newer; DSP Configurator, version 2.0 or newer; and Firmware 
Loader are available on the Extron website. Download and install all programs as follows:

NOTE: Steps 1 through 6, below, are also used to download a firmware update package.

1. Visit the website www.extron.com and click the Download tab (see figure 32).

— OR —
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Figure 32. Downloading a Software or Firmware Package (PCS Shown)

2. Click the Software or Firmware link as appropriate to the operation you are 
performing.

www.extron.com
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3. Click Download for the desired software or firmware to download and (see figure 32).

TIP: Jump to the nearest page of downloads by clicking the desired filtering letter.

The Download Center dialog box appears (see figure 33).

4444444444

5555555555

Figure 33. Download Center Dialog Box

4. Enter the requested personal information;

TIP: Click Remember Me to eliminate step 4 in future downloads.

5. Click Download to copy the software or firmware to the computer. The download warns 
you about downloads and asks you to confirm it (see figure 34).

6666666666

Figure 34. Download Warning and Confirmation

NOTE: Figure 34 may appear different or may not appear at all, depending on your 
web browser choice and its security settings.

6. Cick Run to confirm that you want to run the installation.

7. For a firmware download, exit this procedure and return to Updating the Firmware 
in this Matrix Software section on page 78 or Update the firmware in the HTML 
Operation section on page 140.
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8. Follow the on-screen instructions. The installation creates the necessary subfolders of 
C:\Program Files and the necessary groups. It places the appropriate icons into a 
correct group folders:

NOTE: C:\Program Files(x86)\ ...  for 64-bit Windows OS.

Product Configuration Software —

• Folder — C:\Program Files\Extron\ Extron PCS

• Group folder —Extron Electronics\Extron Product Configuration 
Software

• Check for Extron PCS Updates
• Extron PCS Help
• Extron Product Configuration Software
• Uninstall Extron Product Configuration Software

DSP Configurator —

• Folder — C:\Program Files\Extron\DSP_Configurator

• Group folder —Extron Electronics\DSP Configurator

• DSP Configurator Help
• DSP Configurator
• Uninstall DSP Configurator

Firmware Loader —

• Folder — C:\Program Files\Extron\FWLoader

• Group folder —Extron Electronics\Firmware Loader

• Check for Firmware Loader Updates
• Firmware Loader Help
• Firmware Loader
• Uninstall Firmware Loader
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Product Configuration Software

Starting the Program
Start the Extron Product Configuration Software as follows:

1. Click Start > Programs > Extron Electronics > Extron Product Configuration 
Software > Extron Product Configuration Software. 

The Product Configuration Software opens to the Device Discovery screen (see figure 35).
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Figure 35. Device Discovery Screen

2. Select (click) your DTP CrossPoint and click Connect (see figure 35). The Product 
Configuration Software opens to the EDID Minder page (see figure 36 on the next 
page).

Operate the Product Configuration Software as described in the PCS Help.

Menu 
• Save — Saves a configuration file consisting of a complete set 

of matrix switcher settings, including ties, presets, EDIDs, input 
video configurations, input audio configurations, output video 
configurations, output audio configurations, RS-232 insertion 
setting, and screen saver settings, to a file. If no file currently exists, 
the program prompts you for a file name. The file extension for 
these files is .extc.

• Save As ... — Saves a configuration file to a new location.

• Connect and Apply — Calls the Device Discovery screen where 
you can select a different or the same Extron device, connect to it, and open and apply 
a saved configuration file to it.

NOTE: Connect and Apply is unavailable for selection when the Product 
Configuration Software is currently connected to a device.

• Open and Apply — Opens a saved configuration file and applies its settings to the 
connected device shown on the currently selected device tab.

• Disconnect — Disconnects the Product Configuration Software from the unit while 
leaving the program active.
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Figure 36. Product Configuration Software (DTP CrossPoint 84 Shown Connected)

• Settings — Allows you to view and set a wide assortment of hardware and 
communication settings. Select settings that can be changed:

• Device name

• Date and Time

• Adminstrator and user passwords

NOTE: An Administrator password must be assigned before a User password 
can be assigned.

• RS-232 baud rate for the rear panel Remote port

• TCP/IP settings (DHCP, IP address, subnet mask, gateway address, and DNS 
server)

• Reset Device ... — Opens a dialog box that allows you to initiate 3 levels of matrix 
switcher reset.

• Update Firmware ... — Disconnects the Product Configuration Software from the unit 
and calls the Firmware Loader utility in the background (see Updating the Firmware, 
on the next page).

• About This Module ... — Provides the version number of the software.
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Updating the Firmware
The Product Configuration Software can call the Firmware Loader utility, which provides 
a way to replace the firmware that is coded on the control board of the switcher without 
taking the unit out of service.

NOTE: Upgrading the firmware does not overwrite the current configuration.

Update the unit firmware as follows:

1. Perform steps 1 through 6 of Installing the Software, on page 73, to download the 
firmware upgrade from the Extron website, www.extron.com.

2. Click Run in the File Download and Security Warning dialog boxes (see figure 37 on the 
next page). The PC downloads the firmware update from the Extron website and starts 
the Extron Installation Program to extract the firmware file.

3. Click Next. The program extracts the firmware files and places them in a folder 
identified in the InstallShield Wizard window.

ATTENTION:

• The extension of the firmware file must be .eff or .efs. Opening a file with an 
incorrect extension may cause the device to stop functioning.

• L’extension du fichier firmware doit être .eff ou .efs. Si un fichier est ouvert avec 
une mauvaise extension, l’appareil peut arrêter de fonctionner.

NOTES:

• Note the folder to which the firmware file is saved. When downloaded 
from the Extron website, the firmware is placed in a subfolder of:

• 64-bit Windows OS:  C:\Program Files (x86)\Extron\Firmware.

• 32-bit Windows OS:  C:\Program Files\Extron\Firmware.

• The original factory-installed firmware is permanently available on the unit. If 
the attempted firmware upload fails, the unit reverts to the factory-installed 
firmware.

4. Click Finish to exit the program.
 

5. Connect the computer to the rear panel LAN port (see item Q on page 15) or front 
panel Configuration port (see item A on page 21) of the switcher.

6. Start the Product Configuration Software and connect to the unit (see Starting the 
Program, steps 1, 2, 3, and 5, starting on page 76.

http://www.extron.com
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Folder Where
Firmware is
Saved.
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Figure 37. Extracting Firmware Upgrade Files

7. Click Tools > Update firmware. The software asks you to confirm that you want to 
continue the update (see figure 38 on the next page).



 

DTP CrossPoint 84 IPCP Series Matrix Switchers • Matrix Software 80

 

8888888888

9999999999

¢¢¢¢¢¢¢¢¢¢

££££££££££

¢¢¢¢¢¢¢¢¢¢

Figure 38. Updating Firmware

8. Click Continue. The Product Configuration Software disconnects itself from the unit 
and calls the Firmware Loader utility in the background. The Update Firmware dialog 
box appears.

9. Click Browse. The Open dialog box opens.

10. Navigate to the folder where you saved the firmware upgrade file (see figure 38, above). 
Select the file and click Open. The Update Firmware dialog box returns to the top.

11. Click Update to continue.

The Firmware Loader utility tests the  
connection, installs the update, and then 
verifies the firmware.

At the conclusion of the process, the utility reports Upload Complete. 

12. Click Close. The Product Configuration Software window returns to the front.



 

DTP CrossPoint 84 IPCP Series Matrix Switchers • Matrix Software 81

13. Click the  in the connection tab to completely disconnect the program from the unit 
and then reconnect the program as described in Starting the Program, beginning at 
step 3 on page 76.

DSP Configurator Program
The DSP Configurator can connect to the switcher via any rear panel LAN port or the front 
panel Configuration port. Use of the rear panel Remote (RS-232) port is not recommended.

Starting the Program

NOTE: Extron recommends connection via an Ethernet LAN port for the 
DSP Configurator program.

Start the DSP Configurator Program, as follows:

1. Click Start > Programs > Extron Electronics > DSP Configurator > DSP 
Configurator. The DSP Configurator startup screen displays (see figure 39).

2222222222

Figure 39. DSP Configurator Screen and DTP CrossPoint Selection

2. If necessary, select the DTP CrossPoint switcher in the drop-down box and click OK.

TIP: If you have only DTP CrossPoint switchers of the same model, click Always 
perform the selected operation to eliminate step 2 in future startups.

The DSP Configurator program starts in Emulate mode (see figure 40 on the next 
page).
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Figure 40. DSP Configurator (Stereo Audio) Program Window
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Using the Program
In the DSP Configurator window in Emulate mode, you can tailor a variety of audio 
parameters and then transfer them to the DTP CrossPoint by going to Live mode 
(connected to a DTP CrossPoint). You can also switch to Live mode and then tailor the 
audio settings in real time, while listening to the audio output with a critical ear (see Emulate 
mode vs. Live mode, on page 109).

There are three possible DSP Configurator displays, shown below, with the following 
available switching functions:

• Audio and video I/O page — Make video and audio ties (audio follow) and audio 
adjustments

• Audio-only I/O page — Make audio only ties (audio breakaway) and audio adjustments

• Video-only I/O page — Make video only ties (video breakaway)

The DSP Configurator program always starts in the audio and video I/O page, as shown 
in figure 40 on the previous page. The audio-only I/O page looks virtually identical. The 
video-only I/O page strips out all of the audio control blocks (see Video-only I/O page and 
audio-only I/O page, on page 107).

The DSP Configurator program window consists of a number of signal processor chains, an 
AV matrix block, a mic mixer block, and several other mixer blocks.

A Line audio input signal processor chains

B Mic input signal processor chains

C AV matrix block

D Virtual returns inputs processor chains

NOTE: The virtual returns, along with the virtual sends, comprise the virtual 
bus, an internal bus for creating submixes. The virtual bus allows you to “loop” 
already-mixed audio to these processor chains for additional processing.

See figure 40 on the previous page. Virtual sends A through H run down through 
the L, M, N, and O mixer blocks and exit the DSP. A through H reenter the DSP 
as virtual returns on D.

E Expansion port input signal processing chains

F Post-matrix signal processor chain

G Switcher-to-output mixer block

H Mic-to-output mixer block

I Virtual returns-to-output mixer block

J Expansion inputs-to-output mixer block

K Output signal processor chain

L Switcher-to-virtual-send-bus mixer block

M Mic-to-virtual-send-bus mixer block

N Virtual returns-to-virtual-send-bus mixer block

O Expansion inputs-to-virtual-send-bus mixer block
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Audio signal processor chains and control blocks
Each of the six signal processing chains (A, B, D, E, F, and K) consists of one or a 
series of control blocks of two basic types that are specific to that chain: gain, trim, post-
gain, and volume control blocks (collectively known as “gain blocks” – ) and processor 
blocks ( ). For example, the audio input 1 chain consists of a gain fader, a filter block, two 
dynamic blocks, a delay block, and a trim fader. Gain controls are always present (active) in 
the signal processor chain. Processor blocks, while always shown in the program window, 
must be individually activated (“inserted”) as shown in figure 42.

Many gain blocks can be muted and process block controls can be bypassed. Mutes and 
bypasses are shown by a red indicator in the block.

Gain blocks — The parameters set by the gain blocks are always present in the signal 
chain. To access the actual fader control to view a value, make a change, or observe a 
live audio meter (Input Gain chain and Output Volume chain Gain and Trim blocks only), 
double-click the gain block icon (see figure 41). This action opens a dialog box, a new 
window that contains the fader for that control.

A dialog box opens,
which contains the

full fader control. 

Figure 41. Accessing a Typical Gain Control Dialog Box
Double-click the
processor block. 

A dialog box opens,
which contains the

processes available
in this block.

Click to select
the desired process.

The selected processor is displayed in the block.

If you want to change the variables of the 
process, double-click the block again, opening a 
separate window.

Figure 42. Selecting and Inserting a Typical Processor Block Dialog Box
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Processor blocks — Each processor block control represents a menu of one or more 
possible processes (such as filters) that can be inserted into the audio stream. For blocks 
that provide more than one processor, only one processor can be selected. Each block can 
be inserted by a double-click or right-click >Insert and selecting the desired processor 
(see figure 42, on the previous page). Once a block is inserted, the selected processor is 
displayed in the block and the block itself changes color.
 

Each processor has a set of associated parameters that define that processor (such as 
a frequency curve). Those parameters can be accessed and changed by double-clicking 
again on the now inserted process block. This action opens a customizable dialog box, a 
new window that contains parameters for the process (see figure 43).

Figure 43. Sample Processor Dialog Box

 

NOTE: Figure 43 is a sample of one type of dialog box. The contents and appearance 
of each processor are unique to that processor.

• The Set Defaults button discards all custom settings and reload the factory  
defaults.

• The Bypass button temporarily suspends the processor without removing the  
processor block.

By default, each processor block is automatically bypassed when inserted (the Bypass button 
in the processor dialog box is selected), although this can be changed for each processor 
block type (see DSP Configurator Tools menu on page 115 and the specific tabs for the 
processor types). When a processor is bypassed, a red indicator in the block turns on. 

The block can be removed from the audio stream by selecting it and depressing the 
keyboard <Delete> key or by right-clicking and selecting Delete.



 

DTP CrossPoint 84 IPCP Series Matrix Switchers • Matrix Software 86

Line audio input signal controls (A)

The program audio input signal processor chain makes adjustments to program audio 
material before it is tied to specific outputs.

Gain control block — The always-present gain control provides 
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left and right controls to adjust the audio level of each input through 
a range of -18 dB to +24 dB to set input gain levels for optimal 
signal to noise ratio.

Click and drag the desired fader (1) or click in the dB field (2) and 
type a value. The meter value displayed in green shows the signal 
level in dBFS.

3 Audio Format drop-down box — Use  
this control to select the audio format:

• Analog — Audio on the local audio input (captive screw) 
connector (see item G on page 13) is processed within the 
DSP.

• Digital — Embedded audio on the HDMI or DTP input is 
handled as follows:

• LPCM format — Audio is de-embedded and 
processed within the DSP.

• Any other format — The original digital audio is not 
de-embedded and is not routed into the DSP. No audio is available on the 
analog audio output (captive screw) connector (see item J on page 14).

• Auto — Audio is automatically selected between the digital and analog inputs, with 
the digital input having priority. When the Detected Format field (4) displays either 
None or Multi-Channel, the analog input is automatically selected.

Based on the selection made in this box, when the dialog box is closed, the Gain block 
reports Auto Gain, Dig Gain, or Ang Gain.

4 Detected Format: field — This field displays the detected digital   
audio format. The displayed format can be either:

• None — No digital signal format is detected. This may be due to a source device 
being switched off or not connected. Some digital audio players may not output a 
detectable signal (or no digital audio clock) when paused or stopped.

• Analog input audio passes through the DSP to any output when Audio Format 
(3) is set to Analog or Auto.

• Digital input audio is not passed to any output.

• 2-Ch LPCM — The detected format is uncompressed digital audio, in stereo or 
2-channel format. This does not include Dolby or DTS stereo formats, as these 
audio formats are encoded.

• LPCM input audio passes through the DSP to any output when Audio Format 
(3) is set to Digital or Auto.

• Embedded LPCM input audio passes directly to an HDMI or DTP output, 
bypassing the DSP, if the Output Signal Source control in the Volume block 
of that output is set to Original (see item 6 in Output signal processor 
chain Volume controls on page 100).

• Analog input audio is not passed to any output.
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• Multi-Channel — The detected format is any compressed or encoded digital 
audio format, such as Dolby or DTS multi-channel.

• Multi-channel input audio does not pass through the DSP regardless of 
selected Audio Format (3). Gain, mute controls, and meters are disabled and 
unavailable for operation throughout the DSP.

• Multi-channel input audio passes to an HDMI or DTP output, bypassing the 
DSP, if the Output Signal Source control in the Volume block of that output 
is set to Original (see item 6 in Output signal processor chain Volume 
controls on page 100).

• Analog input audio passes through the DSP to any output when Audio Format 
(3) is set to Analog or Auto.

See item 5 for interaction with the Audio Format drop-down box.

5 Select Control indications and radio buttons — These buttons indicate the audio, 
Digital or Analog, that is adjusted by this control block. This control reacts to the 
Audio Format (3) control as follows:

• Audio Format (3): Analog — 

• Audio Format (3): Digital — 

• Audio Format (3): Auto — The software automatically selects the radio button 
dependent on the Detected Format: field (4) display as follows:

• Detected Format (4): None or Multi-Channel — 

• Detected Format (4): LPCM — 

You can manually select a radio button only when the Audio Format drop-down box 
(3) is set to Auto. Select Digital or Analog to override the selected control.

NOTES:

• Setting the analog gain without a signal present may have a real-world 
application. For example, if you have a consumer audio component, a gain 
setting of 11.8 dB (consumer line level of -10dBV; pro line level of +4dBu; 
conversion factor from dBV to dBu = 11.8 dB) will bring its line level up to pro 
line level (or you can see the suggested setting if you insert a building block for 
a consumer audio product [see Signal Path Building Blocks on page 121]).

• Setting the digital gain without a signal present is less likely. If you know the 
general level of your source material you can attempt this but Extron does not 
recommend doing so.

6 Polarity buttons — Select to flip the polarity of the wires connected to the audio  
connectors (+/tip and -/ring) to easily correct for miswired connectors.

7 Gang button — Select to tie the left and right fader and mute controls   
together. Ganged faders move together at relative levels to the top or bottom 
of their travel. If one fader reaches the limit of its travel first, it retains that position while 
the other fader continues to travel. When the ganged faders travel in the reverse 
direction, the fader that was at its limit reverts to its position relative to the other fader.

8 Mute buttons — Select to separately mute and unmute the left and right  
audio channels. If you mute both channels, audio is completely silent on 
that input. When one or both channels are muted, one or two red indicators in the block 
turn on. The mute controls are common to both digital and analog signals.

NOTE: When the left and right channels are ganged, either Mute button mutes and 
unmutes both channels.
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Filter block — The filter processor block, when first inserted, provides  
one of four filter selections; additional filters can then be added. A filter 
attenuates (removes) or boosts a range of frequencies from an audio 
waveform, while passing other frequencies. Click the desired filter to 
select it.

NOTE: Selecting Bass & Treble Filter inserts two separate filters.

Additional filters, for a total of up to three filters, can then be added by double-clicking the 
processor block. Additionally, the frequency range of each filter can be changed in the 
dialog box, customized to the filter, that can be accessed by double-clicking the processor 
block.

To add a second or third filter to the filter block, select the desired filter in 
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the 2  and 3  drop-down boxes in the dialog box.

The following filters are available:

1 High pass filter — A high pass filter passes a band of 
frequencies extending from a specified cutoff frequency (greater 
than zero) up toward the high end of the frequency spectrum. All 
frequencies above the specified cutoff frequency are allowed to 
pass, attenuating all frequencies below. The default cutoff is 100 Hz.

2 Low pass filter — A low pass filter passes a band of frequencies extending from a 
specified cutoff frequency (less than infinite) down toward the low end of the frequency 
spectrum. All frequencies below the specified cutoff frequency are allowed to pass, 
attenuating all frequencies above. The default cutoff is 10 kHz

3 Bass and treble filters — Also known as shelving or tone filters, the separate bass 
and treble filters give the ability to cut or boost gain evenly above or below a given 
frequency, with the end-band shape giving the visual appearance of a shelf. These filters 
are typically applied to program material, and are expressed as bass and treble control. 
The default bass frequency is 100 Hz and the treble default is 8 kHz.

4 Parametric equalizer filter — A parametric equalizer is a variable equalizer that 
offers control of all parameters, including amplitude (boost or cut — the amount of gain 
(boost) or gain reduction (cut) that is applied at a given frequency), center frequency 
(frequency), and bandwidth (Q). This allows the user to control the amplitude of each 
band, shift the center frequency, and widen or narrow the affected area.

Dynamics blocks (2) — The two dynamics processor blocks, when inserted,
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each provide one of four dynamic processors. A dynamic processor alters 
the dynamic range of an audio signal, the difference between the loudest to 
the quietest portions of the signal above the noise floor of the system. 
Dynamic range can either be increased using an expander (noise gate) or reduced using a 
compressor. Click the desired dynamics processor to select it or to view a live audio  
meter as shown at right.

The parameters of each processor can be changed in the dialog box, customized to 
the processor, that can be accessed by double-clicking the processor block.

1 Automatic gain control (AGC) — AGC adjusts the gain level based upon the strength 
of the incoming signal to achieve a more consistent volume. Above a set threshold, 
weaker signals receive more gain to reach a user-defined target level; stronger signals 
receive less gain or no gain at all. 

A window range is also applied above and below the target level. When the signal 
reaches the window, gain control starts scaling in a linear fashion toward the target level 
to achieve smoother results.

The default threshold is -40 dB. The default target level is -10.0 dB. The default gain 
and window are 12.0 dB.
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2 Compressor — The compressor regulates the level of the input signal by reducing, 
or compressing, the dynamic range of the signal above a specified threshold. The 
input-level-to-output-level ratio of the signal determines the reduction in the dynamic 
range beyond the threshold setting. For example, with a ratio setting of 2:1, for every 2 
dB of input the compressor outputs 1 dB of gain.

Compression is commonly used to keep mic levels within an acceptable range for 
maximum clarity. A compressor make softer sounds louder either by reducing the 
dynamic range and then raising the output level of the compressor (referred to as 
make-up gain), or by increasing the input signal and then preventing clipping by 
reducing the louder portions of the signal. This has the effect of making louder portions 
of a signal softer. Compression also can be used, similar to a limiter, to protect a system 
or a signal chain from overload.

The default threshold is -30 dB. The ratio is 2.0:1.

3 Limiter — The limiter regulates the level of the input signal by severely restricting its 
dynamic range above a specified threshold. The limiter prevents clipping and protects 
a system against component or speaker damage. The limiter is closely related to the 
compressor but applies a much higher compression ratio, in excess of 20:1 (often 
expressed as ∞:1) and with a high threshold setting (default is -10 dB, close to clipping). 
The ratio cannot be changed.

4 Noise gate — The noise gate is an expander, expanding the dynamic range of a signal 
below a specified threshold. To simplify, it makes soft signals softer, effectively removing 
background noise while allowing a stronger signal, above the threshold, to pass. Using 
a high ratio of 20:1, the expander closes the audio path below the threshold, eliminating 
background noise, opening the path above the threshold to allow signal to pass; hence 
the term noise gate.

The default threshold is -65 dB. The ratio is 20.0:1.

Delay block — The delay processor block, when inserted, provides a means  
to delay the audio signal to sync it to video. The processor can delay the audio 
using either time or distance in feet or meters between the video display and audio 
speakers, as a determiner. The default delay, when inserted, is at 100 ms using the time 
function. The settings of the delay block can be changed in the dialog box that can be 
accessed by double-clicking the processor block. When you select either Feet or Meters, 
you can also specify a temperature, in either degrees Fahrenheit or degrees Celsius The 
processor calculates the change in speed of sound for the specified temperature.

Trim control — The always-present trim control provides separate left and 
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right input channel faders for fine adjustment with a gain range of -12 dB to 
+12 dB in 0.1 dB increments. The default setting is unity gain (0.0 dB).

Click and drag the desired fader (1) or click in the dB field (2) and type a 
value.

3 Gang button — Select to tie the left and right fader controls  
together. Ganged faders move as described for the item 7 in 
“Gain control block”, on page 87.



 

DTP CrossPoint 84 IPCP Series Matrix Switchers • Matrix Software 90

Mic/line input signal controls (B)

The mic/line input signal processor chain makes adjustments to microphone or line level 
audio material, such as a multimedia presentation, before it is mixed with program audio.

Gain control — The always-present gain control provides a single 
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long-throw fader with a gain range of 0 dB to +80 dB, adjustable in 1 dB 
increments, with a level setting readout below the fader.

A gain range from 0 to +10 dB accommodates a line level signal, typically 
from a wireless microphone receiver with a line level output.

Above +10 dB, the input switches to a mic level input.

Click and drag the fader (1) or click in the dB field (2) and type a value. The 
meter value displayed in green shows the signal level in dBFS.

3 Polarity buttons —Select to flip the polarity of the wires  
connected to the audio connectors (+/tip and -/ring) to easily 
correct for miswired connectors.

4 Phantom Power check box — Click to toggle +48 VDC phantom power  
on and off, typically to power a condenser mic.

5 Mute button — Select to silence and unmute the mic audio.  
If you mute the audio, it is completely silent on that input. When the 
audio is muted, a red indicator in the block turns on.

Filter block — The filter processor block, when first inserted, provides  
one of four filter selections; additional filters can be then be added. The 
available filters and adding additional filters are identical to as described 
for the Line audio Filter block, on page 88 (except that up to five filters 
total can be selected for this block).

NOTE: Selecting Bass & Treble Filter inserts two separate filters.

Feedback suppressor block — The feedback suppressor processor  
block, when inserted, detects feedback on a live microphone channel, 
and uses a set of fixed and dynamic filters to counteract the frequency peaks at the 
detected feedback frequencies. You may possibly achieve an additional 3 dB to 9 dB of mic 
gain where feedback would have otherwise prevented these levels.

Dynamics blocks (2) — The two dynamics processor blocks, when inserted,  
each provide one of four dynamic processors. The available processors are 
identical to as described for the Line audio Dynamics block, on page 88.

Delay block — The delay processor block, when inserted, provides a means  
to delay the audio signal to sync it to video. The delay processor block is 
identical to as described for the Line audio Delay block, on page 89.
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Ducking block — The ducking processor block, when 
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inserted, provides a means to duck, or lower the level of 
one or more input signals (ducking targets, such as 
microphones, the program material, or audio input on the 
virtual bus) when a specified source must take 
precedence. The inserted ducking processor block 
ducks the targets when the processor detects a signal 
from the ducking source. Ducking lasts for the duration 
of the interrupting signal (plus hold and release time) and 
restores the original level of the ducked mic once the 
other signal has ceased. Ducking is useful when:

• Program material needs to be attenuated in order to 
more clearly hear the voice of the narrator.

• One microphone, such as one used by a master of 
ceremonies, needs to have priority over other mics, 
program material, or both.

• A paging mic needs to attenuate all other signals.

All four ducking processor blocks are controlled via 
a common dialog box that opens when you select to 
configure any of the ducking blocks. All empty ducking processor blocks have no ducking 
source or target settings by default.

In some cases, multiple levels of ducking may be required, enabling an input source to take 
precedence over all but one other input. 

In the priority tree on the right side of the figure above, post-matrix 1, mic inputs 2 and 3, 
and virtual return A are set to duck when mic 1 has a signal above the ducking threshold. 
Mic 2 is set to duck post matrix 3 and 4. Since mic 1 has previously been set to duck mic 2, 
mic 1 is disabled to prevent contradictory priorities.

The inputs are arranged by their priority status. Mic 1 has all other ducked inputs under 
it; therefore, if a signal is detected, it triggers mics 2 through 4 to duck. If mic 2 detects a 
signal and there is no signal on mic 1, mic 2 triggers mics 3 and 4 to duck. However, if the 
mic 1 signal exceeds the threshold, it then ducks all inputs including mic 2.

NOTE: Ducking attenuation is not additive. When an input target is ducked, 
regardless of how far down the priority line it is, the maximum attenuation is that set 
for the individual input and virtual send in the “by (dB):” column near the center of 
the dialog box.

See Ducker Priority Tutorial on page 127 for a more detailed examination of priority.

1 Current source indicator — Shows the input selected as the ducking source.  
 Ducker settings affect the input channel shown here. When a ducker dialog is 
opened for a channel, the current source defaults to that channel. The current source 
can also be selected via the priority tree (see 5, on the next page).

2 Enable Source Mic/Line check box — When checked, ducking is  
enabled for the current source and the ducker processor block is lit. 
When cleared, ducking is disabled for the current source and the ducker processor 
block is unlit.

3 Duck: (targets) — Shows all potential input targets. Only checked inputs  
are ducked. The current source is not available as a target (a source cannot 
duck itself). If the current source has been designated as a target of another 
input channel, that input channel is not available (a target cannot be the 
source).
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4 by (dB): — Individual attenuation settings for each duck target in dB.  
The default is 20.0 dB. If additional attenuation of a target is required, increase 
this value. The current source setting is not available.

The attenuation range is 80.0 to 0.0 dB in 0.1 dB increments. 

5 Priority — Displays the hierarchy of ducking source to duck  
targets. Priority levels are displayed in tree fashion. Input channels 
that are targets being ducked by a source are shown as indented 
below the source. Any input channel displayed in the tree is an 
active link. Click an input channel to select that channel as the 
current source. The current source indicator (see 1, on the previous 
page) reflects the selected input channel.

6 Settings: — Used to configure the parameter settings for the  
ducker source. When a ducker block is copied, these settings 
are transferred.

Threshold — Sets the input signal level, in dB, the ducking 
source must exceed before ducking begins. If ducking does 
not occur quickly enough to avoid loss of speech or program 
material from the ducking source, decrease this setting. If ducking occurs too soon, 
allowing background noise to trigger ducking, increase the setting.

The range is -60 to 0 dB in 1 dB increments. The default is -30 dB.

Attack Time — Adjusts the time to duck the targets once the threshold is exceeded.

The range is 0 to 3000 milliseconds in 1 millisecond increments. The default is 
1 millisecond.

Hold Time — Determines the time, in milliseconds, after a ducking source signal drops 
below the threshold before ducking ceases. 

The range is 0 to 10000 milliseconds in 1 millisecond increments. The default is 
1000 milliseconds (1 second).

Release — Determines how long, in milliseconds, after the ducking source level is 
below the threshold and the hold time is met, the ducking targets take to restore signal 
levels.

The range is 10 to 10000 milliseconds in 1 millisecond increments. The default is 
1000 milliseconds (1 second).
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Gain control — The always-present gain control provides a single 
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long-throw fader with a gain range of 12 dB to -100 dB, adjustable in 0.1 dB 
increments, with a level setting readout below the fader.

Click and drag the fader (1) or click in the dB field (2) and type a value. The 
meter value displayed in green shows the signal level in dBFS.

3 Mute button — Select to mute and unmute the mic  
audio. If you mute the audio, it is completely silent on 
that input. When the audio is muted, a red indicator in 
the block turns on.

NOTES:

• The  indicator (4) means that this fader is part of a group master (group 2 in this 
example) (see Group masters, on page 103 to create group masters).

• Multiple masters can be created for a fader, in which case the 4 indicator is .

• By default, the front panel Mic Volume knob controls this fader.

AV matrix block (C)

The AV matrix block (figure 44) displays the current tie 

Figure 44. AV Matrix Block

 
configuration of either the program own emulation 
(Emulate mode) or the connected matrix switcher (Live 
mode) and provides a way to make or break ties.

• To create a tie, drag a line from an input node ( ) to 
one or more output nodes.

• To tie an input to all outputs, right-click an input node 
and select Connect To All Outputs.

• The Legend panel identifies the type of tie: Video 
I/O (video breakaway), Video and Audio I/O (audio 
follow), or Audio Only (audio breakaway). Click the 
legend link to select the type of tie.

• To remove a tie, click an input or output node and 
press the keyboard Delete key or right-click an input 
or output node and select Delete All Connections 
(for an input node) or Delete Connection (for an 
output node).
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Virtual returns inputs controls (D)

The virtual returns input processor chain makes adjustments to inputs on the virtual bus 
from within the DTP CrossPoint switcher.

Filter block — The filter processor block, when first inserted, provides  
one of four filter selections; additional filters can be then be added. The 
available filters and adding additional filters are identical to as described 
for the Line audio Filter block, on page 88.

NOTE: Selecting Bass & Treble Filter inserts two separate filters.

Dynamics block — The dynamics processor block, when inserted, each  
provide one of four dynamic processors. The available processors are 
identical to as described for the Line audio Dynamics block, on page 88.

Delay block — The delay processor block, when inserted, provides a means  
to delay the audio signal to sync it to video. The delay processor block is 
identical to as described for the Line audio Delay block, on page 89.

Gain control (pre-mixer) — The always-present gain control provides a fader with a  
gain range of 12 dB to -100 dB, adjustable in 0.1 dB increments. The Gain block is 
identical to as described for the Mic/line inputs signals Gain block, on page 86.

Expansion port input signal gain control (E)

The always-present expansion port input pre-mixer gain control provides a fader with  
a gain range of 12 dB to -100 dB, adjustable in 0.1 dB increments. The Gain block is 
identical to as described for the Mic/line inputs signals Gain block, on page 86.

Post-matrix signal processor chain (F)

The post-matrix signal processor chain makes adjustments to program audio material, after 
it is tied to a specific output but before it is mixed with microphone or other audio material.

Loudness block — The loudness processor block, when inserted, applies  
a filter compensation curve to the signal in an inverse relationship to the 
post-gain control setting and output volume control setting; the higher the 
post-gain or output volume setting, the less compensation is applied. For the relationship to 
the post-gain control, the left and right trims are represented by separate curves in the 
Loudness dialog. You can fine-tune the loudness compensation (see Optimizing the 
Audio, on page 131).
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Gain (pre-mixer) control block — The always-present gain control 
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provides left and right controls to adjust the audio level of each audio output 
from the AV switcher block through a range of -100 dB to +12 dB to ensure 
that there is no noticeable volume difference among sources.

Click and drag the desired fader (1) or click in the dB field (2) and type a 
value.

3 Mute buttons — Select to separately silence and unmute the  
left and right audio channels. If you mute both channels, audio 
is completely silent on that output. When one or both channels 
are muted, one or two red indicators in the block turn on.

NOTE: When the left and right channels are ganged, either Mute 
button mutes and unmutes both channels.

4 Gang button — Select to tie the left and right fader controls together.   
Ganged faders move together at relative levels to the top or bottom of their 
travel. If one fader reaches the limit of its travel first, it retains that position 
while the other fader continues to travel. When the ganged faders travel in the reverse 
direction, the fader that was at its limit reverts to its position relative to the other fader.

NOTES:

• The  indicator (5) means that this fader is part of a group master (group 1 in 
this example) (see Group masters, on page 103 to create group masters).

• Multiple masters can be created for a fader, in which case the 5 indicator is .

• By default, the front panel Volume knob controls this fader.
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Switcher-to-output mixer block (G)

The switcher-to-output mixer block (see figure 45) sends audio from the AV matrix block to 
the output. It is an array of points where the output of the AV matrix can be mixed into the 
output of the DSP. The block provides a way to mute and unmute the output of the AV block 
onto the path to the physical audio connectors. The mix-points are unmuted by default. 
Unmuting effectively mixes the inputs into the audio outputs at the level set in the left and 
right mix controls.

Switcher-to-output
Mixer

}
}

Mic Inputs
Virtual Returns
Expansion Inputs

}
Audio Outputs
1 through 4

Virtual
Send Bus
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Figure 45. Switcher-to-output Mixer Block and Mix-point Dialog Box

To mute or unmute an input, double-click one of the mix-points (1) to open a mix-point 
dialog box. Click the Mute button (2) in the dialog box to unmute or mute the applicable 
input. The appearance of the mix-point indicates the input connection status as follows:

 Unmuted

 Muted

The mix-point dialog box features a fader control that provides a mix (level) adjustment with 
a gain range of -35 dB to +25 dB in 0.1 dB increments. Click and drag the fader (3) or click 
in the dB field (4) and type a value. The default setting is unity gain (0 dB).

TIP: If you have an audio signal is output on the virtual bus and looped around back to 
the virtual input, mute the audio output by the AV block in these mix-points to prevent 
the unprocessed signal from being output along with the processed audio.
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Figure 46. Simplified Mixer Signal Flow

• Mix-point mutes (indicated by  in figure 46, a graphic representation of the mixer) do 
not block the horizontal signal flow. Unless muted before the mixer, audio always flows 
from left to right through the mixer.

• Mix-point unmutes ( ) redirect the audio vertically without disrupting the horizontal 
signal flow. In the first column of mix-points, audio is redirected up. In the second 
column, audio is redirected down.

• The virtual send bus does not exit the DSP, but is looped around for potential additional 
processing.

• In support of future DMP 128 applications, the Expansion bus outputs are not 
numbered intuitively in the signal flow diagram. Outputs 1 through 8 are below outputs 9 
through 16.
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Mic-to-output mixer block (H)
Virtual returns-to-output mixer block (I)
Expansion inputs-to-output mixer block (J)

These three mixer blocks (see figure 47) are an array of points where mic, virtual bus, and 
expansion bus audio can be further mixed into the left and right channels of audio outputs 
1 through 4. The block provides a way to unmute and mute the inputs from the mic/line 
input, virtual bus, or expansion bus signal processor chains. The mix-points are muted by 
default. Unmuting effectively mixes the inputs into the audio outputs at the level set in the 
mix controls.

Mic-to-output
Mixer

}
Virtual returns-to-output
Mixer

Expansion inputs-to-output
Mixer

Switcher-to-output
Mixer
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Figure 47. Output Mixer Blocks and Mix-point Dialog Boxes

To mute or unmute an input, double-click one of the mix-points (1) to open a mixing dialog 
box. Click the Mute button (2) in the dialog box to unmute or mute the applicable input.

The dialog boxes feature a fader control that provides a mix (level) adjustment with a gain 
range of -35 dB to +25 dB in 0.1 dB increments. Click and drag the fader (3) or click in the 
dB field (4) and type a value. The default setting is unity gain (0 dB).
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NOTES:

• Unlike from line inputs 1 through 4 (typically program audio), more than one mic, 
virtual return, or expansion port audio input can be mixed into a single audio output.

• The message Input is muted! in figure 47 (5) indicates that Mute is selected 
in the mic/line input gain control block. This message can appear ONLY for mix-
points in the mic-to-output mixer block.

Output signal processor chain (K)

The output signal processor chain makes adjustments to mixed program and microphone 
audio, before it is output to the selected speakers or other audio devices.

Trim control block — The always-present trim control provides 
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left and right controls to adjust the audio level of each output through 
a range of -12 dB to +12 dB to ensure that there is no noticeable 
volume difference among sources.

Click and drag the desired fader (1) or click in the dB field (2) and 
type a value. The meter value displayed in green shows the signal level 
in dBFS.

3 Gang button — Select to tie the left and right fader   
controls together. Ganged faders move together at 
relative levels to the top or bottom of their travel. If one fader 
reaches the limit of its travel first, it retains that position while the 
other fader continues to travel. When the ganged faders travel in 
the reverse direction, the fader that was at its limit reverts to its 
position relative to the other fader.

Delay block — The delay processor block, when inserted, provides a means  
to delay the audio signal to sync it to video. The delay processor block is 
identical to as described for the Line audio Delay block, on page 89.

Filter block — The filter processor block, when first inserted, provides  
one of four filter selections; additional filters can be then be added. The 
available filters and adding additional filters are identical to as described 
for the Line audio Filter block, on page 88.

NOTE: Selecting Bass & Treble Filter inserts two separate filters.

Dynamics block — The dynamics processor block, when inserted, each  
provide one of four dynamic processors. The available processors are 
identical to as described for the Line audio Dynamics block, on page 88.
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Volume controls — The always-present volume controls provide left and right controls to 
adjust the audio level of each output through a range of 0 dB (effectively muted) to +100 dB 
(full volume). There are three analog and two digital volume controls. They are similar, but for 
the Output Signal Source control. The analog and digital types apply to the outputs as 
shown below:

• Analog volume controls — All carry the same audio, assuming the same tied input, the 
same output source setting, and the same mix:

• Amplifier (AMP) — Output 1 only

• Analog volume (ANA VOL) — Output 1 through 4

• Analog DTP (ANA DTP) — Output 3 and 4 only

• Digital volume controls — Both carry the same audio, assuming the same tied input, the 
same output source setting, and the same mix:

• HDMI volume (HDMI) — Output 1 and 2

• DTP (DTP) — Output 3 and 4 only.

Analog Volume Control Digital Volume Control
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Figure 48. Analog and Digital Volume Controls

NOTE: For digital volume controls only, the Output Signal Source selection (6 on 
the next page) affects the remaining controls in the block. If Original or No Audio is 
selected, all other controls in the block become unavailable for selection.

Click and drag the desired fader (1) or click in the dB field (2) and type a value. The meter 
value displayed in green shows the signal level in dBFS.

3  Polarity buttons —Select to flip the polarity of the wires connected to the audio  
connectors (+/tip and -/ring) to easily correct for miswired connectors.

4 Gang button — Select to tie the left and right fader controls together.   
Ganged faders move together at relative levels to the top or bottom of their 
travel. If one fader reaches the limit of its travel first, it retains that position 
while the other fader continues to travel. When the ganged faders travel in the reverse 
direction, the fader that was at its limit reverts to its position relative to the other fader.
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5 Mute buttons — Select to separately silence and unmute the left and  
right audio channels. If you mute both channels, audio is completely silent 
on that input. When one or both channels are muted, one or two red indicators in the 
block turn on.

6 Output Signal Source drop-down box — Use this control to select  
the audio source:

• Original — Audio embedded in the original digital (HDMI or 
DTP) input passes through the matrix switcher without being 
de-embedded and processed within the DSP. All other controls in the digital volume 
control become unavailable for selection, because audio is not processed within 
this block.

• From DSP — Audio is de-embedded and processed within the DSP.

• No Audio — Audio is muted (but no indication of the muting is shown other than 
the selection in this box). All other controls in the digital volume control become 
unavailable for selection, because audio is not processed within this block.

TIP: If the Output Signal Source is set to Original, the digital audio 
embedded in the digital (HDMI or DTP) signal continues to be routed as part of 
the digital signal and is output with the video, even for audio breakaway ties.

For video-only ties, select No Audio to prevent embedded audio from being 
routed with the video signal.
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Switcher-to-virtual-send-bus mixer block (L)
Mic-to-virtual-send-bus mixer block (M)
Virtual returns-to-virtual-send-bus mixer block (N)
Expansion inputs-to-virtual-send-bus mixer block (O)

These four mixer blocks (see figure 49) are an array of points where the switcher output, 
the mic, the virtual bus, and the expansion bus audio can be further mixed and routed 
for additional processing. The block provides a way to unmute and mute the inputs. The 
mix-points are muted by default. Unmuting effectively mixes the inputs into the audio 
outputs at the level set in the mix controls.

The operation and indication of the mix-points and the dialog boxes are identical to as 
described for the Mic-to-output mixer block, on page 98.
 

Mic-to-virtual-send-bus
Mixer

Virtual returns-to-virtual-send-bus
Mixer

Expansion inputs-to-virtual-send-bus
Mixer

Switcher-to-virtual-send-bus
Mixer
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Figure 49. Virtual Send Bus and Expansion Bus Mixer Blocks and Mix-point 
Dialog Boxes
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Group masters
Any of the gain, volume, trim, bass, and treble fader controls for one or more gain blocks 
can be grouped with other gain blocks of the same type (in the same location in the audio 
signal path but for different inputs or outputs) for single-fader control of the entire group 
(see figure 50) Mute controls within the blocks can also be grouped (see figure 51). Up to 32 
groups can be created, each can include up to 16 group members.

NOTE: Stereo gain blocks have two, left and right, signal paths. Each path counts as a 
group member, limiting you to up to eight gain blocks total for a control group of stereo 
gain controls. In figure 50, the group 3 master consists of six members.
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Figure 50. Sample Fader Group Master and Associated Gain Controls

Figure 51. Sample Mute Group Master and Muted Inputs

As an example. assume that your system has several audio outputs dedicated to a single 
room. You want all outputs to receive the same audio input, but there are different audio 
dynamics in different parts of the room. Front row audience members need less mic audio 
mixed in, and you want to insert varying degrees of delay for different audience rows. 
The output 1 through output 3 analog volume controls can be grouped into a master that 
controls the volume throughout the room (see figure 50).
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Each individual volume control in the group can be set for that output, but when you move the 
group fader, the faders for all three outputs move in tandem, retaining their relative levels.

NOTE: By default, group 1 (A, in figure 50) is configured as the Program Volume. 
Group 1 masters the Pre-mixer Gain control block (see page 95), and parallels the 
front panel Volume control. Group 2 (B) is configured as the Mic Volume. It masters 
the Mic/line Input Gain control block (see page 93), and parallels the front panel 
Mic volume control. These default groups can be overwritten if desired, but not deleted 
(see the System reset SIS command on page 64).

If you overwrite groups 1 and 2, the front panel controls adjust the group masters that 
you create in place of them.

An icon in the gain control indicates that that gain control is assigned to a group. In 
figure 50, on the previouse page, the  icon (C) indicates group 3. The  icon (D) in the 
output 3 control indicates that that gain control is assigned to more than one group.

Grouped faders move together at relative levels to the top or bottom of their travel. If one 
fader reaches the limit of its travel first, it retains that position while the other faders continue 
to travel. When the grouped faders travel in the reverse direction, the fader that was at its 
limit reverts to its position relative to the other faders. No gain block level fader can be set 
beyond the upper or lower limits for that group fader, either the hard limits or the soft limits. 
Any gain fader in the group can be set to a level below the group fader.

Soft limits ( , E) are adjustable, letting you set the ceiling and floor for the group.

NOTE: If a block is muted, that block remains muted when the group mute is released.
TIP: Extron recommends that if you include a control in multiple groups, that you do so 

with care; overlapping group membership can quickly become unmanageable.

Configuring a group master

Configure a group as follows:

1. Click Tools > Configure Groups to open the Configure Groups dialog box.

NOTE: Or, click View > Group Controls and then click Add a Group.

2. In the Select Group drop-down box, click a group to select it (see figure 52).
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Figure 52. Configure Groups Dialog Box

NOTE: <empty> groups have no group members assigned. Numbered groups 
(such as Group #) or otherwise named groups have controls assigned that may be 
overwritten if you select them and continue.
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3. In the Select Control Type field, click the + to expand the Gain or Mute tree and then 
select a control to assign it to the group.

4. In the Available Group Members field, click the desired check boxes to select or 
deselect those blocks as members of the group.

Block trees with multiple potential group members automatically expand.

Potential group members that are already assigned to a different group are displayed in 
blue.

5. Click the Apply button to create or configure the group.

6. If desired, repeat steps 2 through 5 to create or configure other groups.

7. Click the Close button to exit the Configure Groups dialog box.

Deleting a group master

Delete a group as follows:

1. Click Tools > Configure Groups to open the Configure Groups dialog box.

NOTE: Or, click View > Group Controls and then click Add a Group.

2. In the Select Group drop-down box, click a numbered group (such as Group #3) to 
select it (see figure 52, on the previous page).

3. Click Delete Current Group.

4. Click Yes in the Confirm Deletion dialog box.

Setting soft limits

Each gain type control provides upper and lower soft limits used to limit the  
range of the group master control. Soft limits ( ) prevent group controls from 
exceeding an upper limit or going below a lower limit. They are easily adjustable 
and provide the ability to set a ceiling and floor for the group. When a group 
master is created, the soft limits default to the hard limits (maximum and 
minimum) of that group of controls. 

Soft limits can be defined using the mouse by clicking and dragging the 
Soft Limit icon. The resolution is 0.1 dB. For more precise setting, using the 
keyboard, see Setting group master soft limits on page 120.
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Viewing and using a group master

Click View > Group Controls to open the Group Controls dialog box (see figure 53).

Figure 53. Group Controls Dialog Box

• Slide a group fader up and down to adjust all gain controls in the group.

• Click and drag a soft limit ( ) to set the ceiling or floor for the group.

NOTES:

• The soft limits cannot be dragged beyond the current setting of the group fader; 
the ceiling cannot be set below the fader and the floor cannot be set above the 
fader.

• None of the individual gain faders can be dragged below the floor or above the 
ceiling of the soft limits of the group.

• Click the Mute button in a mute group to mute or unmute all blocks in the group.

NOTE: If a block is muted, that block remains muted when the group mute is 
released.

• Click Add a Group to open the Configure Groups dialog box (see Configuring a group 
master on page 104 and figure 52).

• Click Tools > Clear All Groups in the Group Controls dialog box to delete all groups.

• Click Tools > Increment/Decrement Simulator in the Group Controls dialog box to 
open a dialog box (see figure 54) that lets you easily experiment with fine adjustments.

Figure 54. Increment/Decrement Simulator Dialog Box

NOTES:

• You must select a group before the other controls in the dialog box are active.

• The size of the increment can be changed from its default value of 1 dB by typing 
a value in the Increment Value or Decrement Value field, to as fine as 0.1 dB.
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• Click Tools > Group Details Report in the Group Controls dialog box to create a text 
file that details all created groups (see figure 55).

GROUP DETAILS REPORT

Group #1 (Program Volume)
   Processor Type: Pre-mixer Gain
   Current Gain value: 0 dB
   Current Group Members:
      Output #1 (Output#1) Left Channel
      Output #1 (Output#1) Right Channel
Group #2 (Mic Volume)
   Processor Type: Pre-mixer Gain
   Current Gain value: 0 dB
   Current Group Members:
      Mic #1 (Input#9)
      Mic #2 (Input#10)
      Mic #3 (Input#11)
      Mic #4 (Input#12)

Figure 55. Sample Group Details Report

Video-only I/O page and audio-only I/O page
The video-only I/O page (see figure 56), selected by clicking Video Only in the legend field, 
clicking View > Video I/O, or pressing the keyboard <F4> key. Switching operations using 
the AV matrix block (see AV matrix block (C) on page 93) tie only video (video breakaway).

Figure 56. DSP Configurator Program Window, Video-only I/O Page

The audio-only I/O page, selected by clicking Audio Only in the legend field, clicking 
View > Audio I/O, or pressing the keyboard <F3> key. The appearance is identical to 
the video & audio I/O page (see figure 40 on page 82), and the same audio control are 
available. Switching operations using the the AV matrix block (see AV matrix block (C) on 
page 93) tie only audio.
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Presets
The DTP CrossPoint 84 can store up to 32 presets and can include both selected ties and 
selected audio signal processing settings made in the program. Presets, when recalled, 
overwrite only a portion of the current configuration, leaving other ties and settings 
unchanged, and are useful when only selected ties and/or settings, such as for a particular 
room, need to be changed.

Save a preset
Before you save a preset using the DSP Configurator program, you must select (mark) the 
desired ties and signal processor blocks. Save a preset as follows:

1. Mark the desired video and audio ties as desired:

a. Click an output node ( ). The node is marked by a green outline ( ).

The output and the tied input are selected to be saved as a preset.

b. Ctrl-click additional outputs as desired.

TIPS:

• If an input is tied to multiple outputs, and you want the entire set of ties saved 
as a preset, mark each output to save that tie.

• To mark multiple successive outputs (marking all outputs selects all ties),  
mark the uppermost output node as described in step 1a. Then, 
Shift-click an output node under it to mark all of the outputs between the 
two nodes.

2. Mark the desired mic mix-points:

a. Click a mix-point ( ). The point is marked by a green outline ( ).

The mic/line input, the mixed output, and all mix settings are selected to be saved 
as a preset.

b. Ctrl-click additional mix-points as desired.

TIPS:

• To mark the same mic/line input mix-point for a successive series of  
outputs, mark the leftmost or rightmost mix-point as described in 
step 2a. Then, Shift-click a mix-point to the left or right of it to mark each 
mix-point in the row (mix the mic/line input to each output).

• To mark the same output mix-point for a successive series of mic/line  
inputs, mark the uppermost mix-point as described in step 2a. Then, 
Shift-click a mix-point under it to mark each mix-point in the column (mix 
the output to each mic/line input).

3. Mark the desired gain and/or processor blocks:

a. Click a processor block. The block is marked by a green outline ( ).

The processor block and all of its settings is selected to be saved as a preset.

b. Ctrl-click additional processor blocks as desired.

TIP: To mark multiple successive processor blocks in a  
chain, use right-click > Mark Row.
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4. Save the preset:

a. Click Tools > Presets > Save Presets.

The Save a Preset dialog box appears.

b. As desired, enter a specific preset number

c. As desired, enter a preset name.

NOTE: Unless you enter a specific number, name, or both, the DSP Configurator 
enters the next unused preset number and the name “Preset {number}.

d. Click OK.

Recall a Preset
Recall a preset as follows:

1. Select the desired preset in the Presets drop-down box (see figure 57).

The selected preset appears in the Presets drop-down box, marked processors appear 
indicated by green boxes, ties that will be loaded as part of the preset are shown by 
dashed lines, and ties that will be eliminated by the preset are indicated by the output 
node highlighted in green.

2222222222

1111111111

Figure 57. Recalling a Preset

NOTES:

• The Recall, Cancel, and Delete buttons appear when a preset is selected.

• An asterisk (*) in the drop-down box indicates that a preset that only exists 
in the switcher has not been saved to the configuration file of the DSP 
Configurator. The ties and settings of the preset are not in sync between the 
DSP Configurator program and the switcher.

• Presets marked with an asterisk should be recalled and then the current DSP 
Configurator settings saved. Click File > Save or File > Save As.

• It may take up to two seconds for the preset data to read-in in Live mode.

2. Click Recall to load and make active the selected preset.

TIPS:

• Click Cancel to abandon the preset recall (but not deleting the preset) and 
return to the current configuration.

• Click Delete to permanently erase the preset..

Emulate mode vs. Live mode
The DSP Configurator program always starts in Emulate mode. In Emulate mode, you can 
perform all of the functions available in the DSP Configurator program, without connecting 
a switcher to the computer, and save all of the ties and settings to a configuration file on 
your PC. When you open the file via the DSP Configurator program, the program restores 
all ties and settings as the current configuration (emulated if in Emulate mode or live, in the 
switcher, if in Live mode) and makes presets saved in the file available for recall.
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Synchronizing: pull vs. push
When you switch to Live mode, after making ties or setting processors in Emulate mode, 
you need to synchronize the switcher and the DSP Configurator program. You are given the 
opportunity to either:

• Pull data from the switcher and update the configuration of the DSP Configurator 
program.

• Push data from the DSP Configurator program to the switcher, overwriting ties, settings, 
and presets in the switcher.

You can also switch to Live mode and then tailor the audio settings in real time, while 
listening to the audio output with a critical ear.

Selecting Live mode and pulling data
Switch from Emulate mode to Live mode as follows:

NOTE: Extron recommends connection via an Ethernet LAN port for DSP Configurator.

1. Click the Mode Live button (see figure 58). The Connect to device window appears, 
with either the TCP/IP tab, the USB tab, or RS-232 tab active.

or or
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Figure 58. Selecting Live Mode

2. If necessary and as desired, click either the:

• RS-232 tab (for connection via the rear panel Remote port — Proceed to step 5).

• TCP/IP tab (for connection via the LAN port (preferred) — Proceed to step 3).

• USB tab (for connection via the front panel Configuration port — Proceed to step 4).
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3. If you selected TCP/IP in step 2:

a. Observe the IP Address field in the IP Connection window. The field displays the 
last IP address entered.

If the IP Address field is correct, proceed to step 3b.

If the address is not correct, either click in the IP Address field and enter the IP 
address or click on the scroll down button ( ) to open a drop-down box and select 
from among the recently used addresses. Proceed to step 3b.

NOTE: If the local system administrators have not changed the value, the 
factory-specified default, 192.168.254.254, is the correct value for this field.

b. If the switcher is password protected, click in the Password field and enter the 
appropriate administrator password.

c. Click OK.

The Synchronize with Device dialog box (see figure 59, on the next page) appears. 
Proceed to step 6.

4. If you selected USB in step 2:

a. Click the USB Devices drop-down box and select the switcher.

b. Click OK.

The Synchronize with Device dialog box (see figure 59) appears. Proceed to 
step 6.

5. If you selected RS-232 in step 2:

a. Click the Com Port drop-down box and select the PC comm port that is 
connected to the rear panel RS-232 port of the switcher.

b. Check the baud rate displayed in the comm port selection window.  
If you need to change the baud rate to match the rate of the 
switcher, click the Baud Rate drop-down box and select the 
desired baud rate. The default is 9600.

c. Click OK.

The Synchronize with Device dialog box (see figure 59) appears. Proceed to 
step 6.

6. If necessary and as desired, click (see figure 59) either the:

• Pull radio button (to configure the DSP Configurator program to match the 
switcher — proceed to step 8)

• Push radio button (to configure the switcher to match the DSP Configurator 
program — proceed to step 7)
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Figure 59. Selecting Live Mode, Continued
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7. If you want to tailor the push to the switcher (push just the configuration, just the 
presets, or the configuration and selected presets), click the Advanced button (see 
figure 59, on the previous page) and proceed to step 7a.

To push all of the DSP Configurator ties, gain and processor blocks, and presets to the 
switcher, proceed to step 8.

a. Select the Custom radio button.

b. Select one or both check boxes as desired; Push Configuration and Push 
Presets.

NOTE: Configuration includes all ties, mic mixes, and gain and processor 
blocks. This selection does not include presets.

c. If you selected Push Presets in step 7b, select either:

Selected — Proceed to step 7e.

All (equivalent to a standard push) — Proceed to step 8.

d. If you selected Selected in step 7c, the Synchronize with Device dialog box 
reappears. Click OK.

e. Select the desired presets to push by clicking the appropriate check boxes.

f. Click OK. Proceed to step 9.

8. Click OK. The DSP Configurator program is connected live to the switcher, completing 
the mode selection. Ties, processors, and presets are pushed or pulled as selected.

9. If you have created ties or made any changes to the DSP parameters (including gain 
and processor blocks) since the last time you saved to a file, the DSP Configurator 
prompts you to save the file. Click Yes or No, as desired,

If a password was required and not entered or if an incorrect password was entered, 
the program prompts for the password.

DSP Configurator Windows Menus

DSP Configurator File menu 

NOTE: New, Open, and Recent Files are unavailable in Live 
mode.

New — Discards the current DSP configuration (after prompting 
to save any changes) and opens a blank configuration file with no 
inserted processors, saved presets, created ties, or mic mixes.

Open — Loads and activates a previously saved DSP configuration 
file.

Save — Saves all changes to the current DSP configuration file 
under the current file name. If the file has not previously been saved 
the program prompts for a file name.

Save As — Saves all changes to the current DSP configuration file under a new file name.

Backup — Transfers all presets plus the current configuration to a DSP configuration file 
within the DSP Configurator program.

Recent Files — Opens a list of recently opened or saved DSP configuration files, making it 
easy to select one to open.

Exit — Closes the DSP Configurator Program.
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DSP Configurator Edit menu 
Cut — Copies all of the parameters of a selected processor block or 
set of selected blocks to the clipboard and removes the blocks from the 
processor stream.

NOTES:

• Gain blocks are always present and cannot be Cut.

• Processor blocks are removed from the processor stream after a Cut and a 
subsequent Paste operation.

• Processor blocks and their parameters can be pasted only into another block of 
the same type. For example, the input 1 filter block and all of its parameters can be 
copied to the input 2 filter block but not to the input 1 delay block.

Copy — Copies all of the parameters of a selected processor block, gain block, or set of 
selected blocks to the clipboard.

Paste — Inserts processor blocks and their parameters from the clipboard into the DSP 
Configurator program at the location selected.

DSP Configurator View menu 
Audio & Video I/O — Selects the audio and video I/O page for the 
DSP Configurator program (the default view).

Audio I/O — Selects the audio-only I/O page for the DSP 
Configurator program.

Video I/O — Selects the video-only I/O page for the DSP 
Configurator program.

Meter Bridge — Opens a Meters dialog box (see figure 60) with real-time meters that 
monitor the audio levels at each input and output.

NOTE: Meter Bridge is available in Live mode only and only while connected via the 
LAN port of the switcher.

Figure 60. Meter Dialog Box

Re-enable all dialogs — Re-enables all dialog boxes, the pop-up windows that allow 
you to make changes to the parameters of a block.

Group Controls — Opens the the Group Controls dialog box (see Viewing and using a 
group master on page 106).
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DSP Configurator Tools menu 
Presets — Allows you to mark all items, save a preset, and clear 
marked items:

• Mark All Ties — Mark (select) all created ties to save as a 
preset.

• Mark All Items — Mark (select) all parts of the current 
configuration (excluding presets), including processors, 
created ties, and mic mixes to save as a preset.

• Save Preset — Save the currently marked processors, ties, 
and mic mixes as a preset.

• Clear Marked Items — Unmark (deselect) all parts of the current configuration 
(excluding presets), including processors, created ties, and mic mixes.

Connect to Device or Disconnect from Device (depending on Emulate or Live mode) — 
Performs the same functions as the Mode Emulate and Mode Live buttons.

Device Manager — Opens the Device Manager dialog box, in which you can switch 
between devices that use the DSP Configurator and also add, clone (duplicate), or delete 
devices that use the DSP Configurator.

Issue RESET Command — Initializes and clears any or all of the following: ties, mic mixes, 
presets, audio configuration, processor blocks, and gain blocks. This reset is identical to the 
EZXXX} SIS command (see page 64).

Firmware Loader — Calls the Firmware Loader program, which allows you to replace the 
switcher firmware without taking the switcher out of service. This is similar to the Product 
Configuration Software Update Firmware selection (see Updating the Firmware, on 
page 78).

Organize Building Blocks — Opens the Organize Building Blocks dialog box, in which 
you can save building blocks, move them within folders, or delete them (see Organizing 
building blocks, on page 125).

Configure Groups — Opens the Configure Groups dialog box (see Configuring a group 
master on page 104).

Device Setting — Opens a dialog box that provides a means to set the IP address and 
passwords of the unit and to set the baud rate for the serial port.

Options — Opens a tabbed dialog box that allows you to tailor the appearance and 
operation of the DSP Configurator program to your liking:

• Appearance — Change the color style of the program.

• Complimentary Colors — Set the primary and secondary colors in the filter blocks. 
Complimentary colors allows custom selection of colors used with the various graphs 
and dialog boxes. Graph colors change the row colors containing the information and 
descriptions of the graphs seen in the processor blocks.

• Graph Colors — Change the row colors containing the information and descriptions of 
the graphs seen in the processor blocks.

• Preferences — Contains options for selection of the devices to connect to, or to 
Always ask on startup. That selection can be changed using Default Device.

If Show Meters is set to True, Dynamic Block Meters can be used to tailor the 
appearance of the dynamics meters to use the full meter to show input and gain 
reduction, or to show the level based on the output and gain reduction.

• Processor Defaults — Sets the default parameters for all processors. Also allows 
you to restore the factory defaults for these processors.
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DSP Configurator Window menu 
Cascade — Rearranges all open DSP Configurator program windows, 
including dialog boxes, in a cascading array.

Close All Windows — Closes all open dialog boxes.

Individual windows — Brings the associated dialog box to the front 
of the desktop.

DSP Configurator Help selection 
Opens the DSP Configurator program Help file.

DSP Configurator Presets drop-down box
Displays a list of up to 32 presets, which can  
include ties and audio settings. You can select 
a preset from the list to display it in the 
window and either activate it (Recall), abort the 
selection without 
either recalling or deleting it (Cancel), or delete it (Delete) (see Recall a preset on page 109

NOTES:

• The Recall, Cancel, and Delete buttons appear when a preset is selected.

• An asterisk (*) in the drop-down box indicates that a preset that only exists in the 
switcher has not been saved to the configuration file of the DSP Configurator. 
The ties and settings of the preset are not in sync between the DSP Configurator 
program and the switcher.

DSP Configurator Mode buttons 
Allows you to select between Live mode and Emulate mode (see 
Emulate mode vs. Live mode, on page 109, for more information).
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Keyboard Navigation
The DSP Configurator program is fully navigable using the computer keyboard. Some 
keyboard navigation behavior matches Windows standards, while other behaviors are 
specific to the DSP Configurator program.

When the program is started, the cursor focus is in the upper left corner of the program 
audio input (line signal processor chain (A on figure 61). The Input 1 Gain block is 
highlighted green [ ]).

AAAAAAAAAADDDDDDDDDD EEEEEEEEEEBBBBBBBBBB CCCCCCCCCC

Figure 61. DSP Configurator Program Window

Standard Windows navigation
The keyboard keys navigate and function as follows:

• <Tab> key —

Sequentially jump among major segments of the DSP Configurator program. From the 
audio input chains (A), sequential jumps are in the following order:

• AV matrix block (B)

• Output processor chains and mixers (C)

• <Shift>-<Tab> key combination —

Reverses the direction of the Tab key function.
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• Arrow ( , , , and ) keys —

Navigate up, down, left, and right within any of the areas in the DSP Configurator.

Jump from the audio input blocks (A) into the input name fields (D).

Jump from the output blocks (C) into the output name fields (E).

• <Enter> Key — Performs the same action as a mouse double-click. For example, 
opens the context menu from which a processor type may be selected or opens a 
dialog box when applicable. When an action button is highlighted, <Enter> executes the 
button action and toggles the button when applicable.

• Control key — The <Ctrl> key can be used in the following shortcuts.

• <Ctrl>-<X> — Cut the selected elements.

• <Ctrl>-<C> — Copy the selected elements.

• <Ctrl>-<V> — Paste the selected elements.

• <Ctrl>-<E> — Go to Emulate mode.

• <Ctrl>-<A> — The first press of the Ctrl-A combination highlights all AV matrix 
block (B) output nodes. The second press highlights all elements within the 
program.

• <Alt> key — The <Alt> key is used with specific letter keys to open and navigate task 
bar menus. When the <Alt> key is pressed and either held or released, the first letters in 
the menu titles (File, Edit, View, Tools, Window, or Help) become underlined. Press the 
underlined letter key to open that menu.

Once a task bar menu is open, use the up and down arrow keys to move up and down 
in the menu or submenu, use the right key to open a submenu (if applicable), and use 
the <Esc> key to back out of an active menu or submenu.

DSP Configurator-unique navigation

Making ties

Video and audio ties can be made from the keyboard as follows:

1. Use the arrow ( , , , and ) and <Tab> keys to navigate to the AV matrix block 
(B) input node ( ) from which you will make the tie. The node is marked by a yellow 
outline ( ).

2. Press and hold the <Shift><Tab> key while you press the right arrow  to drag the 
potential tie (dashed line) to the corresponding output node (input 1 to output 1, 2 to 2, 
and so on).

3. Release the <Shift> key.

4. Press the <Enter> key to execute the tie.

5. If desired to make additional ties from the same input, press the up arrow  or 
down arrow  (<Shift> is not required) to select another output to tie to the same input.

6. If you made additional ties from the same input, press the <Enter> key to execute 
the tie.

7. If desired, repeat steps 5 and 6 to tie additional outputs to the same input.

8. If desired to make ties from a different input, press the left arrow  key once, and 
repeat steps 1 through 7.

9. Press the <Tab> key, <Esc> key, right arrow  key, or left arrow  key to exit the set 
ties operation.
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Highlighting and marking items, cutting or copying, saving a preset

When an item within the program is selected, it is green highlighted. One or more highlighted 
items can be cut, copied, pasted, or saved as a preset. The cut, copy, and paste functions 
can be performed using the task bar menus (see the <Alt> key, on the previous page) or 
the shortcuts described on the previous page.

NOTE: When an item is cut, it is not removed from its original location until it has been 
pasted in its new location.

Highlight multiple elements for cut, copy, paste, or a preset as follows:

1. Use the arrow ( , , , and ) keys to move to the first block to highlight.

2. To highlight sequential blocks:, press and hold the <Shift> key, then use the arrow 
( , , , and ) keys to navigate to and highlight additional elements.

When you reach the last element you want highlighted, release the <Shift> key.

3. To highlight non-sequential blocks:

a. Press and hold the <Ctrl> key, then use the arrow ( , , , and ) keys to 
navigate to the next desired element

b. Release the <Ctrl> key.

c. To highlight sequential blocks, press and hold the <Shift> key, then use the 
arrow ( , , , and ) keys to navigate to and highlight additional elements.

d. To move away from the highlighted block or set of sequential blocks, press 
and hold the <Shift> key, then use the arrow ( , , , or ) keys to move the 
highlighting box away from the last-highlighted element.

NOTE: If you do not perform step 3c, the last selected element will not remain 
highlighted.

e. Release the <Shift> key.

4. To highlight another element or group of elements, repeat steps 1 through 3.

5. To cut or copy, press the <Ctrl>-<X> or <Ctrl>-<C> key combination.

6. To save a preset, press <Alt>, then <T>, then right arrow , then down arrow , 
then <Enter> (see figure 62, on the next page).

The Save a Preset dialog box appears.

a. As desired, <Tab> to the Preset Number field and type a specific preset number.

a. As desired, <Tab> to the Preset Name field and type a preset name.

NOTE: Unless you enter a specific number, name, or both, the DSP 
Configurator program enters the next sequential unused preset number and 
the name Preset number.

b. Press <Tab> to highlight the OK button and press the <Enter> key.
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Alt T Enter

Figure 62. Saving a Preset Using Keyboard Navigation

Setting group master soft limits

• <Shift> key in a combination moves the upper limit —

• <Shift>-Up arrow or <Shift>-down arrow ( Shift   or Shift  ) — Moves the soft 
upper limit in 0.1 dB increments.

• <Shift>-<Page Up> or <Shift>-<Page Down> — Moves the soft upper limit in 
10 dB increments.

• <Shift>-<Home> — Moves the soft upper limit to the upper default.

• <Shift>-<End> — Moves the soft upper limit to the fader position.

• <Ctrl> key in a combination moves the lower limit —

• <Ctrl>-Up arrow or <Ctrl>-down arrow ( Ctrl   or Ctrl  ) — Moves the soft lower 
limit in 0.1 dB increments.

• <Ctrl>-<Page Up> or <Ctrl>-<Page Down> — Moves the soft lower limit in 
10 dB increments.

• <Ctrl>-<Home> — Moves the soft lower limit to the fader position.

• <Ctrl>-<End> — Moves the soft lower limit to the lower default.
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Signal Path Building Blocks
All of the inputs and outputs that have name blocks (  in figure 63) are discrete 
signal paths:

Visible in figure 63 Not visible in figure 63

• Line in • Virtual returns in

• Mic in • Expansion bus in

• Output

The input and output processor chains on these paths can be individually loaded with 
pre-configured modular templates called building blocks. These modules are designed for 
specific microphones, source devices, or speaker destinations, and can streamline the initial 
configuration. The modules are configurable and are more versatile than a global template.

The modular building blocks can be loaded to a selected input or output by a clicking on the 
signal path label bringing up the building block dialog box.

Different menus or dialogs are available according to the selected signal path.

The building blocks can be renamed and processor blocks further customized according to 
the requirements of the system.

Figure 63. Building Blocks Availability
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Selecting a building block
Select a hand-held microphone configuration as follows:

1. Open the Building Blocks dialog box: Click the Mic Input 1 number box. The 
Building Blocks dialog box opens.

Click the number. A Building Block dialog box opens.

The modules in the box are dependent on the 
device type clicked.
In this example, mic modules are shown 
because a mic input was selected.

1111111111

2. Select the desired building block: Click Shure Beta 58. The input channel 
loads the pre-configured processor blocks, sets the gain, and renames the channel 
Shure Beta 58.

NOTE: Common devices may be grouped in folders. If necessary, click a folder 
(Handheld mic in the example below) to open it and make the building blocks 
available for selection.

Click the desired input device.

The input device name and the processor chain change to shows the adjustments.

2222222222
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Adding a building block
Custom building blocks can be created if necessary, such as if a new mic is connected to 
an input. The signal path can be configured for that specific mic and then saved as a new 
building block as follows:

1. Modify the processing chain for an input or output. In this example, a custom mic 
configuration has been created for mic 2.

2. Open the Building Blocks dialog box: Click the Mic Input 2 number box. The 
Building Blocks dialog box opens.

Click the number. A Building Block dialog box opens.

2222222222

3. Add a building block: In the dialog box, select the Add Block icon ( ).
Click the Add Block icon.

The Add a Building Block dialog box opens.

3333333333



 

DTP CrossPoint 84 IPCP Series Matrix Switchers • Matrix Software 124

4. Name the block: In the Name field, type a name for the new building block. If desired, 
select a folder for the block in the Create In: drop-down box.

4444444444

NOTE: You can choose to overwrite an existing building block:

1. Type an existing name for the new configuration.

The program prompts to warn that an existing configuration will be overwritten.

 

2. Click Yes.

5. Click Add.
Click the Add button.

The dialog box closes.

The Name field changes to that of the new building block.

5555555555

The new mic configuration is now a building block that can be used to quickly configure 
new devices.
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Organizing building blocks
The Tools menu contains a utility that allows the building blocks to be organized or 
rearranged to suit an application. Individual blocks and folders can be moved or deleted 
and new folders can be created. Click Tools > Organize Building Blocks. The Organize 
Building Blocks dialog box opens (see figure 64).

Figure 64. Starting the Organize Building Blocks Utility

The general categories of folders include the main inputs; mic/line, line, and virtual return; 
and line outputs.

This utility lets you organize listed building blocks. You can also import and export the 
building blocks file so that you can use your set of building blocks on other computers.

Organizing Listed Building Blocks

Building blocks can be organized within default folders or within new folders. You can move 
individual building blocks or a folder with all of its contents to a new location.

Create a new folder in the Organize Building Blocks dialog box by clicking the New Folder 
icon ( ) in the upper right corner. The folder appears within the currently selected group in 
the organizational tree. 

To move a building block or a folder, click and drag the desired item to the new location.

Folders can be expanded to view the associated building blocks by clicking the 
Plus icon ( ) beside the folder name.

Deleting a building block or folder 

TIP: If you inadvertently delete a needed default 
building block, you can restore it (see Restore 
Default Building Blocks, on the next page).

From within the Organize Building Blocks dialog box, 
delete a building block or folder by selecting (clicking) 
the block or folder from the list and clicking the Delete 
icon ( ).
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Restore Default Building Blocks

If one of the default building blocks, those that were installed with DSP Configurator, has 
been deleted, it can be restored. 

NOTE: User-defined building blocks cannot be restored.

From within the Organize Building Blocks dialog box, restore default building blocks by 
selecting (clicking) the Restore Default Building Blocks icon ( ). The default building 
blocks and original folders are restored to the list.

Importing or Exporting Building Blocks Files

You can import a building blocks file from another computer running DSP Configurator or 
export a file for use elsewhere. Building blocks files are saved with an XML file extension.

Import a building blocks file from within the Organize Building Blocks dialog box as 
follows:

1. Click the Import Building Blocks File icon ( ). The “Import from...” dialog box 
opens.

2. Browse to and select the desired building blocks file.

3. Click Open. The selected building blocks file is imported into the Organize Building 
Blocks dialog box.

Export a building blocks file from within the Organize Building Blocks dialog box, 
as follows:

1. Click the Export Building Blocks File icon ( ). The “Export to...” dialog box 
opens.

2. Browse to the location where the file is to be saved.

3. In the File Name field, leave the current file name or enter a new file name.

4. Click Save.
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Ducker Priority Tutorial
Insert a ducker using one of the Double-click the block, 

then click Ducker
Right-click the box to open context
menu, then click Insert Ducker

-or-
 

methods at right.

Once inserted, double-click on the 
ducker block to open the Ducker 
Configuration dialog box. The 
Enable Source Mic/Line box is 
checked.

Set a ducking source

The first inserted mic ducks all selected targets. 

1. Insert a ducking processor to mic 1.

2. Open the ducker configuration box and select the desired duck targets (see figure 65). 
In this example post-matrix 1 through 4 are the ducking targets.

 

Figure 65. Set a Ducking Source

Any signal on mic 1 that exceeds the ducking threshold now ducks mics 2 through 4.

Set an additional ducking source

The ducking processor can also have an additional input duck other targets using the 
priority feature. The second input ducks its selected duck targets, and can also be 
ducked by the first ducking source.

1. Insert a ducking processor on the additional ducking source. In this example, mic 2 is 
the second ducking source (see figure 66).

Figure 66. Set a Second Ducking Source
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As was shown in figure 65, on the previous page, mic 1 is the first source. Since it was 
selected as a ducking target, mic 1 is not available as a target of mic 2.

2. Open the ducking dialog box for the input and select the desired duck targets. In this 
example mics 3 and 4 are the ducking targets of mic 2.

Any signal on input #2 that exceeds the ducking threshold now ducks mics 3 and 4. 
The ducking targets can be changed at any time by double-clicking the mic 2 ducking 
processor block. 

Since mic 2 is a target of mic 1, if a signal on mic 1 exceeds the ducking threshold, 
mics 2 through 4 are still ducked regardless of whether the signal on mic 2 exceeds its 
ducking threshold.

NOTE: No input will be ducked more than the amount set in the applicable 
by (dB): field.

Expansion Port Operation Within the DSP
The expansion port (see DMP Expansion Port and LED, in the Installation section 
on page 14) allows a DTP CrossPoint matrix switcher and an Extron DMP 128 ProDSP 
Digital Matrix Processor to be connected together for bidirectional communications with 
16 channels of output audio and 8 channels of input audio. Audio that is processed in one 
unit can be directly input to the other unit to harness its processing capabilities.
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Expansion output channels
The DTP CrossPoint has 16 expansion output channels (see figure 67), comprised of:

• Mic inputs 1 through 4 (channels 1 through 4)

• Virtual returns A through D (channels 5 through 8)

• Line outputs 1 through 4, left and right (channels 9 through 16)

DTP CrossPoint 84

DMP 128 ProDSP
Digital Matrix Processor

}
} }

}}

Figure 67. Expansion Output Channels
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Expansion input channels
The DTP CrossPoint accepts 8 expansion input channels (see figure 68).

DMP 128 ProDSP
Digital Matrix Processor

DTP CrossPoint 84}
Figure 68. Expansion Input Channels

Connection
No special setup is required; just connect the two devices. By default, the DMP 128 is 
the primary unit and the DTP CrossPoint is always the secondary unit. If you have trouble 
connecting the matrix switcher and the DMP 128, check that the DMP 128 is set to be the 
primary device.
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Optimizing the Audio
Program material that you are familiar with is preferable for the following procedures, 
otherwise, pink noise can be used.

TIP: The Extron VTG 300 or VTG 400 is recommended to provide the pink noise.

Input Clipping and Clipping Meters
Audio clipping is a form of distortion that occurs when the signal peaks (or excursions) 
exceed the limits of the circuit, cutting off the excursions of a signal. This condition gives 
audibly undesirable results. While it is difficult to clip the audio signal within the DSP audio 
signal chain, it is extremely important that the audio signal is not clipped before the input to 
the switcher. Once audio is clipped at the input, there is no remedy further down the signal 
chain. However, if audio clipping occurs at the output of the DSP that is not a result of 
clipping at the input, this can be addressed in the DSP audio signal chain.

Meters are available in the gain controls ( ) and in the dynamic processor blocks ( ) when 
the program is in Live mode and an audio signal is applied to the DSP. The meters in the 
DSP Configurator program indicate clipping at a user-definable level, with the default setting 
at -1 dB. At the -1 dB setting, the meter indicates clipping when it reaches -1 dBFS, or 1 dB 
below actual clipping. Setting the clipping meter below actual clipping provides a bit of a 
“safety net,” letting you know to pull back on input gain before clipping actually occurs. You 
can increase or decrease this safety net by clicking Tools > Options > Defaults tab > 
Meter Clipping tab, and setting the Clip  
Threshold to a number between 0 (dB) and 
-20. When the clip threshold is set to 0, clipping 
is indicated only when actual clipping occurs.

Meters within the DSP Configurator program are peak-type meters, referenced to “full 
scale,” or 0 dBFS. For the DTP CrossPoint 84, 0 dBFS corresponds to 22 dBu, which is the 
maximum output level of the switcher.

Setting the Input and Output Gain Structure
Before calibrating loudness, set up the system gain structure.

1. Set the signal generator to output -10 dBFS or use recorded program material at 
-20 dBFS.

2. Set the input gain in the DSP Configurator so that the input meter reads -20 dBFS.

NOTE: In step 3, if using a recorded source and the player has an output level 
setting control, ensure that the output of the player is set to its maximum, or 0 dB 
of attenuation.

3. For program material, set the input level to approximately -15 dBFS, with peaks 
at no more than -5 dBFS to -3 dBFS. This setting provides enough headroom to 
accommodate transients or unanticipated loud events in the program material in order 
to avoid possible clipping.

4. Tie the audio from the source to the speakers that will carry program material in the 
room to be calibrated.

5. With the output channel volume set to -20 dB, listen to the audio output while you 
set the external amplifier so that the source material plays at a volume level that is 
reasonably loud but tolerable. Verify that the amplifier is not clipping by observing the 
amplifier clip indicator.
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Adjusting the Pre-matrix Trim
The pre-matrix trim control can be used to compensate for any level changes caused by 
signal processing before the trim control. Adding a compressor generally reduces the signal 
level, while a filter can either boost or cut the overall signal level.

NOTE: This procedure is valid only if no processing is active in the output signal path, 
and if post-matrix trim value is set to 0 dB (unity gain). If you have processors inserted 
in the output signal path, open them and bypass them to temporarily remove them 
from the signal path.

1. After you have set the input gain, add any processors that you wish to use into the input 
signal chain.

TIP: If you make changes to filter settings after you have set your dynamics 
processors, recheck the levels in your dynamics processors to make sure that they 
are still valid.

2. Open the line input gain dialog box, the output volume dialog box, and the pre-matrix 
trim dialog box.

3. Set output volume to 100%. If the audio is too loud or distracting, mute the output.

4. With program material (or pink noise) present at the input, adjust the pre-matrix trim so 
that the meter level in the output volume dialog box matches the meter level in the input 
gain dialog box. This maintains the audio at an optimal level in the input signal chain.

TIP: This is a good baseline. If, after you’ve set up your microphone input gain and 
mix-point levels, output processing, and post-matrix trim levels, you find that you 
need more headroom to prevent clipping at the outputs, return to the pre-matrix 
trim controls and lower each trim by the same dB amount.

You may also find that further minor adjustments to the pre-matrix Trim controls 
help to balance out the perceived audio levels of the different inputs.

Finalizing the Output Gain Structure
Adding a compressor generally reduces the signal level, while a filter may boost or cut the 
overall signal level. Loudness boosts the overall signal level, but mostly at lower volume 
settings (see Calibrating Loudness on page 124 for more information).

1. Add any processors that you wish to use into the output signal chain.

After adding processors to the output signal chain, the output volume level may clip 
when set to or near 100%.

2. Set output volume to a level where clipping is eliminated.

NOTE: Mic levels also contribute to possible clipping at the outputs. They may need 
to be lowered at the mic mix-points to maintain the balance between program 
material (line inputs) and voice (mic).

TIP: Remember that the output volume control is essentially the same volume 
control that is accessible to a front panel operator. An operator may unknowingly 
change the volume back to a level where clipping occurs. You can reduce the 
chance of this inadvertent clipping by using the post-matrix trim control rather than 
the volume control (see Adjusting the Post-matrix Trim on the next page).
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Setting the Mic Input and Mic Mix-point Levels
1. Double-click the mic mix-point to be set, opening the dialog box for that mix-point.

2. Unmute the mix-point (mixing in the mic signal). The default level is 0.0 dB, or unity gain.

3. Connect your chosen microphone to mixed mic/line input.

4. Open the mic input gain dialog box for the mixed mic.

5. If your mic requires phantom power, turn it on in the mic input dialog box.

6. Unmute the mic/line input.

7. While testing the mic, raise the mic gain fader until the mic is clearly audible.

The gain level and the mic gain meter level reading vary at this point, but as a general 
guideline, the input gain level is approximately 40 dB to 50 dB and the meter averages 
approximately -20 dBFS.

TIP: Voice levels at microphone inputs can vary greatly, making audio optimization 
difficult for these inputs. Having the meters average around -20 dBFS gives 
enough headroom to accommodate sudden changes to voice levels. Further 
adjustment may be necessary.

Adjusting the Post-matrix Trim
Adjusting the post-matrix trim is a bit of a balancing act. This section provides guidelines, 
but it may take a bit of experimentation to set levels just right. For example, the output 
level can be controlled and kept below clipping using a compressor or limiter in the output 
dynamics block. However, adjusting the post-matrix trim affects how the compressor or 
limiter works.

1. Open the output volume dialog box and the post-matrix trim dialog box.

2. Set output volume to 100% (if the audio is too loud or distracting, mute the output).

3. With program material or pink noise present at the input, adjust the post-matrix trim until 
the meter level in the output volume dialog box is below clipping (or ideally, matches the 
level at the input gain meter). This maintains the audio at an optimal level in the output 
signal chain, and prevents clipping at the output.

Setting the Volume Control for an External Amplifier
The maximum output of the switcher is +22 dBu. Assume that you have a power amp 
with a maximum input level of +4 dBu when the input attenuator is fully open. If you want 
to control volume levels using the output volume controls of the switcher and at the same 
time ensure that clipping does not occur at the amplifier, you need to turn down the input 
attenuator of the power amp the equivalent of 18 dB (18 + 4 = 22 dB), which puts the input 
level of the amp at -14 dB (+4 minus 18 = -14). If you find that the amp setting (when the 
output volume controls of the DSP Configurator are at 100%) is too loud for the room, you 
can turn it down further. If the amp is not loud enough for the room, you will need a more 
powerful amplifier.

On the other hand, if you wish to control volume levels using the input attenuation control 
for the power amplifier, (using the same power amp max input level) you can set the output 
volume control of the DSP Configurator to -18 dB. This is another way that clip points of the 
two devices will be matched, ensuring that clipping will not occur.

However, Extron recommends using the output volume control of the matrix switcher for 
controlling output volume. If you are using loudness processing on the unit, it works only in 
conjunction with the output volume control.
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Calibrating Loudness
The basic gain structure is now set up. From this point, loudness can be calibrated using an 
SPL meter, a critical ear, or a combination of the two.

Setting loudness using a meter
To calibrate loudness, use a sound pressure level meter set to “C” weighting.

1. Open the post-matrix loudness processor dialog box.

2. Bypass the loudness processor.

3. Place the meter in an average listening location.

4. Start your program material playback or generate pink noise.

5. Measure the SPL in the room.

6. In the loudness dialog box, adjust the fader until the value in the “SPL” readout box 
matches the reading on the SPL meter. 

NOTE: Calibration can be performed with the output channel volume set to 
any comfortable listening level, but a relatively loud volume that can be easily 
measured is preferred.

Loudness is now calibrated.

7. Release the bypass of the loudness processor to hear the compensation.

Alternate method:

NOTE: This method works if 90 dB is an acceptable amplifier or volume limit for the 
room.

1. Set the Loudness Compensation fader in the loudness dialog box to its default (center) 
position and the output channel volume fader to 0 dB (100% volume).

2. Adjust the amplifier until the SPL meter reads 90 dB. Loudness is now calibrated.

Setting loudness “by ear”
When setting loudness by ear, it is also essential that the system gain structure be set up 
first.

1. Open the post-matrix loudness processor dialog box.

2. Bypass the loudness processor.

3. Place the meter in an average listening location.

4. Set the output volume fader to a relatively quiet listening level. Filter compensation 
from the loudness processor is most prominent at low listening levels. Set to the levels 
described earlier.

5. Set the Loudness Compensation fader in the loudness dialog box to its default (center) 
position.

6. Release the bypass on the loudness processor to hear the compensation.

NOTE: You should hear a moderate enhancement to the program material with 
more accentuated bass frequencies (below 500 Hz) and more brightness in the 
high frequencies that carry harmonic content (above 7 kHz). You can toggle the 
loudness bypass on and off to compare the difference between loudness off and 
on.
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7. To experiment with less loudness compensation, move the Loudness Compensation 
fader to the left, toward Less.

For more loudness compensation, move the fader to the right, toward More.

8. Any adjustment you make to the Loudness Compensation fader carries through to all 
listening levels. Set the DSP Configurator output volume to a relatively loud listening 
level. 

9. Toggle the loudness bypass on and off to compare the difference between loudness off 
and on. At a loud listening level, this difference should be minimal, or barely perceivable.
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HTML Operation

The DTP CrossPoint Matrix Switcher can be remotely controlled via:

• SIS commands (see Programming Guide, beginning on page 52)

• The Extron Product Configuration Software and DSP Configurator software (see Matrix 
Software, on page 72).

• The built-in HMTL page (see below)

This section details using the built-in HTML page to perform a variety of tasks. Subjects 
includes:

• Download the Startup Page and View Switcher Status

• Change the Communications Settings

• Update the Firmware

• Set Passwords

• Set the Clock

The switcher can be monitored and configured through its LAN port, connected via a 
LAN or WAN, using a compatible web browser. The browser display has the appearance 
of a web page. This chapter describes the factory-installed HTML page, which is always 
available and cannot be erased or overwritten.

NOTES:

• For best results, Extron recommends the following browsers:

• Microsoft® Internet Explorer®, version 8.0 or newer, with compatibility mode 
off

• Mozilla® Firefox®, version 6 or newer

• Google® Chrome™, version 9 or newer

• Apple® Safari®, version 4 or newer

• If your Ethernet connection to the matrix switcher is unstable, try turning off the 
proxy server in your Web browser. In Microsoft Internet Explorer, click Tools > 
Internet Options > Connections > LAN Settings, uncheck the Use a proxy 
server... box, and then click OK.
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Download the Startup Page and View Switcher Status
Access the switcher using HTML pages as follows:

1. Start the Web browser program.

2. Click in the Address field of the browser and highlight any existing text.

3. Enter the IP address of the switcher in the Address field of the browser.

NOTE: If the local system administrators have not changed the value, the 
factory-specified default, 192.168.254.254, is the correct value for this field.

4. Press the keyboard <Enter> key. The switcher checks to see if it is password protected.

If the switcher is not password protected, it downloads the HTML page (see figure 70 
on the next page).

If the switcher is password protected, the switcher downloads the Authentication 
Required dialog box (see figure 69).

Figure 69. Enter Network Password Page

NOTE: By default, the User Name is either admin or user, depending on the level of 
authentication requested.

5. Click in the User Name field and type in the appropriate name.
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6. Click in the Password field and type in the appropriate administrator or user password. 
Click the OK button.

The switcher downloads the factory-installed HTML page, (see figure 70).
  

Figure 70. Built-in HTML Page

The input status panel displays the connection status of each input. The output status panel 
displays the selected resolution of scaler outputs 3 and 4. The various lock icons have the 
following meanings:

Input Status locked ( ) — The input is HDCP compliant.

Input Status unlocked ( ) — The input is not HDCP compliant.

Output Status locked-check ( ) — The connected display is HDCP compliant and an 
encrypted signal is routed to it.

Output Status locked-X ( ) — The connected display is HDCP compliant but currently 
not encrypted.
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Change the Communications Settings
Click the Edit button in the Communications Settings panel (see figure 71, 1) to open the 
Communications Settings dialog box. The dialog box provides a location for viewing and 
editing settings unique to the Ethernet interface. See the IPCP Pro 350 Series User Guide at 
www.extron.com for basic information about IP addresses.
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Figure 71. Communications Settings Dialog Box

Address Fields (DHCP Not Selected)
The IP Address field (2) contains the IP address of the connected matrix switcher. This 
value is encoded in the flash memory in the switcher.

The Subnet Mask field (3) is used to determine whether the matrix switcher is on the same 
subnet as the controlling PC when you are subnetting.

The Default Gateway field (4) identifies the address of the gateway to the controlling PC 
to be used if the matrix switcher and the mail server are not on the same subnet.

Valid addresses consist of four 1-, 2-, or 3-digit numeric subfields, properly called octets, 
separated by dots (periods). Each field can be numbered from 000 through 255. Leading 
zeroes, up to 3 digits total per octet, are optional. Values of 256 and above are invalid. 
For more information on all of these fields, see the IPCP Pro 350 Series User Guide at 
www.extron.com.

The default addresses are as follows, but if these conflict with other equipment at your 
installation, you can change the addresses to any valid value:

• IP address 192.168.254.254 • Gateway address 0.0.0.0

• Subnet mask 255.255.0.0

The MAC Address (5) is hardcoded in the matrix switcher and cannot be changed.

http://www.extron.com
http://www.extron.com
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Edit any of these changeable fields as follows:

NOTE: The address fields cannot be edited when DHCP is selected.

1. Click in the desired field. The graphic cursor becomes a text cursor.

2. Edit the address or name as desired.

3. Press the <Tab> key on the keyboard or click in another field to exit the field.

4. Click the Apply button (see figure 71, on the previous page, 7) to make the address 
change take affect.

Use DHCP Check box
The Use DHCP check box (6) directs the matrix switcher to ignore any entered IP addresses 
and to obtain its IP address from a Dynamic Host Configuration Protocol (DHCP) server (if 
the network is DHCP capable). Contact the local system administrator to determine if this 
is the appropriate selection. Click the Apply button (7) to make check box changes take 
affect.

Update the Firmware
Click the Update button in the Device Info panel (see figure 72) to open the Firmware 
Update dialog box. The dialog box provides a way to replace the firmware that is coded in 
the switcher without removing it from the system.

4444444444 5555555555

Figure 72. Firmware Update Dialog Box

Update the switcher firmware as follows:

1. Perform steps 1 through 6 of Installing the Software, on page 73, to download the 
firmware upgrade from the Extron website.

2. Connect the PC to the matrix switcher via any switcher LAN port.

3. Access the matrix switcher using HTML pages.

4. Click Update in the Device Info panel (see figure 72, above). The Firmware Upgrade 
dialog box opens.

5. Click Browse. The Open dialog box opens.
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6. Navigate to the folder where you saved the firmware upgrade file (see figure 73). Select 
the file and click Open. The Firmware Update dialog box returns to the top.

6666666666

6666666666

7777777777

¢¢¢¢¢¢¢¢¢¢

Figure 73. Updating Firmware

7. Click Upload. The switcher reports Uploading, Initializing, Installing, and Rebooting. this 
process may take 6 to 8 minutes. After the reboot is complete, the display returns to the 
default HTML page (see figure 70 on page 139).

NOTE: If the default HTML page does not display after 10 minutes, close the web 
browser and reopen.
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Set Passwords
Click Set in the Passwords panel (see figure 74, 1) to open the Passwords dialog box.
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Figure 74. Passwords Dialog Box

The fields in the Passwords dialog box are for entering and verifying administrator and user 
passwords. Passwords are case sensitive and are limited to 12 upper case and lower case 
alphanumeric characters. Each password must be entered twice: once in the Password 
field (2) and then again in the Confirm Password field (3). Characters in these fields are 
masked by asterisks or dots (*****). If you do not want to password protect an access level, 
leave both fields blank. After entering the desired password in both fields, click the Apply 
button (4).

NOTES:

• An administrator password must be created before a user password can be 
created.

• You cannot clear an existing password using this dialog box (see the Reset (clear) 
administrator password and Reset (clear) User password SIS commands, 
both on page 70).
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Set the Clock

Sync to PC
The simplest way to set the switcher clock is to click Sync to PC in the Date/Time Settings 
panel (see figure 75). The switcher uploads the time and date information from the 
connected computer.

Figure 75. Date/Time Settings Panel — Sync to PC

Set Manually
The Date/Time Settings dialog box (see figure 76) provide a location for viewing and setting 
the time functions.

1111111111
2222222222

3333333333 4444444444

5555555555

Figure 76. Date/Time Settings Dialog Box

Manually set the time as follows:

1. Click Set Manually on the the Date/Time Settings panel to open the Date/Time 
Settings dialog box.

2. Click the Calendar icon ( ) and select the date in the pop-up calendar tool.

3. Use the keyboard to enter hours, minutes, and seconds or click the up or down  
buttons until the desired variable is displayed in the applicable fields.

4. Select AM or PM in the AM/PM drop-down box.

5. Click Apply.
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DSP SIS Commands

Command and Response Table for SIS Commands
Many DSP functions; gain (which includes the mix-points), trim, mutes, and some group 
master functions; can be controlled using SIS commands. These commands follow the 
same general rules as basic SIS commands, but the variables (X/s) tend to be more 
complex. Also, a comprehensive understanding of the audio signal flow of the DSP is 
helpful to understanding these commands. Thumbnails of the controls are provided in the 
tables that follow for reference; the signal flow is described in detail in DSP Configurator 
Program, beginning on page in 81. The  letters in the tables on on pages 145 through 
149 refer to blocks of controls in the full DSP Configurator program window (see figure 40 
on page 82).

Symbol Definitions
] = Carriage return and line feed

} = Carriage return (no line feed)

| = Pipe (can be used interchangeably with the } character)

• = space

E = Escape key

W = Can be used interchangeably with the E character

X6) = Object ID (gain control or mix-point) See the tables on pages 145 through 149.

X6! = Level value -100.0 dB to +80.0 dB, in 0.1 dB increments. Example: 56 = 5.6 dB.

NOTE: The valid range of the X6! level for a specific control depends on the control addressed.

X6@ = Mute and phantom power status 0 = unmute (pass audio) or off 1 = mute or on

X6# = Group master group number 01 – 32

X6$ = Group fader setting dB value, in 0.1 dB increments. The valid range depends on the type of gain block 

X6% = Group fader increment dB value, in 0.1 dB increments, to raise or lower a group fader

X6^ = Group fader soft limit dB value, in 0.1 dB increments. X6^ must be within the range for the gain block 
grouped in X6#.

X6& = Group type 6= gain   12 = mute
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Line Input Gain Blocks (A) 

Input Gain Trim Input Gain Trim

Input 1 Input 5
Left 30000 30100 Left 30008 30108

Right 30001 30101 Right 30009 30109

Input 2 Input 6
Left 30002 30102 Left 30010 30110

Right 30003 30103 Right 30011 30111

Input 3 Input 7
Left 30004 30104 Left 30012 30112

Right 30005 30105 Right 30013 30113

Input 4 Input 8
Left 30006 30106 Left 30014 30114

Right 30007 30107 Right 30015 30115

Mic Input Gain Blocks (B) 

Input Pre-
mixer

Input Input Gain Pre-mixer 
Gain

Input Input Gain Pre-mixer 
Gain

Input 1 40000 40100 Input 3 40002 40102

Input 2 40001 40101 Input 4 40003 40103
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Post-matrix Gain Blocks (F) 

Output Gain Output Gain

Output 1 Output 3
Left 50000 Left 50004

Right 50001 Right 50005

Output 2 Output 4
Left 50002 Left 50006

Right 50003 Right 50007

Virtual Returns and Expansion Inputs Gain Blocks (D and E) 

Virtual Return Gain Expansion Input Gain

Virtual Return A 50100 Expansion Input 1 50200

Virtual Return B 50101 Expansion Input 2 50201

Virtual Return C 50102 Expansion Input 3 50202

Virtual Return D 50103 Expansion Input 4 50203

Virtual Return E 50104 Expansion Input 5 50204

Virtual Return F 50105 Expansion Input 6 50205

Virtual Return G 50106 Expansion Input 7 50206

Virtual Return H 50107 Expansion Input 8 50207
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Switcher-to-output mixer block (G)
Mixer blocks, part 1 

 
 
 
 
 

GGGGGGGGGG

HHHHHHHHHH

IIIIIIIIII

JJJJJJJJJJ

Out 1 Out 2 Out 3 Out 4 Out 5 Out 6 Out 7 Out 8

Output 1
Left 20000

Right 20101

Output 2
Left 20202

Right 20303

Output 3
Left 20404

Right 20505

Output 4
Left 20606

Right 20707

Mic-to-output mixer block (H)
Mic in 1 20800 20801 20802 20803 20804 20805 20806 20807

Mic in 2 20900 20901 20902 20903 20904 20905 20906 20907

Mic in 3 21000 21001 21002 21003 21004 21005 21006 21007

Mic in 4 21100 21101 21102 21103 21104 21105 21106 21107

Virtual returns-to-output mixer block (I)
V. rtn A 21200 21201 21202 21203 21204 21205 21206 21207

V. rtn B 21300 21301 21302 21303 21304 21305 21306 21307

V. rtn C 21400 21401 21402 21403 21404 21405 21406 21407

V. rtn D 21500 21501 21502 21503 21504 21505 21506 21507

V. rtn E 21600 21601 21602 21603 21604 21605 21606 21607

V. rtn F 21700 21701 21702 21703 21704 21705 21706 21707

V. rtn G 21800 21801 21802 21803 21804 21805 21806 21807

V. rtn H 21900 21901 21902 21903 21904 21905 21906 21907

Expansion inputs-to-output mixer block (J)
Exp. in 1 22000 22001 22002 22003 22004 22005 22006 22007

Exp. in 2 22100 22101 22102 22103 22104 22105 22106 22107

Exp. in 3 22200 22201 22202 22203 22204 22205 22206 22207

Exp. in 4 22300 22301 22302 22303 22304 22305 22306 22307

Exp. in 5 22400 22401 22402 22403 22404 22405 22406 22407

Exp. in 6 22500 22501 22502 22503 22504 22505 22506 22507

Exp. in 7 22600 22601 22602 22603 22604 22605 22607 22607

Exp. in 8 22700 22701 22702 22703 22704 22705 22706 22707
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Switcher-to-virtual-send-bus mixer block (L)
Mixer blocks, 

part 2 
 
 
 
 

LLLLLLLLLL

MMMMMMMMMM

NNNNNNNNNN

OOOOOOOOOO

V. Send A V. Send B V. Send C V. Send D V. Send E V. Send F V. Send G V. Send H

Output 1

Left 20008 20009 20010 20011 20012 20013 20014 20015

Right 20108 20109 20110 20111 20112 20113 20114 20115

Output 2

Left 20208 20209 20210 20211 20212 20213 20214 20215

Right 20308 20309 20310 20311 20312 20313 20314 20315

Output 3

Left 20408 20409 20410 20411 20412 20413 20414 20415

Right 20508 20509 20510 20511 20512 20513 20514 20515

Output 4

Left 20608 20609 20610 20611 20612 20613 20614 20615

Right 20708 20709 20710 20711 20712 20713 20714 20715

Mic-to-virtual-send-bus mixer block (M)
Mic in 1 20808 20809 20810 20811 20812 20813 20814 20815

Mic in 2 20908 20909 20910 20911 20912 20913 20914 20915

Mic in 3 21008 21009 21010 21011 21012 21013 21014 21015

Mic in 4 21108 21109 21110 21111 21112 21113 21114 21115

Virtual returns-to-virtual-send-bus mixer block (N)
V. rtn A 21209 21210 21211 21212 21213 21214 21215

V. rtn B 21308 21310 21311 21312 21313 21314 21315

V. rtn C 21408 21409 21411 21412 21413 21414 21415

V. rtn D 21508 21509 21510 21512 21513 21514 21515

V. rtn E 21608 21609 21610 21611 21613 21614 21615

V. rtn F 21708 21709 21710 21711 21712 21714 21715

V. rtn G 21808 21809 21810 21811 21812 21813 21815

V. rtn H 21908 21909 21910 21911 21912 21913 21914

Expansion inputs-to-virtual-send-bus mixer block (O)
Exp. in 1 22008 22009 22010 22011 22012 22013 22014 22015

Exp. in 2 22108 22109 22110 22111 22112 22113 22114 22115

Exp. in 3 22208 22209 22210 22211 22212 22213 22214 22215

Exp. in 4 22308 22309 22310 22311 22312 22313 22314 22315

Exp. in 5 22408 22409 22410 22411 22412 22413 22414 22415

Exp. in 6 22508 22509 22510 22511 22512 22513 22514 22515

Exp. in 7 22608 22609 22610 22611 22612 22613 22614 22615

Exp. in 8 22708 22709 22710 22711 22712 22713 22714 22715
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Line Output Gain Blocks (K) 

Output Trim Output Analog Volume Digital Volume

Output 1 Amp Output HDMI
Left 60100 60300 60000 60200

Right 60101  60301* 60001 60201

Output 2 HDMI
Left 60102 60002 60202

Right 60103 60003 60203

Output 3 Analog DTP Digital DTP
Left 60104 60304 60004 60204

Right 60105 60305 60005 60205

Output 4 Analog DTP Digital DTP
Left 60106 60306 60006 60206

Right 60107 60307 60007 60207

* Not used on MA (mono amplifier) model.
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DSP SIS Commands

Command Function SIS Command 
(Host to Unit)

Response 
(Unit to Host)

Additional description

Audio trim, gain, and mixing

NOTES:

• The command format is the same, regardless of the control or mix-point that is to be set; the acceptable adjustment range varies 
depending on the control or mix-point:

All X6! values are in 0.1 dB increments. Example: 56 = 5.6 dB.
• The valid range of the level for a specific control depends on the control addressed:
 • The line audio input gain range is –18 dB to +24 dB (X6! = –180 to +240). 

• The mic input gain range is –18 dB to 80 dB (X6! = –180 to +800). 
• The line input trim and line output trim range is –12 to +12 dB (X6! = –120 to +120). 
• The mic pre-mixer gain, line out post-switcher gain, and pre-mixer gain range is –100 dB to +12 dB (X6! = –1000 to +120). 
• The mix-points (with their associated mixing controls) range is –35 dB to +25 dB (X6! = –350 to +250). 
• The line output gain range is –100 to 0 dB (X6! = –1000 to 0).

• For attenuation, the negative sign (–) must be entered and is reported in the response. For gain, the positive sign (+) is optional and 
is not returned in the response.

Set an analog DSP trim, gain, or 
mix-point

EGX6)*X6!AU} DsGX6)*X6!] Set object ID (X6)) to a level of X6!.

Example 1: EG30012*56AU} DsG 30012*56] Set the input 7 left gain to a value of 
5.6 dB.

Example 2: EG20800*–125AU} DsG 20800*–125] Set the mic input 1 gain to a level of 
–12.5 dB.

Read an analog DSP trim or 
mix-point

EGX6)AU} X6!] Object ID X6) is set to a value of X6!.

Example 1: EG50005AU} 105] Post-switcher output 4 right is set to 
+10.5 dB.

Example 2: EG60301AU} –955] Output 1 amplified audio output is 
set to -95 dB. This response is not 
possible on an MA model switcher.

Set a digital DSP trim, gain, or 
mix-point

EHX6)*X6!AU} DsHX6)*X6!] Set object ID (X6)) to a level of X6!.

Example: EH60204*-780AU} DsH 60204*-780] Set the output 3 left digital DTP gain to 
a value of –78 dB.

Read a digital DSP trim or mix-point EHX6)AU} X6!] Object ID X6) is set to a value of X6!.
Example: EH30103AU} 75] Line input 2 right trim is set to +7.5 dB.

Audio mute
Audio mute EMX6)*1AU} DsMX6)*1] Mute object ID X6).

Example: EM60006*1AU} DsM 60006*1] Mute output 4, left, analog volume.

Audio unmute EMX6)*0AU} DsMX6)*0] Unmute object ID X6).
Example: EM40000*0AU} DsM 40000*0] Unmute mic input 1 gain (pass audio).

Read audio mute EMX6)AU} X6@] X6@: 0 = mute off, 1 = mute on.

Phantom power

NOTE: The phantom power commands are valid only for the mic input gain object IDs (Y6)s 40000 through 40003).

Phantom power on EZX6)*1AU} DsZX6)*1] Turn phantom power on for object ID X6).
Example: EZ40000*1AU} DsZ 40000*1] Turn phantom power on for mic 1.

Phantom power off EZX6)*0AU} DsZX6)*0] Turn phantom power off for object ID X6).
Read phantom power status EZX6)AU} DsZX6)*X6@] X6@: 0 = phantom power off. 

       1 = phantom power on.

NOTE: X6) = Object ID (gain control or mix-point) See the tables on pages 145 through 149. 
X6! = Level value (depends on control) -100.0 dB to +80.0 dB, in 0.1 dB increments. Example: 56 = 5.6 dB. 
X6@ = Mute and phantom power status 0 = unmute (pass audio) or off 1 = mute or on



Command and Response Table for DSP SIS Commands (continued)
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Command Function SIS Command 
(Host to Unit)

Response 
(Unit to Host)

Additional description

Group masters

NOTES:

• See Group Masters, on page 103, for more information about audio group masters.

• A group must have assigned members for these commands to have an effect.
• For X6$, a positive (+) value is assumed unless a negative (-) value is specified.
• If entering a X6$ value outside the valid range for the group or outside the soft limits, the DTP CrossPoint responds with an invalid 

parameter (E13) error.

Set a group fader control EDX6#*X6$GRPM} GrpmDX6#*X6$] Set the group fader to a value of X6$.
Example: ED2*-293GRPM} GrpmD2*-293] Set the group 2 fader control to 

-29.3 dB.
Raise a group fader control EDX6#*X6%+GRPM} GrpmDX6#*X6$] Increase the level of the X6# group fader 

by X6% dB.
Example: ED2*30+GRPM} GrpmD2*-263] Raise the group 2 fader 3 dB (from 

-29.3 dB to -26.3 dB, starting from the 
level set in the Set a group fader control 
example, above.

Lower a group fader control EDX6#*X6%-GRPM} GrpmDX6#*X6$] Decrease the level of the X6# group 
fader by X6% dB.

View the group fader control level EDX6#GRPM} GrpmDX6#*X6$] In verbose modes 1 and 2, the response 
is simplified to X6$].

Mute a group mute control EDX6#*1GRPM} GrpmDX6#*1] Mute all blocks in group X6#.
Clear (unmute) a group mute control EDX6#*0GRPM} GrpmDX6#*0] Umute all blocks in group X6#.
View a group mute control EDX6#GRPM} X6@]
Set soft limits ELX6#*X6^upper*X6^lowerGRPM} Set the groups soft limits to X6^ and X6^.

GrpmLX6#*X6^*X6^]

Example: EL2*+60*-60GRPM} GrpmL2*60*–60] Set the upper soft limit for the group 2 
fader to +6.0 dB and the lower limit to 
-6.0 dB.

View soft limits ELX6#GRPM} GrpmLX6#*X6^*X6^] In verbose modes 0 and 1, the response 
is simplified to X6^*X6^].

View group type EPX6#GRPM} GrpmPX6#*X6&] Show the group type (X6&) for group 
X6#. In verbose modes 0 and 1, the 
response is simplified to X6&].

View group members EOX6#GRPM} X6) is the control or mix-point. In 
verbose modes 0 and 1, the response is 
simplified to X6)1*X6)2*...*X6)16].

GrpmOX6#*X6)1*X6)2*...*X6)16]

NOTE: X6) = Object ID (gain control or mix-point) See the tables on pages 145 through 149. 
X6# = Group master group number 01 – 32 
X6$ = Group fader setting dB value, in 0.1 dB increments. The valid range depends on the type of gain block 
X6% = Group fader increment dB value, in 0.1 dB increments, to raise or lower a group fader 
X6^ = Group fader soft limit dB value, in 0.1 dB increments. X6^ must be within the range for the gain block grouped 
 in X6#. 
X6& = Group type 6= gain 12 = mute
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Reference 
Information

This section covers the following DTP CrossPoint matrix switcher procedures:

• Mounting the Switcher

• Removing and Installing Button Labels

ATTENTION:

• Installation and service must be performed by authorized personnel only.

• L’installation et l’entretien doivent être effectués par le personnel autorisé 
uniquement.

Mounting the Switcher
The DTP CrossPoint 84 is housed in a rack-mountable, 2U high metal enclosure with 
mounting flanges for standard 19-inch wide racks.

UL Guidelines
The following Underwriters Laboratories (UL) guidelines pertain to the installation of the 
matrix switcher into a rack.

• Elevated operating ambient temperature — If installed in a closed or multi-unit rack 
assembly, the operating ambient temperature of the rack environment may be greater 
than room ambient. Therefore, consider installing the equipment in an environment 
compatible with the maximum ambient temperature specified by Extron (Tma = +32 to 
+122 °F [0 to +50 °C]).

• Reduced air flow — Installation of the equipment in a rack should be such that the 
amount of air flow required for safe operation of the equipment is not compromised.

• Mechanical loading — Mounting of the equipment in the rack should be such that a 
hazardous condition is not achieved due to uneven mechanical loading.

• Circuit overloading — Consideration should be given to the connection of the 
equipment to the supply circuit and the effect that overloading of the circuits might have 
on overcurrent protection and supply wiring. Appropriate consideration of equipment 
nameplate ratings should be used when addressing this concern.

• Reliable earthing (grounding) — Reliable earthing of rack-mounted equipment 
should be maintained. Particular attention should be given to supply connections other 
than direct connections to the branch circuit (such as the use of power strips).
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Mounting Instructions
If desired, rack mount the switcher as follows:

1. Insert the unit into the rack, aligning the mounting bracket holes with those in the rack 
(see figure 77).

Figure 77. Installing the Switcher in a Rack

2. Secure the switcher to the rack using the supplied bolts.

Removing and Installing Button Labels

Making Labels Using the Button-Label Generator Program
The Button Label Generator software creates labels that you can place in the translucent 
covers of the input and output selection buttons. You can create labels with names, 
alphanumeric characters, or even color bitmaps for easy and intuitive input and output 
selection (see Installing Labels in the Buttons on page 155 for the procedure for 
removing and replacing the translucent covers).

Installing the Button Label Generator software
The Extron Button Label Generator is available on the Extron website under the Download 
tab (see figure 78, 1). Click the Software link (2), and download and install the program 
on your PC.
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Figure 78. Location of Software on the Website

By default, the Windows installation creates a C:\Program Files\Extron\
ButtonLabelGenerator directory and places the Button Label Generator icon into a group 
or folder named “Extron Electronics.”

NOTE: C:\Program Files(x86)\ ...  for 64-bit Windows OS.
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Using the Button-Label Generator software
1. To run the Button-Label Generator program, click Start > Programs > 

Extron Electronics > Button Label Generator > Button Label Generator. The 
Button-Label Generator window appears (see figure 79).
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Figure 79. Extron Button-Label Generator Window

2. In the Systems drop-down box (1), choose the MPX Plus 866 A option to match, 
as closely as possible, the button label size and quantities for your DTP CrossPoint 
switcher.

3. Using normal Windows controls, you can create and print labels that can be placed in 
the label windows on the front panel of the switcher.

NOTE: For best results, print on transparent or translucent material.

4. Click the Clear All Buttons button (2) and create new labels as many times as 
necessary to make all of the button labels that you need.

To access the help program, click the Help menu (3).
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Making Labels from Paper Templates
Figure 81 on page 156 provides strips of blank button labels. If desired, copy them or 
cut them out, write button information in each button area as desired, and put them in the 
windows of the input or output buttons.

Installing Labels in the Buttons
Install new labels in the front panel buttons as follows:

1. Remove the button from the matrix switcher; use a small, flat bladed screwdriver such 
as an Extron Tweeker to gently pry a button out from the front panel (see figure 80).

TEXT 

Separate the two-
piece button here at
the corner.

Pry the two 
pieces apart. 

Diffuser 

Base 

Button Label 
Clear Lens 

Figure 80. Illuminated Button Label Replacement

2. Locate the notch in the corner of one side of the clear button cap lens.

3. Separate the white backing (diffuser) from the clear button cap (lens); insert the blade of 
the small screwdriver into the corner notch and gently twist the blade.

4. Save the translucent white diffuser, but remove the label insert from the transparent 
button cap lens.

5. Insert the replacement button label into the button cap. Check for correct label 
orientation.

6. Align the white diffuser plate with the cap (lens). The bumps on the diffuser plate should 
be aligned (top and bottom) with the notches on the clear button cap. Firmly snap it into 
place.

7. Align the tabs on the base of the matrix switcher with the notches on the diffuser plate. 
Gently, but firmly, press the reassembled button into place in the front panel of the 
switcher.

8. Repeat steps 1 to 7 as needed to relabel other buttons.
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Extron Warranty

Extron Electronics warrants this product against defects in materials and workmanship for a period of three years 
from the date of purchase. In the event of malfunction during the warranty period attributable directly to faulty 
workmanship and/or materials, Extron Electronics will, at its option, repair or replace said products or components, 
to whatever extent it shall deem necessary to restore said product to proper operating condition, provided that it is 
returned within the warranty period, with proof of purchase and description of malfunction to:

USA, Canada, South America, 
and Central America: 
Extron Electronics 
1230 South Lewis Street 
Anaheim, CA 92805 
U.S.A.

 
Japan: 
Extron Electronics, Japan 
Kyodo Building, 16 Ichibancho 
Chiyoda-ku, Tokyo 102-0082 
Japan

Europe and Africa: 
Extron Europe 
Hanzeboulevard 10 
3825 PH Amersfoort 
The Netherlands

China: 
Extron China 
686 Ronghua Road 
Songjiang District 
Shanghai 201611 
China

Asia: 
Extron Asia Pte Ltd 
135 Joo Seng Road, #04-01 
PM Industrial Bldg. 
Singapore 368363 
Singapore

Middle East: 
Extron Middle East 
Dubai Airport Free Zone 
F12, PO Box 293666 
United Arab Emirates, Dubai

This Limited Warranty does not apply if the fault has been caused by misuse, improper handling care, electrical 
or mechanical abuse, abnormal operating conditions, or if modifications were made to the product that were not 
authorized by Extron.

NOTE: If a product is defective, please call Extron and ask for an Application Engineer to receive an RA (Return 
Authorization) number. This will begin the repair process. 
 
USA: 714.491.1500 or 800.633.9876 Europe: 31.33.453.4040  
Asia: 65.6383.4400 Japan: 81.3.3511.7655 

Units must be returned insured, with shipping charges prepaid. If not insured, you assume the risk of loss or damage 
during shipment. Returned units must include the serial number and a description of the problem, as well as the 
name of the person to contact in case there are any questions. 

Extron Electronics makes no further warranties either expressed or implied with respect to the product and its quality, 
performance, merchantability, or fitness for any particular use. In no event will Extron Electronics be liable for direct, 
indirect, or consequential damages resulting from any defect in this product even if Extron Electronics has been 
advised of such damage.

Please note that laws vary from state to state and country to country, and that some provisions of this warranty may 
not apply to you.

 

Extron Headquarters
+1.800.633.9876 (Inside USA/Canada Only)

Extron USA - West Extron USA - East 
+1.714.491.1500 +1.919.850.1000 
+1.714.491.1517 FAX +1.919.850.1001 FAX

Extron Europe
+800.3987.6673 
(Inside Europe Only)

+31.33.453.4040 
+31.33.453.4050 FAX

Extron Asia
+65.6383.4400
+65.6383.4664 FAX

Extron Japan
+81.3.3511.7655
+81.3.3511.7656 FAX

Extron China
+86.21.3760.1568 
+86.21.3760.1566 FAX

Extron Middle East
+971.4.299.1800
+971.4.299.1880 FAX

Extron Korea
+82.2.3444.1571
+82.2.3444.1575 FAX

Extron India
1800.3070.3777 
(Inside India Only)

+91.80.3055.3777 
+91.80.3055.3737 FAX

© 2014 Extron Electronics   All rights reserved.   www.extron.com
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